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1 Getting Started

What Is Report Generator?
Report Generator is a software package that can take any information from
your MATLAB® workspace and export it to a document in the form of a report.
The reports that you create with Report Generator can include figures, data,
variables, and functions from your models or M-files, as well as snapshots of
system graphics and figures.

Two Report Generator Packages
There are two Report Generator packages: MATLAB Report Generator and
the Simulink® Report Generator. If you want to create reports for MATLAB
M-files, you need the MATLAB Report Generator. If you want to create
reports for Simulink or Stateflow® models, you need both MATLAB Report
Generator and the Simulink Report Generator, which is built atop the
MATLAB Report Generator and includes fixed-point components.

This manual documents both MATLAB Report Generator and Simulink
Report Generator. This manual also documents fixed point components, which
are included with Simulink Fixed Point.

Multiple Report Formats
One of the key features of Report Generator is that you can create reports in
the following documentation formats:

• Rich Text Format (RTF)

• Extensible Markup Language (XML)

• Hypertext Markup Language (HTML)

Report Generator Overview
The parts of Report Generator are shown in the following diagram.

1-2



What Is Report Generator?

Report Generator
Part Description

Report Generator Includes Report Explorer, the graphical user interface
(GUI) for Report Generator. Report Generator is
shown as a dashed box because you can use Report
Explorer or the MATLAB command line to generate
reports and edit setup files.

Setup File Specifies which components will be in the report,
as well as component attributes and component
relationships.

Components Controls the report generation process and inserts
information into a report with self-contained, modular
elements, such as the Evaluate MATLAB Expression
component or the Handle Graphics® Property Table
component.

Stylesheet Specifies parameters that control the display and
formatting of the report. Available formats include
HTML and RTF.

Report Generated document that contains the information
specified by the setup file.

1-3



1 Getting Started

Generating a Report
This section describes how to use Report Generator, demonstrates how to
generate a report, and provides brief descriptions of the components used in
the setup file. The following topics are included:

• “Opening Report Generator” on page 1-4

• “Generating the Report” on page 1-5

• “Component Descriptions” on page 1-8

Opening Report Generator
With Report Generator, you can generate reports, build setup files, and
convert DocBook XML files. To access Report Generator, you can use the
MATLAB command line or the Report Generator graphical user interface,
which is Report Explorer.

Opening Report Generator from the MATLAB Command Line
To open Report Explorer, type report at the MATLAB command prompt. You
can also type setedit and rptconvert with no arguments to open Report
Generator.

Opening Report Generator from the MATLAB Desktop
You can open Report Explorer without going to the MATLAB command line.

• From the MATLAB desktop, click Start > MATLAB > MATLAB Report
Generator > Report Explorer

• If you are using Simulink Report Generator, click
Start > Simulink > Simulink Report Generator > Report Explorer.

Opening Report Generator from Simulink
In a Simulink model, you can open Report Generator directly by clicking
Tools > Report Generator.
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Generating a Report

Generating the Report
To generate reports with Report Generator, you can use Report Explorer or
the MATLAB command line. To decide which report generation method to
use, see the table below.

If You... Use

Know the setup file you want to use and
you don’t need to edit it

Command line

Want to generate a report from an existing
setup file (or edit the setup file) but are
not sure of the name of the file or if it is
on your path

Report Explorer

Want to create a new report, or edit an
existing setup file (for example, if you
want to customize a standard setup file or
edit one of your own setup files)

Report Explorer

Using the Command Line to Generate a Report
You can generate a report without opening the setup file, using the MATLAB
command line. Issue the following command at the command line:

report SetupFileName

where SetupFileName is the name of your setup file. For example, if you type
report ch1-tutorial, a report is generated.

To generate multiple reports, type the following statement at the MATLAB
command line:

report ('SetupFileName1','SetupFileName2',...)

Report Generator creates the corresponding reports in the order specified by
the input arguments.
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1 Getting Started

Note If you type report without any input argument, Report Explorer
appears. Report Explorer lists all the setup files you have on your path.

Using Report Explorer to Generate a Report
You can also use Report Explorer to generate a report. The following
procedure opens the setup file before generating a report.

1 In the Options panel, double-click ch1-tutorial.rpt to open the setup file.

The Properties panel displays the basic report options:

2 Click Report in the toolbar. The report is generated.

By default, the ch1-tutorial report is generated in HTML. Many other
generation options are available. For more information, see “Setting Report
Output Options” on page 2-2.
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Generating a Report

While the report is generating, the following events occur:

• All options in Report Explorer become inactive.

• The Outline panel highlights each component as it is executing.

• Report Explorer shows the report generation status.

After report generation is complete, your Web browser opens to display your
report:

If your report is not displayed, make sure that the View report after
generating check box is selected in the Properties panel.

Alternative Methods to Generate Reports
Report Generator gives you several options to initiate report generation. You
can start report generation by

• Clicking Report on the File menu

• Clicking Generate Report in the Properties panel
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1 Getting Started

• Clicking Report in Report Explorer toolbar

• Right-clicking a setup file in the Options panel and clicking Generate
Report on the shortcut menu

Component Descriptions
The components in the setup file determine the information contained in
the generated report. For example, the ch1-tutorial setup file contains
four components:

The following sections show the information each component in the outline
inserts into the report:

• “Paragraph Component” on page 1-8

• “Evaluate MATLAB Expression Component” on page 1-8

• “Figure Snapshot Component” on page 1-9

• “Handle Graphics Property Table Component” on page 1-10

Paragraph Component
The first component in the setup file is a Paragraph component. The
Paragraph component inserts the following paragraph in the report.

When peaks.m runs in the workspace, the following text is
displayed to the Command Window:

Evaluate MATLAB Expression Component
The second component in the setup file is an Evaluate MATLAB Expression
component. This is represented in the setup file by
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Generating a Report

Eval String-%Evaluate PEAKS in the base workspace.

This component evaluates the following M-code:

%Evaluate PEAKS in the base workspace.

%Clear other open figures.
close all

%Create the figure.
peaks

%Set the figure print size to 5x4 inches.
set(gcf, ...
`PaperPosition',[1 1 5 4],...
`PaperUnits','inches');

and inserts the command-line output in the report.

z = 3*(1-x).^2.*exp(-(x.^2) - (y+1) ...
- 10*(x/5 - x.^3 - y.^5).*exp(-x.^2-y.^2) ...
- 1/3*exp(-(x+1).^2 - y.^2)

Figure Snapshot Component
The third component in the setup file is the Handle Graphics Figure Snapshot
component. The Handle Graphics Figure Snapshot component inserts a
snapshot of the current figure into the report. Because the Evaluate MATLAB
Expression component created the Peaks image, it is the current image and
is inserted into the report.
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1 Getting Started

Handle Graphics Property Table Component
The fourth component in the setup file is the Handle Graphics Property Table
component. The Handle Graphics Property Table component inserts a table
of selected Handle Graphics figure property name/property value pairs for
the Peaks image.

PaperPosition: (1.00, 1.00) 5.00 x 4.00 inches
PaperOrientation: portrait
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Using Report Explorer

Using Report Explorer
A report consists of information that is specified by the components in its
setup file. You can think of the setup file as a container for components.

To build a setup file, you add components. For example, if you want to include
a paragraph of text in a report, you add a Paragraph component.

Report Explorer serves as the primary graphical user interface (GUI) for
Report Generator. With Report Explorer, you can

• Browse setup files and Report Generator components on the MATLAB path

• Create new setup files

• Open, modify, and delete existing setup files and components

• Generate reports

To start Report Explorer, click Report Generator on the MATLAB Start
menu or type report at the MATLAB command prompt. Report Explorer
GUI features three panels:
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1 Getting Started

Outline panel (leftmost) Displays the structure of the setup file currently
open in Report Explorer.

Options panel (center) Displays the options for the currently selected
object in the Outline panel. For example,
when a setup file is open, the Options panel
displays the available components. When the
Stylesheet Editor is open, the Options panel
displays available stylesheets or available style
parameters, depending on the selection in the
Outline panel.

Properties panel
(rightmost)

Displays properties for the currently selected
object in Report Explorer.
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Using Report Explorer

You use Report Explorer to select and organize the components that you want
in the setup file. The outline of the current setup file is displayed in the
Outline panel of Report Explorer. The outline contains all the components
that will be included in the report. Child components are always shown
indented under their parent component:

Note If you need help with a component, select the component in the Options
panel or Outline panel and click Help in the Properties panel.

You can perform the following component operations with Report Explorer:

• “Opening Setup Files” on page 1-13

• “Creating New Setup Files” on page 1-14

• “Adding Components” on page 1-15

• “Moving Components” on page 1-16

• “Deleting Components” on page 1-16

• “Activating and Deactivating Components” on page 1-17

• “Cutting, Copying, and Pasting Components” on page 1-19

• “Using Variable Notation in Text Fields” on page 1-20

• “Using the Preferences Dialog Box” on page 1-22

Opening Setup Files
You use Report Explorer to open existing setup files. To open a setup file,
follow these steps:
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1 Getting Started

1 To open Report Explorer, type report at the MATLAB command prompt.

2 In the Options panel, select a setup file.

3 In the Properties panel, click Open. The report opens.

Note If you do not have Report Generator for Simulink installed, you will
not be able to edit or add Simulink or Stateflow components.

Alternate Methods for Opening Setup Files
You can also open setup files by

• Clicking Open Report on the File menu

• Double-clicking the setup file in the Options panel

• Typing setedit SetupFileName at the MATLAB command prompt

• Pressing Ctrl+O on your keyboard

• Clicking Report Generator on the Tools menu in Simulink

• Right-clicking the setup file in the Options panel and clicking Open
Report on the shortcut menu

Creating New Setup Files
You use Report Explorer to create a new setup file. In Report Generator, setup
files are saved as *.RPT files. To create a new setup file, follow these steps:

1 Open Report Explorer.

2 Click New in the toolbar.

A new setup file appears in the Outline panel:
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Alternate Methods for Creating New Setup Files
You can also create new setup files by

• Clicking New on the File menu

• Right-clicking Report Generator in the Outline panel and clicking New
on the shortcut menu

• Typing setedit NewFileName at the MATLAB command prompt

• Pressing Ctrl+N on your keyboard

Adding Components
When a setup file is open in Report Explorer, the Options panel displays
the available components. To add a component to a setup file, select the
component that you want to use from the Options panel.

The general classes of components, such as Formatting, MATLAB, and so on,
are denoted by a folder icon, . Components for each class are listed below
the class to which they belong and are denoted by the component icon, .

To add a component, follow these steps:

1 Create a new setup file in Report Explorer.

2 Drag the Chapter/Subsection component from the Options panel and
drop it in the Outline panel.

In the Outline panel, the component appears under the Report component:

As the tree view in the Outline panel indicates, components are arranged in
hierarchical order. Report Generator begins at the top of the tree and proceeds
until the bottom of the tree. Therefore, you will want to move components
around in the tree.
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Moving Components
You can move components in four directions: up, down, left, and right. Four
buttons located in the toolbar let you move components around in the Outline
panel.

Button Purpose Effect

Move up The selected component executes one
step earlier in report generation.

Move down The selected component executes one
step later in report generation.

Move left The selected component moves up one
level in the component hierarchy.

Move right The selected component moves down
one level in the component hierarchy to
become a child of the component above.

Note You must be careful when you move components, especially when
there are parent-child relationships involved. Some components cannot have
children, and some components should not be children of other components.

Alternate Methods for Adding Components
You can also add components by

• Clicking Add component to current report in the component’s
Properties panel

• Right-clicking the component in the Options panel and clicking Add
component to current report on the shortcut menu

• Dragging the component from the Options panel to the Outline panel

• Double-clicking the component in the Options panel

Deleting Components
To delete a component, follow these steps:
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1 In the Outline panel, select the component you want to delete.

2 Click Delete in the toolbar.

The component disappears:

Alternate Methods for Deleting Components
You can also delete a component by

• Clicking Delete on the Edit menu

• Pressing Delete on your keyboard

• Right-clicking the Outline panel and clicking Delete on the shortcut menu

Note If you delete a component in your setup file that has children, all
its children are also deleted.

You cannot delete the Report Generator root, which is always at the top of
the tree structure in the Outline panel.

Activating and Deactivating Components
You can activate and deactivate individual components in a setup file. When
active, the component and all its children are included in the generated
report. When inactive, the component and all its children are not included
in the report.
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You can activate and deactivate components for

• Evaluating a component’s effect on a report

• Testing components to find an report generation error

• Generating multiple versions of a report without creating new setup files

The Outline panel represents active and inactive components with different
icons:

Active component

Inactive component

To activate a component, follow these steps:

1 Select the component to activate in the Outline panel.

2 Click Activate/Deactivate Component in the toolbar.

The component becomes inactive, as the following figure shows:

Alternate Methods for Activating and Deactivating Components
You can also activate or deactivate a component by
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• Clicking Activate/Deactivate Component on the Edit menu

• Right-clicking the component in the Outline panel and clicking
Activate/Deactivate Component on the shortcut menu.

Note If you deactivate a component in your setup file that has children,
all its children are deactivated as well.

Cutting, Copying, and Pasting Components
The Report Explorer interface provides the ability to cut, copy, and paste
components in the Outline panel.

To copy a component, follow these steps:

1 Select the component to copy in the Outline panel.

2 Click Copy in the toolbar.

To cut a component, follow these steps:

1 Select the component to cut in the Outline panel.

2 Click Cut in the toolbar.

To paste a component, follow these steps:

1 Cut or copy a component that you want to paste.

2 Select the area in the outline in which you want to paste the component.

3 Click Paste in the toolbar.

Alternate Methods for Cutting, Copying, and Pasting
Components
You can also cut, copy, or paste a component by
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• Clicking Cut, Copy, or Paste on the Edit menu

• Pressing Ctrl+C to copy, Ctrl+X to cut, and Ctrl+P to paste

• Right-clicking the component in the Outline panel and clicking Cut, Copy,
or Paste on the shortcut menu.

Using Variable Notation in Text Fields
In Report Generator, you can use variable notation to display variables in
generated reports. To use a variable in a text field, use %<varname> syntax.

For example, to display the variable myvar, you would express it as %<myvar>.

If a variable represents a large amount of text, Report Generator collapses
the text automatically to conserve space in a generated report. To make sure
that a variable’s output is not collapsed, use double angle brackets in the
variable notation, such as %<<myvar>>.

Sending Report Generator Objects to the MATLAB
Workspace
The Report Explorer provides a tool that creates a handle in the MATLAB
workspace to the currently selected object in Report Explorer. Once you have
an object handle, you can manipulate the object at the MATLAB command
line.

Once you create or open a setup file, you can send objects to the workspace.

1 Create a new setup file by clicking New on the File menu.

A new setup file appears in the Outline panel.

2 Send the object to the MATLAB workspace.

a Select the new setup file in the Outline panel.

b Right-click the setup file and click Send to Workspace on the shortcut
menu.

The object handle is sent to the MATLAB workspace in the ans variable.
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3 Assign the object handle to another variable. This step is necessary to avoid
overwriting the handle when you send another object to the workspace. For
example, type rgobj = ans.

After you click Send to Workspace, the setup file object handle appears at
the MATLAB command line.

ans =

[RptgenML.CReport]
SectionType: 'auto'

DirectoryType: 'setfile'
DirectoryName: ''
FilenameType: 'setfile'
FilenameName: 'index'

isIncrementFilename: 0
Format: 'html'

Stylesheet: 'default-html'
isView: 1

isAutoSaveOnGenerate: 0
isRegenerateImages: 1

Description: 'A report'
Language: 'auto'

PostGenerateFcn: ''
RptFileName: ''

You can assign the object handle to another variable.

rgobj = ans

rgobj =

[RptgenML.CReport]
SectionType: 'auto'

DirectoryType: 'setfile'
DirectoryName: ''
FilenameType: 'setfile'
FilenameName: 'index'

isIncrementFilename: 0
Format: 'html'
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Stylesheet: 'default-html'
isView: 1

isAutoSaveOnGenerate: 0
isRegenerateImages: 1

Description: 'A report'
Language: 'auto'

PostGenerateFcn: ''
RptFileName: ''

You can also modify the object properties from the command line.

rgobj.Format = 'rtf97'

rgobj =

[RptgenML.CReport]
SectionType: 'auto'

DirectoryType: 'setfile'
DirectoryName: ''
FilenameType: 'setfile'
FilenameName: 'index'

isIncrementFilename: 0
Format: 'rtf97'

Stylesheet: 'default-fo'
isView: 1

isAutoSaveOnGenerate: 0
isRegenerateImages: 1

Description: 'A report'
Language: 'auto'

PostGenerateFcn: ''
RptFileName: ''

Using the Preferences Dialog Box
To change output format defaults, use the Report Generator Preferences
dialog box. You can change default image file formats, report file extensions,
and the MATLAB command used to display the generated report.

To open the dialog box, click Preferences on the File menu.

1-22



Using Report Explorer

To modify the default file extension used in generated reports, follow these
steps:

1 Choose the desired format in the Format ID list.

2 Edit the Extension field to your desired file extension. For example, you
might prefer the .htm extension to .html.

3 Click Apply.

To change the default file format for Simulink, Stateflow, or Handle Graphics
images, follow these steps:

1 Choose the desired format in the Format ID list.

2 Choose the desired file format in the Simulink images, Stateflow
images, or HG images list.

3 Click Apply.
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To make the format available to the File Format list in Report Explorer,
select the Visible in Report Explorer check box.

To change the MATLAB command used to view the report, follow these steps:

1 Choose the desired format in the Format ID list.

2 Choose the command to use in the View command list.

• edit('%<FileName>'); — Opens the report in a text editor

• web(rptgen.file2urn('%<FileName>'),'-browser'); — Opens the
report in the MATLAB Web browser

• docview('%<FileName>','UpdateFields'); — Opens the report in an
RTF editor

• ! "%<FileName>" & — Executes the report as a command to the
operating system

3 Click Apply.

MATLAB replaces %<FileName> with the full file path and name of the
generated report.

Note Make sure that the editor or viewer specified in the View Command
list supports the applicable output file format.

To restore the default settings for an output format, choose the format in the
Format ID list and click Reset to Defaults.
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Setting Report Output Options
Report Generator lets you control most aspects of report output. For more
information, see the following sections:

• “Setting the Report File Directory” on page 2-2

• “Setting the Report Filename” on page 2-3

• “Setting the Report Format” on page 2-3

• “Viewing and Printing Your Report” on page 2-6

• “Autosaving the Setup File” on page 2-7

• “Regenerating Images” on page 2-7

• “Including a Report Description” on page 2-7

Setting the Report File Directory
Choose the appropriate directory for the report file according to the table
below. Make sure you have write privileges for that directory.

Directory Option

The same directory as
the setup file

Same as setup file

The current working
directory

Present working directory

Temporary directory Temporary directory

Another directory Custom. Specify a directory in the Custom text
box (you can use the Browse button (...) to
select from a list of directories).

You can use the %<VariableName> notation to specify a directory in the
Custom text box. See “%<VariableName> Notation” on page 8-253 in the
reference page for the Text component.
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Setting the Report Filename
Choose the appropriate filename for the report file according to the table
below.

Images are placed in a directory with the same name as the report file.
For example, testreport.html images are placed in a directory named
testreport_files.

Filename Option

Your report is to have the same
filename as the setup file.

Same as setup file (default)

Your report is to have a
filename that is different from
the setup file name.

Custom. Enter the name of the report in
the text box.

You can use the %<VariableName> notation to specify a filename in the
Custom text box. See “%<VariableName> Notation” on page 8-253 in the
reference page for the Text component.

Setting the Report Format
You can choose the report output format in the File Format text box. You
should choose the output format according to how you want to view the report.
For example, if you want to use Microsoft Word, you should choose Rich Text
Format.
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Each output format has a default stylesheet. Specify the stylesheet in the text
box next to the File Format text box.

The table below shows which output format to use with different viewers or
software as well as which stylesheets are available for use with each output
format.

Viewer Format Purpose Stylesheet Options

Adobe
Acrobat
Reader

Portable
Document
Format (PDF)

Produces a PDF
that can be
viewed with
Acrobat Reader
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Viewer Format Purpose Stylesheet Options

Web browser Web (HTML)
(default)

Use for
publishing on
the World Wide
Web

Web (see “Web
Stylesheets ” on page
2-5)

Word
processor

Rich Text
Format (RTF)

Compatible
with most
word-processing
packages,
including
Microsoft Word

Print (see “RTF
Stylesheets ” on page
2-5)

Note You can create and use customized styles, in addition to the built-in
stylesheets. See Chapter 6, “Creating and Using Customized Styles”

Web Stylesheets

Web Stylesheet Description

Default HTML
stylesheet

HTML on a single page

Simulink book HTML
stylesheet

HTML

Truth Table HTML
stylesheet

HTML

RTF Stylesheets

RTF Stylesheet Description

Standard Print Displays title page, table of contents, list of titles

Unnumbered Chapters &
Sections

Chapters and sections are not numbered.
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RTF Stylesheet Description

Numbered Chapters &
Sections

Chapters and sections are both numbered.

Compact Print Minimizes white space to reduce page count

Compact Simple Print Minimizes page count, suppresses title, table of
contents, list of titles

Large Type Print Uses 12 point font (slightly larger than Standard
Print)

Simple Print Suppresses title page, table of contents, list of
titles

Very Large Type Print Uses 24 point font and landscape paper
orientation

Note Some Web and print stylesheets include an automatically generated
list of titles. The list of titles includes a list of table titles and a list of figures
with titles.

Viewing and Printing Your Report
To view your report after generation, you have the following options:

• To view the report automatically, use the View report after generating
option in the Generation Options section in the Properties panel. When
report generation is complete, the viewer associated with the report output
format displays the report.

• To view the report from the MATLAB command line, use the rptviewfile
command, such as rptviewfile ch1-tutorial.

• To view the report manually, browse to the location specified in the Report
File Location section in the Properties panel and open the file.

If you want to print your report, select the print option from the viewer.
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Autosaving the Setup File
To automatically save the setup file before you generate a report, select Save
setup file on generation, which is located in the Generation Options
section of the Properties panel.

Regenerating Images
By default, the Regenerate Simulink and Stateflow Images option in
the Generation Options section of the Properties panel is not selected.
Previously generated images are not regenerated each time you generate
a report, which results in faster report generation. If you have made any
changes that could affect the image, you should select this option.

Including a Report Description
Use the Report Description field in the Properties panel to make notes and
comments on your setup file. This text appears in the Properties panel when
you select a setup file in the Options panel.
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Converting XML Documents
If you want to generate the same report in a different output file format
without regenerating the report, you can use either the user interface (Report
Explorer File Converter) or the command line (rptconvert command). The
File Converter transforms a DocBook XML source file generated in Report
Generator into a formatted document, such as HTML, RTF, or PDF.

Note Report Generator can convert only XML source files created by the
latest version of Report Generator.

Converting XML Documents with Report Explorer
To open the Convert Properties panel, follow these steps:

1 In Report Explorer, select Tools > Convert source file.

The Convert Source File Properties panel appears.
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2 Click Browse and select your XML source file.

3 Select your output format and stylesheet as follows:

a In the File format text box, select an output format.

b In the Stylesheet text box, select a stylesheet. The stylesheet choice
depends on the selected output format.

c Optionally, click Edit if you want to customize the stylesheet you have
selected.

For more information about available formats and stylesheets, see “Setting
the Report Format” on page 2-3.

For more information about editing stylesheets, see Chapter 6, “Creating
and Using Customized Styles”

4 Use the check box to indicate whether or not you want to view the report
after it has been converted.
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5 To begin the conversion, click Convert file.

Editing XML Source Files
Before you send a source file to the converter you can edit it as text in the
Report Explorer. To do so:

1 In the Outline panel, open the File Converter. One way to do this is to
right-click Report Generator and select Convert source file.

2 In the Options panel, select the source file that you want to edit.

3 In the Properties panel, click Edit as text.

4 Use the MATLAB Editor to edit and save the text.

Converting XML Documents at the Command Line
To convert files outside Report Explorer interface, you can use rptconvert
from the command line with varying levels of definition:

• <ReportName>=rptconvert('<DocBookFileName>'), where <ReportName>
is the name of your report, and DocBookFileName is the name of the
DocBook file (with or without the .xml extension). Report Generator uses
the default format (HTML) and stylesheet (Single-Page Web).

• <ReportName>=rptconvert('<DocBookFileName>',format); where the
valid format arguments are

- HTML

- RTF95

- RTF97

- FOT (for XML)

Enter the format name in single quotation marks, for example, 'HTML'.
Report Generator uses the default stylesheet for the selected option.

• <ReportName>=rptconvert('<DocBookFileName>',format,stylesheet);

For a discussion of valid stylesheet options for each output
format, see “Setting the Report Format” on page 2-3. Type
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rptconvert #STYLESHEETLIST for a list of valid stylesheet arguments.
Enclose the stylesheet name in single quotation marks.
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Creating Log Files
In Report Generator, a log file describes a setup file, including its report
generation settings and components. A log file can be used for many purposes,
including

• As a debugging tool

• As a reference to a setup file

• To share information about a setup file through e-mail

A log file includes the following:

• Setup file outline

• Components and their attributes

• Generation status messages currently displayed in the Generation
Status tab

• All MATLAB licenses

To generate a log file, select File > Log File. An HTML version of the
log file is saved in the same directory as the setup file and is named
<setupfilename>_log.html. The log contains

• Setup file table

• Setup file table of contents

• Table of details for each component in the setup file

• Product version table
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The following figure shows the MATLAB Web browser displaying part of the
log file for the ch1-tutorial setup file:
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Generating M-Code from Setup Files
Using Report Generator, you can generate M-code versions of setup files
in the form of an M-file (*.m). An M-file of a setup file is useful for a
variety of purposes, including generating reports and modifying setup files
programmatically.

To generate an M-file from Report Generator, a setup file must already be
loaded. Select File > Generate M-File. After generation, the M-file opens in
the MATLAB Editor. The M-file is saved in the same location as the setup file.

For example, the ch1-tutorial setup file generates the following M-code:

function [rptgenml_creport1] = buildch1_tutorial
%BUILDCH1_TUTORIAL
%% Create RptgenML.CReport
rptgenml_creport1 =
RptgenML.CReport(...'DirectoryType','pwd',...'Format','html',...
'Stylesheet','default-html',...'Description',['A simple version
of mfile-report.rpt',
char(10),'',char(10),'This setup file has five components:',
char(10),'1) Report - specifies the output file location and file
format',char(10),'2) Paragraph - inserts a single paragraph into
the report',char(10),' 3) Eval - evaluates a MATLAB command and
inserts command window output',char(10),' 4) Figure Snapshot -
inserts a picture of the figure created during eval',char(10),'
5) Figure Prop Table - inserts a property-value table reporting
on the figure',char(10),'',char(10),'This report is discussed in
detail in the first chapter of the Report Generator
documentation.'],...'RptFileName',
'C:\WINNT\profiles\user\Desktop\ch1-tutorial.rpt');
%% Create rptgen.cfr_paragraph
rptgen_cfr_paragraph1 =
rptgen.cfr_paragraph('ParaTitle','','ParaText','When peaks.m
runs in the workspace, the following text is displayed to the
command window:');
setParent(rptgen_cfr_paragraph1,rptgenml_creport1);
%% Create rptgen.cml_eval
rptgen_cml_eval1 = rptgen.cml_eval(...'EvalString',['%Evaluate
PEAKS in the base workspace',char(10),'',char(10),'%This clears
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other open figures.',char(10),'close all',char(10),'',char(10),
'%This creates the figure.',char(10),'peaks',char(10),'',
char(10),
'%This sets the figure print size to 5x4 inches',char(10),
'set(gcf,...',char(10),''PaperPosition'',[1 1 5 4],
...',char(10),'''PaperUnits'',''inches'');'],...
'isCatch',false,...'CatchString','disp([''Error during eval: '',
lasterr])',... 'isInsertString',false);
setParent(rptgen_cml_eval1,rptgenml_creport1);

2-15



2 Generating Reports

Working with Legacy Setup Files
Legacy setup files are files that you created in a previous version of Report
Generator. You can use such legacy setup files in the latest version in either
of two ways. You can load legacy setup files in Report Explorer, or you can
use the previous versions of the Report Generator interfaces to work with
legacy setup files.

• “Enabling the Legacy Report Generator Interfaces” on page 2-16

• “Using the Legacy Report Generator Interfaces” on page 2-17

Enabling the Legacy Report Generator Interfaces
You enable the previous versions of the Report Generator interfaces at the
MATLAB command line. To enable the legacy interfaces, enter

RptgenML.v1mode(true)

at the MATLAB command line. MATLAB responds with

ans =

1

A logical 1 indicates that Version 1 mode is on. To turn Version 1 mode off,
enter

RptgenML.v1mode(false)

at the MATLAB command line. MATLAB responds with

ans =

0

A logical 0 indicates that Version 1 mode is off.

2-16



Working with Legacy Setup Files

Using the Legacy Report Generator Interfaces
When Version 1 mode is enabled, you can use the previous versions of the
Report Generator interfaces. The MATLAB functions related to Report
Generator also load the old interfaces.

Keep the following points in mind when using the previous versions of Report
Generator interfaces:

• You cannot use a setup file created in the latest version of Report Generator
with the old interfaces. If you save a legacy setup file in the latest version
of Report Generator, you will not be able to work with the same setup file
in the old interface.

• You cannot use the old interfaces with the latest version. While the Setup
File Editor can coexist with Report Explorer, we do not recommended it.
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Report Generator Interfaces

setedit

rptlist

rptconvert
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Troubleshooting
This section contains information about how to deal with problems that you
may have when using Report Generator.

Managing Report Generator Memory Usage
By default, MATLAB sets a limit of 100 MB on the amount of memory the
Java Virtual Machine (JVM) can allocate. The memory used by Report
Generator to build a document must fit within this 100 MB limit. If you
are having trouble processing large reports, you might need to increase the
amount of memory Report Generator can allocate.

Running MATLAB Without a Desktop
One way to increase the amount of JVM memory available to Report
Generator is to run MATLAB with -nodesktop mode enabled.

Increasing the MATLAB JVM Memory Allocation Limit
You can also increase the amount of JVM memory available by increasing the
MATLAB JVM memory allocation limit.

To increase this limit, create a file named java.opts and put it in your
MATLAB startup directory. In this file, include the -Xmx option, specifying
the amount of memory you want to give the JVM.

For example, to increase the JVM memory allocation limit to 128 MB, use the
following syntax in the java.opts file:

-Xmx128m

Note To avoid virtual memory thrashing, never set the -Xmx option to more
than 66% of the physical RAM available.

On UNIX systems, create the java.opts file in a directory where you intend
to start MATLAB and move to that directory before starting MATLAB.

On Windows systems:
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1 Create the java.opts file in a directory where you intend to start MATLAB.

2 Create a shortcut to MATLAB.

3 Right-click the shortcut and select Properties.

4 In the Properties dialog box, specify the name of the directory in which
you created the java.opts file as the MATLAB startup directory.
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Exporting a Simulink Web View
A Web View is an interactive rendition of a Simulink model or Stateflow
diagram that you can view in a Web browser. A Web View uses Scalable Vector
Graphics (SVG) to render and navigate a model.

Creating a Web View requires Simulink Report Generator. Using a Web View
in a Web browser requires SVG support in the browser, implemented natively
or through a plug-in, but it does not require MathWorks products to be
installed. For detailed information on software requirements and limitations
for using Web Views, see “Report Generator Release Notes”.

Because they require only Web browsers with widely available SVG support,
Web Views are useful for presenting models to audiences and for sharing
models with colleagues who may not have MathWorks products installed.

Opening the Export Interface
The Simulink Report Generator interface for exporting a model as a Web View
is either a dialog box or a Report Explorer panel. The two interfaces have the
same capabilities and a similar appearance, with minor differences owing to
the different contexts in which the interfaces appear.

To Open Export
Interface From...

Use Export Interface
Opens As...

Report Explorer Export Simulink
to Web command on
Tools menu

Report Explorer panel

Simulink model window Export to Web
command on File menu

Dialog box

Stateflow diagram
editor

Export to Web
command on File menu

Dialog box

Command line slwebview command
with no arguments

Report Explorer panel
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Setting Export Options
In exporting a Web view, you can set options that, together, specify which
Simulink systems or Stateflow charts to export:

• Whether to export Simulink systems or Stateflow charts that contain or are
contained by the current system or chart

• Which masked blocks, if any, to include

• Whether to follow links to library blocks

Setting Options in the Export Interface
The Include Systems option specifies which Simulink systems or Stateflow
charts to export.

Include Systems Option Value Meaning

Current Export only the Simulink system
that is open in the model window or
the Stateflow chart that is open in
the diagram editor

Current and above Export the current Simulink system
or Stateflow chart and all systems or
charts that contain it

Current and below Export the current Simulink
system or Stateflow chart and all
subsystems or subcharts that it
contains

All Export all Simulink systems or
Stateflow charts in the model that
contains the current system or chart
(the default value)

The Look Under Masks option is available only when you are exporting
Simulink subsystems or Stateflow subcharts that the current system or chart
contains. This option specifies which masked blocks, if any, in subsystems or
subcharts to export.
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Look Under Masks Option Value Meaning

No masked blocks Do not export any masked blocks

Masks with no workspace and
no dialog

Export only graphical masked blocks
— those that have no workspaces
and no dialogs (the default value)

Masks with no dialog Export only functional masked
blocks — those that have no dialogs

All masked blocks Export all masked blocks

The Follow Library Links option specifies whether or not to follow links
into library blocks.

Follow Library Links Option
Value

Meaning

Selected Follow links into library blocks

Unselected Do not follow links into library
blocks (the default value)

Setting Options on the Command Line
The first argument to the slwebview command is the name (a string) or
a handle identifying the Simulink system or Stateflow chart to export.
Remaining arguments are alternating name and value pairs (strings) setting
export options.

The option named 'SearchScope' specifies which Simulink systems or
Stateflow charts to export.

’SearchScope’ Option Value Meaning

'Current' Export only the Simulink system or
the Stateflow chart specified by the
first argument
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’SearchScope’ Option Value Meaning

'CurrentAndAbove' Export the Simulink system or the
Stateflow chart specified by the first
argument and all systems or charts
that contain it

'CurrentAndBelow' Export the Simulink system or the
Stateflow chart specified by the first
argument and all systems or charts
that it contains (the default value)

'All' Export all Simulink systems or
Stateflow charts in the model
that contains the system or chart
specified by the first argument

The option named 'LookUnderMasks' is meaningful only when you are
exporting Simulink subsystems or Stateflow subcharts that the specified
system or chart contains. This option specifies which masked blocks, if any, in
subsystems or subcharts to export.

’LookUnderMasks’ Option Value Meaning

'none' Do not export any masked blocks

'graphical' Export only masked blocks that have
no workspaces and no dialogs (the
default value)

'functional' Export only masked blocks that have
no dialogs

'all' Export all masked blocks

The option named 'FollowLinks' specifies whether or not to follow links
into library blocks.
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’FollowLinks’ Option Value Meaning

'on' Follow links into library blocks

'off' Do not follow links into library
blocks (the default value)

The option named 'ViewFile' specifies whether or not to display the Web
View in a Web browser after generating it.

’ViewFile’ Option Value Meaning

true Display the Web View in a Web
browser after generating it (the
default value)

false Do not display the Web View in a
Web browser after generating it

Reviewing and Generating a Web View
Each Web View export dialog box is associated with a particular Simulink
model window or Stateflow diagram editor window and therefore with the
system or chart displayed in that window.

The Report Explorer Web View export panel shows information about the
Simulink system or Stateflow chart that is current at the time you display the
panel from Report Explorer or the slwebview command. However, it exports
the system or chart that is current at the time you click Export Model. If
you change the current system or chart while the Report Explorer Web View
export panel is displayed, the Report Explorer panel does not automatically
change to show information about the newly current system. To update the
Report Explorer panel and display information about the current system or
chart, click Refresh.

The Web View export dialog box or Report Explorer panel displays a list of
layers—that is, Simulink systems or Stateflow charts—to be exported. The
list of layers depends on the system or chart associated with the dialog box or
Report Explorer panel. It also depends on the export options you choose.
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To generate a Web View, click OK in the export dialog box or click Export
Model in the Report Explorer panel. This action generates two sets of files
in the current MATLAB directory:

• An HTML file to be displayed in a Web browser

• A directory, with the same name as the HTML file, containing supporting
files

To send the Web View to another computer, you must send both the HTML file
and the directory of supporting files, and these must remain together. You can
package the HTML file and the supporting directory into a zip file for transfer.

When you generate a Web View from the export dialog box or the Report
Explorer panel, the Web View is also displayed in a Web browser. The
slwebview command displays the Web View in a Web browser by default, but
you can suppress the display by setting the 'ViewFile' option to false.
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Using a Simulink Web View
To display a Web View, you need a Web browser with support for Scalable
Vector Graphics (SVG), implemented natively or through a plug-in. For
detailed information on software requirements and limitations for using Web
Views, see “Report Generator Release Notes”.

A Web View consists of a top-level HTML file and a folder, in the same
directory, containing support files. To display the Web View, open the top-level
HTML file in a Web browser.

The Web View display has these components:

• Graphical display of the current layer (Simulink system or Stateflow chart)

• Four navigation buttons at top left

• Menu of navigation commands, displayed when you move the mouse over
the leftmost button

• Shortcut menu, displayed in some browsers when you right-click the
current layer

If you have Simulink Report Generator installed, you can display an example
Web View of the Simulink F-14 demo model by typing these commands at the
MATLAB command prompt:

sldemo_f14; slwebview(gcs)

Viewing the Current Layer
As you move the mouse over the current layer, parameter names and values
are displayed for each system, chart, block, and line.

You can use menu commands and keyboard accelerators to pan and zoom
within the current layer. You can also use the mouse to pan.
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Action Navigation
Menu
Command

Shortcut Menu
Command

Keyboard
Accelerator

Zoom in Zoom in Zoom in R

Zoom out Zoom out Zoom out V

Zoom to normal
size (100%)

Zoom to 100% 1

Zoom to largest
size that will
fit in browser
window

Zoom to full
screen

Zoom to full
screen

F

Pan up Pan up E

Pan down Pan down C

Pan left Pan left D

Pan right Pan right G

Pan with mouse
(drag layer while
in panning mode)

Pan with
mouse (click
to toggle panning
mode)

Pan with
mouse (click
to toggle panning
mode)

P or Q (press to
enter panning
mode; release
to exit panning
mode)

The shortcut menu command Find text searches for a text string in the
current layer.

Viewing Other Layers
If the current layer contains an exported subsystem or subchart, you can
navigate to that subsystem or subchart and make it the current layer by
clicking it. As you move the mouse over an exported subsystem or subchart,
it is highlighted or the cursor changes, depending on the Web browser you
are using.

You can use the navigation buttons at top left to view other layers.
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Action Navigation Button

View the previous layer in the view
history

View previous

View the top-level layer View home

View all layers in one window View all layers

If you have clicked View all layers to view all layers in one window, clicking
that button again returns to the previous view. This action is also available as
the Show all layers command on the navigation and shortcut menus and
as the X keyboard accelerator. When you view all layers in one window, you
can click a layer to view it. You can also use the Find text command on the
shortcut menu to search for a text string in all layers.
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Working with Looping Components
A looping component runs its child components several times. Report
Generator offers numerous looping components, including logical loops,
Simulink loops, Stateflow loops, and Handle Graphics loops. Most loops share
common characteristics. For that reason, this tutorial focuses on the Figure
Loop component as representative of most looping components.

The Figure Loop component runs its child components several times,
each time applying its child components to Handle Graphics figures. The
figloop-tutorial setup file generates a report that documents multiple
Handle Graphics figures.

The figloop-tutorial setup file contains a Figure Loop component as well
as other components, including

• Title Page

• Chapter/Subsection

• Evaluate MATLAB Expression

• Import File

• Summary Table

• Handle Graphics Name

• Handle Graphics Linking Anchor

• Figure Snapshot

• Handle Graphics Property Table

Note For more information about property table components, see “Working
with Property Table Components” on page 4-13.

Opening the Setup File
To use the figure loop tutorial and edit the setup file, type the following at
the command line:
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setedit figloop-tutorial

The setup file for the figure loop tutorial appears in Report Explorer.

Creating Handle Graphics Figures
There are three important Handle Graphics concepts you need to be familiar
with before proceeding with the rest of this tutorial:

• Invisible figures

• HandleVisibility parameter

• Tags

For more information on Handle Graphics concepts, see the MATLAB Handle
Graphics documentation.

Invisible Figures
When you type figloopfigures, Figures 1, 3, and 5 appear, but Figures 2
and 4 do not. Figures 2 and 4 are invisible (visible='off'), so you can only
see three figures. An invisible figure does not appear on screen; it exists,
but it is hidden.
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HandleVisibility Parameter
Figures An Application on page 4-6 and An Invisible Application on page
4-9 have HandleVisibility='off'. HandleVisibility is a parameter of
a Handle Graphics figure, and it determines whether the handles in your
figure are visible. The figure can be found because it is a child of root. For
more information on HandleVisibility, see the Using MATLAB Graphics
documentation.

To list all figures in your workspace that have HandleVisibility='on', type
get(0,'children')at the command line. The results show that Figures
Peaks Data on page 4-7, Membrane Data on page 4-6 and An Application on
page 4-6 have HandleVisibility='on'.

ans =
5
1
2

Note that most figures have HandleVisibility='on'. To turn
HandleVisibility off, you have to specify HandleVisibility='off' with
the following:

set(handle,'HandleVisibility','off')

Tags
A Handle Graphics figure can have a tag. A tag is a Handle Graphics figure
parameter. A tag does not appear in a figure; it is an identifier that you specify.

If you want to see what tag, if any, a figure has, type get(<handle>, 'tag').
The handle of a figure is the figure number; enter the figure number for
<handle>. For example, to see whether Membrane Data on page 4-6 has a
tag, type get(1, 'tag'), and MATLAB outputs the following response:

ans =
membrane

This means that Figure Membrane Data on page 4-6 has a tag called
membrane. Every figure in this tutorial has a tag. However, by default, figures
have empty tags.
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Figure Summary
The following table shows visibility (figure is visible if visible='on' and
invisible if visible='off'), HandleVisibility, and tags for the figures in
the tutorial.

Name Visible HandleVisibility Tag

Membrane Data on on membrane

Invisible
Membrane Data

off on membrane

An Application on off app

An Invisible
Application

off off app

Peaks Data on on peaks

To create the Handle Graphics figures, type figloopfigures at the MATLAB
command line. Figures Membrane Data on page 4-6, An Application on
page 4-6, and Peaks Data on page 4-7 appear on the screen, but Invisible
Membrane Data on page 4-8 and An Invisible Application on page 4-9 do not
because they are invisible.

Following are Figures Membrane Data on page 4-6 (membrane), An Application
on page 4-6 (app), and Peaks Data on page 4-7 (peaks).
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Membrane Data

An Application
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Peaks Data

Figures An Application on page 4-6 (membrane) and An Invisible Application
on page 4-9 (app), which do not appear on the screen, are shown below.
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Invisible Membrane Data
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An Invisible Application

Before you continue with the rest of the tutorial, it is important that you
understand some important Handle Graphics concepts, such as invisible
figures, HandleVisibility parameters, and tags.

Editing the Figure Loop Component
Select the Figure Loop component in the Outline panel. The Properties panel
for the Figure Loop component appears.
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Looping on the Current Figure
To include a snapshot of the current figure in the report, you must first select a
figure. Select the Peaks Data on page 4-7 window to make the figure current.

To include only the current figure in the report, select Current figure only

from the Include figures list. Click Report to generate a report.

Note When you choose Current figure only, “current figure” refers to
the figure that is current when the report is generated. This might not be
the same figure you selected as the current figure in Report Explorer before
report generation. For example, if the report generation process creates
figures in your report, the last figure created with HandleVisibility = 'on'
is the current figure.
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Looping on All Visible Figures
To include snapshots of all visible figures in your report, select Visible
figuresin the Include figures list. This option inserts a snapshot and
property table for all figures that are currently open and visible.

With HandleVisibility=’on’. The Data figures only (Exclude
applications) option is selected by default and excludes figures with

HandleVisibility = 'off' from the loop. Click Report to generate
a report. Notice that the report contains the figures Membrane Data and
Peaks Data.

With HandleVisibility=’on’ or ’off’. Now clear the Data figures only
option. Figures with HandleVisibility = 'on'(Membrane Data on page 4-6
and Peaks Data on page 4-7) and HandleVisibility = 'off' An Application
on page 4-6) are now included in the loop.

Click Report to generate a report. Notice that the report now contains
Membrane Data on page 4-6, An Application on page 4-6, and Peaks Data
on page 4-7.

Looping on Figures with Certain Tags
To include figures with certain tags, select the All figures with tags
option. When you select a tag, all figures with that tag are included,
regardless of whether the figure is visible or whether HandleVisibility
is 'on' or 'off'.

For a brief discussion of Handle Graphics tags, see “Tags” on page 4-4.

Modifying Section Options
The Figure Loop component provides controls for section options. In a Report
Generator loop, a section refers to a space in the generated report in which
information is displayed, including text, images, tables, and so on. Using
the options available in the Section Options pane, you can alter how the
sections generated by the loop are displayed in the report.
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Create a Section for Each Object in Loop. To enable the loop to create
a section for each object in the loop, select this option. This option is useful
when a loop does not contain a child Chapter/Subsection component that
organizes the loop results. When selected, the loop automatically creates an
individual section for each object found in the loop and uses the object title as
the section title.

In the figloop-tutorial setup file, this option is not needed because the
Figure Loop component has a child Chapter/Subsection component that
already organizes the loop results.

Display the Object Type in he Section Title. To include the object type
in the section title, select this option. When selected, the section titles in
the generated report are prefaced by object types. For example, in a report
generated from the figloop-tutorial setup file without this option selected,
the list of figures produced by the loop would look like

Membrane Data
Invisible Membrane Data
An Application
An Invisible Application

With the option enabled, the list of figures would look like

Figure - Membrane Data
Figure - Invisible Membrane Data
Figure - An Application
Figure - An Invisible Application

Create link anchor for each object in loop. To create a hyperlink to the
object in the generated report, select this option.
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Working with Property Table Components
Property table components display property name/property value pairs
in a table. Report Generator offers numerous property table components,
including the MATLAB Property Table component, the Simulink Property
Table component, the Stateflow Property Table component, and so on.

Report Generator property table components share common characteristics.
For that reason, this tutorial uses the Handle Graphics Property Table
component as a representative of all property table components.

Opening the Setup File
To use the figure loop tutorial and edit the setup file, type the following at
the command line:

setedit figloop-tutorial

The figure loop tutorial setup file appears in Report Explorer.
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Examining the Property Table Output
The Handle Graphics Property Table component displays property
name/property value pairs in a table for Handle Graphics figures, axes, or
plots. The property table appears below the graphic display.
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Property pages for all property table components are similar in form. The
following figure shows the Properties panel for the Handle Graphics Figure
Property Table component:

Click Edit to modify most table settings.

Displaying Property Name/Property Value Pairs
The following sections discuss property name/property value pair display
options.

Split Property/Value Cells
In the Handle Graphics Property Table component’s Properties panel, click
Edit, and a dialog box appears. To have the property name and property value
appear together in one cell, clear the Split property/value cells check box.
This is nonsplit mode. In nonsplit mode, you can have more than one property
name/property value pair per cell and you can also have additional text.
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To have the property name and property value appear in adjacent horizontal
cells in the table, select the Split property/value cells check box. In
this case, the table is in split mode and there can be only one property
name/property value pair in a cell.

4-16



Working with Property Table Components

If you have more than one property in a cell, only the first pair is displayed in
the report; all subsequent pairs are ignored.

Display Options
Each table cell in the report can display a property name/property value
pair in several ways. To select how a property name/property value pair is
displayed in a table cell in the report, select that field in the table and choose
Value in the Display As text box.

Note that in the selected table row, only the value is displayed.

Alignment Options
Use justification buttons to specify the way that text in a cell appears in the
report. There are four justification buttons, which appear in the toolbar
below the figure:
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Note that the selected table row is double justified.

You can also right-click a table row and change justification options in the
context menu that appears.

Putting Text into a Table Cell
You can type text in a table cell in the table dialog box. For the text to be
visible, the table must be in nonsplit mode. To enter text in a cell, double-click
the table cell. A gray box appears with the label for the cell property.
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If you type text outside the angle brackets, the text appears as text in the
report. If you type text inside the table brackets, the text must be a valid
property name. If you type an invalid property name, that property name
appears in the report without a property value.
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Editing the Table Title
The table has a title that you can edit. The title of a table is the same as the
value of the %<Name> property. The title of the table can contain properties
and text. The title is always in nonsplit mode. To modify the title, modify
the %<Name> entry.

If the table has a title, it appears in the list of tables in the generated report.
Some stylesheets offer a list of tables. For a list of stylesheets that offer this
option, see “Setting the Report Format” on page 2-3

To enter a property, follow the steps described in “Adding, Replacing, and
Deleting Properties in a Table” on page 4-20.

Adding, Replacing, and Deleting Properties in a Table
To add, replace, or delete properties in a table, use the table editor dialog box.
Click Edit in the Property Table Component’s Properties panel. The following
figure shows the table editor for a Handle Graphics Property Table component:
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Adding a Property
To add a Handle Graphics property to a table cell in the table editor, follow
these steps:

1 Start the table editor.

2 Add a new, blank table row to the current table.

a Select a table row directly below the location where you want to add
a new property.

b Click Add Row Above Current Cell . A blank table row appears.

3 Add the property to the new table row.

a Select the new table row.

b In the Properties Type menu, select the property type that you want. In
the Properties menu, select the property that you want to add.

c Click Add or double-click the property name. The property appears
in the table row.

If you know the name of the property, you can also type the property name in
the cell. For more information, see “Putting Text into a Table Cell” on page
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4-18. For information about adding new table rows, see “Adding, Replacing,
and Deleting Properties in a Table” on page 4-20.

Replacing or Deleting Properties
In nonsplit mode, you can replace a property in a table cell in the Setup File
Editor by following the instructions in “Putting Text into a Table Cell” on page
4-18. You can delete a property by backspacing over it.

To replace a Handle Graphics property in a cell when the table is in split
mode, follow the instructions in “Adding a Property” on page 4-21. You
cannot use these steps to delete a Handle Graphics property in a cell when
the table is in nonsplit mode, because such cells can have more than one
property name/property value pair.

Displaying or Hiding Table and Cell Borders
You can toggle the table and cell borders on and off in the Property Table
by using the context menu.

To toggle a cell border on and off, place your cursor in the desired cell and
right-click to invoke the context menu. Choose Cell borders and then select
Top, Bottom, Right, or Leftto toggle the desired border on or off.

Adding and Deleting Columns and Rows
To add or delete a column or row, select a cell, and then click one of the buttons
described in the following table.

Button Action

Add column (added to the left of the selected column)

Delete selected column

Add row (added above the selected row)

Delete selected row
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You cannot delete a row or column when it is the only row or column in the
table.

Resizing Columns
To resize the column width, click and drag the vertical border between cells.

Zooming and Scrolling
While you are editing the table in the setup file, you can zoom in and out of
the table with the zoom buttons, located to the left of the horizontal scroll bar.

Button Action

Zoom in

Zoom out

You can scroll vertically and horizontally with the corresponding scroll bars
around the table.

Selecting a Table
You can select a preset table to display property name/property value pairs, or
you can create a custom table.

Preset Tables
A preset table is a table that is already formatted and set up. You can select
a preset table in the preset table drop box in the upper left corner of the
Properties panel. To apply a preset table, select the table and click Apply.

Custom Tables
To create a custom table, you can select a preset table and modify that table to
fit your needs. You might want to start with the Blank 4x4 preset table. You
can add and delete rows and you can add properties.
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Note You cannot save a custom table as a preset table. If you create a table
and then select a preset table, all your changes are lost.

Selecting Object Types
Property and summary table components offer multiple object types on which
to report. For example, the Handle Graphics Property table lets you report on
a figure, an axes object, or a Handle Graphics object.

To select a different object type, use the Object type list in the component’s
Properties panel.

The Handle Graphics Summary Table component offers the same object type
options. Deciding which object type to select depends on the object that you
want to include in the generated report. The Simulink Property Table and
Simulink Summary Table components include: block, model, signal, and
system object types.
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Working with Summary Table Components
Summary table components insert tables containing the details on the
selected object into generated reports. The generated tables contain one object
per table row, and each object property is a table column. Report Generator
offers numerous summary table components, including the Handle Graphics
Summary Table component, Simulink Summary Table component, and the
Stateflow Summary Table component.

Report Generator summary table components share common characteristics.
For that reason, this tutorial uses the Handle Graphics Summary Table
component as a representative of all summary table components.

A summary table can contain many properties. For example, the
simulink-summary setup file contains multiple Simulink Summary Table
components that report on Simulink blocks in the f14 model and their
properties.

Like the other sections in the chapter, this tutorial uses the figloop-tutorial
setup file.
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Examining the Report Output and the Setup File
In the generated report, summary table components generate tables that
contain the specified properties for the selected object. The following figure
shows the summary table produced by the figloop-tutorial setup file.

In the figloop-tutorial setup file, the Handle Graphics Summary Table
component is the child of a Chapter/Subsection component.
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Selecting an Object Type
You can select different Handle Graphics object types for the summary table,
including blocks, signals, systems, and models, with the Object type list in
the component’s Properties panel. The figloop-tutorial setup file contains
one Handle Graphics Summary Table component, and it reports on figure
objects.

The properties available to add to the table depend on the selection in the
Object type list.

Adding and Removing Properties
In the Property Columns pane, you select the object properties to be
displayed in the generated report. Depending on the object type, you can
select any object property to add to the summary table.
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To add a property to the summary table, select the property category from
the property category box to the right of the Property columns field. As
you select different property categories, notice that the field below the box
changes to display the category’s properties. The following figure shows main
as the category selected.

To add a property to the table, select the category from the property category

box, select a property in the properties list, and click Add . The property
should appear in the Property columns field.

To remove a property from the table, select the property in the Property
columns field and press Delete. The property name should disappear from
the Property columns field.

Note After making a change in Report Explorer interface, you must click
Apply for the changes to take effect.

You can also specify your own properties by entering the name manually in
the Property columns field. You must use proper Report Generator variable
notation. For more information, see “Using Variable Notation in Text Fields”
on page 1-20.

Setting Relative Column Widths
Using the Relative column widths field, you apply a relative column
width to the summary table columns in the generated report. Column width
is entered as a relative ratio. If omitted, column widths are determined
automatically.
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Setting Object Row Options
In the Object Rows pane, you configure options for the table rows, including
anchor, filtering, and sorting options. Selecting the Insert anchor for each
row option places an anchor in each table row in the generated report.

Using the Include figures list, you specify what objects are reported on in
the summary table. For example, in the figloop-tutorial setup file, the
summary table components report on figure objects. If you select All Figures
with tags, Report Generator reports on all figure objects that match the tags
specified. If you select Current figure only, Report Generator only reports
on the selected figure. If you select Visible figures, Report Generator only
reports on visible figure objects.
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Creating Components
Components are self-contained, modular elements that control the report
generation process and insert elements into a report. A component is a
MATLAB object (in the object-oriented programming sense).

Why Create Your Own?
In most cases, the components provided with Report Generator should be
more than adequate to meet your needs. However, you may want to create
your own components if you want to generate a report that cannot be easily
created by components included with Report Generator. For example, you can
create a component that inserts a corporate logo into your report, or you can
create a component that plots data.

What’s Involved in Creating Components
You can create custom components with the Component Creator, a tool for
creating new components. The Component Creator creates a “skeleton” object,
i.e., it sets up the raw structure of the component. It does not create all of
the executable M-code.

There are two main steps to creating and running a component:

• Use the Component Creator to create the M-files that form the framework
of the component. See “Component Description” on page 5-10.

• Edit execute.m to make the component executable. (This is an M-file
that is generated when you create a component.) See “Editing Generated
Files” on page 5-16.

5-2



Starting the Component Creator

Starting the Component Creator
To begin the component creation process, click on the Create a new
user-defined reporting component link in Report Explorer Properties
panel.

Two alternative methods to begin component creation are

• Type compwiz at the command line.

• Select one of the component creation choices available on the Tools menu
of Report Explorer. The Tools menu provides options for creating a new
component, deriving a component by modifying an existing Version 2
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component, or deriving a component by modifying an existing Version 1
component.

Modifying an Existing Component
If you want to derive a component from an existing Version 1 or Version 2
component, Report Explorer lists components from which you can choose a
component to modify. The lists of components are similar to the ones shown
below.

Double-click on the name of any component appearing in either of these lists.
The Component Creator GUI is displayed, showing the values and properties
previously determined for this component. (See “Creating a New Component”
on page 5-5 for details about the layout of the Component Creator GUI.)
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Creating a New Component
If you choose to create a new component, the Component Creator GUI is
displayed.

The Component Creator is a three-panel GUI displayed within the framework
of Report Explorer.

Outline panel Displays the structure of the component you are creating.

Options panel Lists example properties that you can add to a component.

Properties
panel

Specifies the behavior of component properties.

When you create a component, you also create several M-files, including
execute.m. The default execute.m file for a new component inserts an
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empty space into the report. Therefore, you must edit execute.m to run the
component properly.
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Defining a Component
When you create a component, you have to decide

• Where to put the directory that contains all the files for the component

• What class name to give the component

• What name will identify the component when it is displayed in Report
Explorer

• What description to give the component in Report Explorer

• Whether the component can have child components

You enter this information in the Properties panel of the Component Creator.

The Component File Location and Component Display Options panes
of the Properties panel allow you to indicate the location where you want to
store a new component and how it is to be displayed.

Component File Location Data
You indicate the location where you want to store your component in the
Component File Location pane of the Properties panel. When the
component is built, the information in this pane creates the directory structure
<parent>/@package_name/@class_name and stores the component files here.
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Class Directory Field
Assign a class name to your component. This name is used to create a
subdirectory under the package directory field. (See “Package Directory
Field” on page 5-8 below.) The build process places the component’s files in
this class directory. The class directory must be unique for each component
in the package. By convention, component class names begin with an upper
or lower case letter c.

Package Directory Field
The set of files created during the build process (see “Building or Rebuilding
a Component” on page 5-14) are stored in a directory under the name you
enter in this field. The directory is located as a subdirectory of the specified
package root directory.

Parent Directory Field
When you create a component, a set of files is created for the component.
These files are located in the class directory you designated in the Class
directory field. The class directory is in turn a subdirectory of the package
directory, which itself is a subdirectory of the directory that you specify in
the Parent directory field.

You specify the parent directory when you create a package for the first time.

You should choose a parent directory that is on the MATLAB path. Otherwise,
it may be difficult for MATLAB to find your component.

Component Display Options
You indicate how you want your component to appear in Report Explorer by
entering data in the Component Display Options pane of the Properties
panel.
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Display Name
You need to specify a display name for your component. This component name
is added to the list of components for its associated category. (See “Category
Name” on page 5-9 below.) Component categories and component display
names appear in the Options panel of Report Explorer.

Here is an example of creating a component called My First Component
under a category called My Category.

Category Name
When you create a component, you have to decide the category of components
to which it will belong. This is the category under which the new component
is displayed in the Options panel of Report Explorer. The available choices are
shown in the Category name list.
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The Category name selection menu shows all available component categories
such as Formatting, Handle Graphics, etc. To select an existing component
category, click on that component category on the menu.

To create a new component category, type the name for the category directly
into the Category name field.

This category name is added to the list of category names shown in the
Options panel of Report Explorer. For example, here is a picture of the
Options panel with a new category, My Category. The category contains a
single new component called My Component.

Component Description
The description of the component can be anything you want. You should keep
the description to one or two sentences. The description appears when you
click on the component name or category name in Report Explorer Options
panel.
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Child Components
If you select the Component may contain children check box, your
component can have child components. Child components appear indented
under the component in Report Explorer hierarchy. During execution, the
component will usually run all child components and include their output in
the report. (The actual behavior of child components is controlled by your
entries in the execute.m file.)

Specifying Component Properties
Component properties determine how a component behaves and what
information it inserts into a report. If you double-click on a property name
for a component shown in the Outline panel, the Properties panel displays
the current values for the property. For example, the next figure displays the
property values for New_String_Property.

By editing the values in the text fields, you can modify the information shown
in this GUI to create new component properties that control the behavior of
your component in ways that you specify.
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Choose a Property Name
Edit the default Property name appropriately to create a name for your new
property. A property name must be a valid MATLAB variable name (e.g., no
spaces, etc.). Property names must be unique within a component.

Specify the Data Type
The data type is the type of data that is used by the attribute. For more
information, see “Data Types” in the MATLAB Programming documentation.

The Data type list contains the following options:

• Double

• Enumeration

• Integer

• String

• String Vector

• %<Parsed String> This data type allows you to include the value
of a variable in the MATLAB workspace in a component. (See
“%<VariableName> Notation” on page 8-253 for a discussion and example
of the specification and use of this data type.)

• True/False

Specify the Default Value
Edit the Default value field to set a default value for the property. The
default value needs to be compatible with the data type. For instance, if the
data type is a MATLAB string, the default value must be enclosed in single
quotes (''). If incompatibilities exist between the default value and the data
type, the component may fail to build.

Specify the Dialog Prompt
This text appears next to the widget on the component’s dialog. It provides
the user with an indication of what the property does and what kind of effect
it has on execution.
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Note When the component is built, a colon is appended to your entry in the
Dialog prompt field. Your entry is displayed in the Properties panel with
the colon appended.

Adding Properties to a Component
The Component Creator provides several additional ways to add properties
to a component, using properties from the properties library. Each library
property provides an appropriate default value that you can modify to suit
your individual requirements.

• Add new property context menu (Outline panel).

Right-click the component name.

• Add property context menu (Options panel).

Right-click the property name.

• Drag and drop from Options panel.

Left-click the name of a property in the Options panel and drag it on top of
the name of a component in the Outline panel.

• Double-click the property name in the Options panel.

The property is added to the component and property values are displayed
in the Properties panel.
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• Add Property button (Property panel)

The Properties pane within the Property panel allows you to add new

properties to a component. Click Add Property to add an
additional property.

This pane additionally provides a display of the properties and values
assigned to the currently selected component.

Building or Rebuilding a Component
The Build pane of the Properties panel allows you to build a new component
or rebuild an existing one.

Build Component Button
After you have entered all data required for defining your category and

component, click Build Component to complete the
process. The Build process creates all the files needed to define the component
and stores them where indicated by the entries in the Location pane. Any
existing files in this location will be overwritten.
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Rebuild Constructor Button
Use this option when adding, removing, or changing properties of an existing
component. This button becomes active only after you have previously
created a component with the Build Component button. To activate
Rebuild Constructor, set the Package name and Class name fields in
the Location pane to the existing values for a defined component. If you
select Create component from on the Tools menu and select one of the
component choices presented to you, the fields are filled-in automatically and
the button becomes active.

In the other fields enter your changes to the component and Rebuild

Constructor to make your changes effective. User-editable
files in this location will not be overwritten.

Removing a Component
To remove a built component, find the class directory
(<root>/@package_name/@class_name). If this is the only
component in the package, you can delete the entire package. If there are
other components you want to preserve, delete the class directory. Also, edit
<root>/@package_name/rptcomps2.xml to remove the XML element that
registers the component. It may also be necessary to remove the component’s
category.

5-15



5 Building Custom Components

Editing Generated Files
Building a component creates several M-files in your MATLAB workspace.
The MATLAB editor initially displays the three most significant files. You
must edit execute.m to make the component perform as you expect. Editing
of the other M-files is optional. The table below describes the significant
M-files that you can edit for specific purposes.

Edit This M-File To Complete This Task

execute.m Specify the report output format and content.

getDialogSchema.m Modify the characteristics of the properties dialog
for a created component.

getOutlineString.m Change the string that describes the component
in the hierarchy. This string is initially entered in
the Display name field of the Properties pane
on the Create Component: Main panel.

Editing the execute.m File
The execute.m M-file is called during report generation to produce the
component’s contribution to the report. After you have built the file during
component creation, you must edit it to specify the explicit format and content
of your output.

The generic form of the execute command is

out = execute(thisComp, parentDoc)

where:

• thisComp is the name of Report Generator component being run.

• parentDoc is a handle to the current document being generated.

• out is a Document Object Model (DOM) node or string to be added to the
report. (For more help with manipulating DOM nodes, see xmlwrite.)

Within the file one or more default lines of code shows each component
property. Property values control how the component behaves during
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execution. Property values should not be changed or set during execution.
Here is an example of a component property line within an execute.m file.

pstring = thisComp.NewStringProperty; % New string property;

Four additional blocks of commented code show how to create these basic
documentation elements:

• “Create a Table” on page 5-17

• “Create a List” on page 5-18

• “Create Text” on page 5-18

• “Create Figures” on page 5-18

You edit this code and add any needed additional code to the file to specify
your output content. After you have processed your data, this code returns
the component’s formatted output.

See the following sections for more details.

Create a Table
To create a table, replace the Source property value below with the name of
your cell array or structure. (Type help(rptgen.cfr_table) at the MATLAB
command line for additional information.)

out = execute(rptgen.cfr_table(...
'Source', tableSrc,...
'numHeaderRows',1,...
'TableTitle','Example Title'),...
parentDoc);

Note For an example of an execute.m file that has been edited to produce
tabular output, see “Editing execute.m” on page 5-26.
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Create a List
To create a list, replace the Source property value below with the name of
your cell vector. (Type help(rptgen.cfr_list) at the MATLAB command
line for additional information.)

out = execute(rptgen.cfr_list(...
'Source', listSrc,...
'ListStyle','orderedlist',...
'ListTitle','Example List'),...
parentDoc);

Create Text
To create text, replace the ParaText property value below with your text
string. (Type help(rptgen.cfr_paragraph) at the MATLAB command line
for additional information.)

out = execute(rptgen.cfr_paragraph(...
'ParaText', paraSrc,...
parentDoc);

Create Figures
To create figures, set the FigureHandle property value with your figure.
(Type help(rptgen_hg.chg_fig_snap) at the MATLAB command line for
additional information.)

figSrc = gcf;
out = execute(rptgen_hg.chg_fig_snap(...
'FigureHandle', figSrc,...
'Title', '',...
'isResizeFigure', 'manual',...
'PrintSize', [6 4],...
'PrintUnits', 'inches'),...
parentDoc);
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Child Components
An additional block of code shows how to run child components. The first line
calls the execute.m method for all child components. The second line appends
the result of the child runs to the document.

childOut = thisComp.runChildren(parentDoc);
out = parentDoc.createDocumentFragment(out, childOut);

Changing the Outline String
The getOutlineString M-file returns the string used in Report Explorer
hierarchy. The generic form of the getOutlineString command

olstring = getOutlineString(thisComp)

returns a single-line string that displays important information about the
component, where:

• thisComp is the component being described.

• olstring is the descriptive string.

This string is displayed in the hierarchy of Report Explorer.

By default getoutlinestring returns the display name of the component.
The string should be fewer than 32 characters long.

Customizing the String
You can customize the string to show additional information about the
component, such as the state of its properties. The truncatestring function
converts any data type into a single line string. The second argument is
the return value if the data is empty. The third argument is the maximum
allowed size of the resulting string.

cInfo = '';
pstring = rptgen.truncateString(thisComp.string,'<empty>',16);

The string typically uses a dash (-) as a separator between the name and
additional component information.
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if ~isempty(cInfo)
olstring = [olstring, '-', cInfo];

end

Editing the Dialog Schema
The getDialogSchema M-file returns all information necessary to create a
properties dialog display. The format of the getDialogSchema command is

dlgstruct = getDialogSchema(thisComp, name)

where:

• thisComp is an instance of the component being edited

• name is a string that can be passed to getDialogSchema to build a specific
type of panel. Normally, name is empty in Report Explorer.

The getDialogSchema file provides a comprehensive, extensively documented
template with which you can modify most aspects of dialog layout, including
creation and placement of widgets, organization of widgets into panels, and
creation of the top-level display within which the panels reside.

Note Advanced MATLAB users are cautioned against modifying fields not
explicitly mentioned in this file. These fields are undocumented and subject
to change in future releases.

Editing Additional Files
There is an additional set of editable files that does not initially appear in the
MATLAB editor. To access these files, right-click on component in the Outline
panel and select Edit files from the menu.
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The contents of the MATLAB editor now expand to include the additional
files listed in the table below.

M-file Purpose

getParentable.m Indicate whether or not a component can contain
children.

getDescription.m Edit to change a component description.

getName.m Edit to change display name.

getType.m Edit to change category name.

rptcomps2.xml Change entries in the registry. Must remain consistent
with entries in getName.m and getType.m.

viewHelp.m Open file in Help viewer.

_help.html Help file viewer

getParentable.m
This file indicates whether or not a component can contain children. It
returns the value true or false. You can modify the value within the code

p = false;

if the requirement for child components has changed.

getDescription.m
The description within this file corresponds to the entry you made in the
Description field in the Component Creator. The following example shows
the display for

compDesc = 'A demonstration component';

Edit the compDesc string to change the component description.
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getName.m
The name within this file corresponds to the entry you made in the
Display name field in the Component Creator. The following example shows
the display for

compName = 'Cemo Component';

Edit the compName string to change the display name.

getType.m
The name within this file corresponds to the entry you made in the
Category name field in the Component Creator. The following example
shows the display for

compCategory = 'Custom Components';

Edit the compCategory string to change the category name.

rptcomps2.xml
This file registers components with Report Explorer and helps to build the list
of available components. Information in this file must be consistent with the
values entered in the getName.m and getType.m files. If you have changed
values in either of these files, you must change the respective values in the
rptcomps2.xml file accordingly. The Report Explorer displays the modified
information after you have restarted MATLAB.

viewHelp.m
This file displays a help file for the component within the MATLAB Help
browser. To display the help file, highlight the name of the component in
Report Explorer and click Help.
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_help.html
This file works in conjunction with viewHelp.m to display help information
for a designated component.

Here is an example of a help file display for a user-created component.
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Component Creation Examples
This section provides two examples showing the creation and use of
component properties:

• The first example, “Creating and Using Component Properties” on page
5-24, provides an example of developing a component that fetches stock
market data and displays the result in tabular format.

• The second example, “A Report Displaying Two Tickers” on page 5-29,
expands upon the first example, showing the use of multiple properties
within a component.

Creating and Using Component Properties
To illustrate the creation and use of component properties, you will create
a component named Equity Values that displays a table of stock market
information in a report. To obtain the desired result, you will

• Give this component a string property named Ticker.

• Build the component.

• Edit the generated execute.m file.

• Display the final output.

Note This example requires the Datafeed Toolbox.

Step 1: Create a Component
Start by creating a component named Equity Values in the class directory
named CStockTicker. The remainder of the component information is
arbitrary.

Step 2: Create a Property
Now give the component one string property named Ticker. Start by
double-clicking on New_String_Property in the Options panel of the
Component Creator. This adds a property to the component you are
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constructing. Then edit Property name appropriately. A property name
must be a valid MATLAB variable name (e.g., no spaces, etc.).

Specify the Data Type. The data type is the type of data that is used by
the attribute. Your Ticker property is a string value, so there is no need
to change the default.

Specify the Default Value. Edit the Default value field to set a default
value for the property. Since for this example you will obtain ticker values
for the security Google, set the Default value to 'GOOG'. (Note that since
this is a MATLAB expression, the single quotes are required to make this a
string value.)

The GUI with these property values entered appears below. Note that in
the Code Preview pane the code has been modified to reflect the settings
you entered above.

Step 3: Build the Component
Click Build on the Component Creator GUI to create the new component.
The Equity Values component is now displayed among the choices in Report
Explorer Options panel.
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Step 4: Initialize the New Component
Building a component creates a number of M-files. Among the created files
is execute.m, which runs the component when the report is generated.
The default execute.m file created by the Component Creator inserts
nothing into the report. You must edit execute.m to make the component
perform as you expect. You can optionally edit other generated files,
such as getOutlineString.m and getDialogSchema.m to provide further
customization of your output.

Editing execute.m. When you create a component, Report Generator
creates an @<compfilename> directory; in this example the created directory
is @CStockTicker. In this directory, open the execute.m file, which runs the
component when the report is generated. This method inserts into the report
the information that the component creates when the report is generated.

In this example you want the component to obtain information about Google
and produce output for your report in tabular format. An edited version of an
execute.m file that accomplishes this appears below. The MATLAB datestr
function converts the date and time information obtained from Yahoo into a
more user-friendly format.

function out=execute(thisComp,parentDoc,varargin)

stockQuote = fetch(yahoo, thisComp.Ticker);
stockQuote.Date = datestr(stockQuote.Date,1);
stockQuote.Time = datestr(stockQuote.Time,13);
out = execute(rptgen.cfr_table(...

'Source', stockQuote,...
'numHeaderRows', 0,...
'TableTitle', 'Stock Market Pricing Data'),...

parentDoc);

Here’s an example of the report output produced using this version of
execute.m.
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Editing getOutlineString.m. The following version of getOutlineString.m
has been edited to append the symbol for the security to the display name.

function olstring=getOutlineString(thisComp)

olstring = [getName(thisComp),' - ',thisComp.Ticker];

The figure below shows the result of this file modification.
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Editing getDialogSchema.m. You can modify the getDialogSchema.m
file to change the appearance of the properties display in numerous ways.
The edited version that follows displays the last quoted price for the security
as part of the properties display. Some additional edits to improve the
appearance of the graphical output have also been made.

function dlgStruct = getDialogSchema(thisComp, name)

try
currQuote = fetch(yahoo, thisComp.Ticker);
quoteStr = sprintf('Last value: %g', currQuote.Last);

catch
quoteStr = sprintf('Warning: "%s" is not a valid symbol.',...
thisComp.Ticker);

end

dlgStruct = thisComp.dlgMain(name,...
thisComp.dlgContainer({

thisComp.dlgWidget('Ticker',...
'DialogRefresh',true,...
'RowSpan',[1 1],'ColSpan',[1 1]);

thisComp.dlgText(quoteStr,...
'RowSpan',[2 2],'ColSpan',[1 1]);

},'Stock',...
'LayoutGrid',[3 2],...
'RowStretch',[0 0 1],...
'ColStretch',[0 1]));

Here is the resulting display from the changes made above.

If you enter an unrecognized value into the New market property field, a
warning message is displayed.
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A Report Displaying Two Tickers
Create a new report and save it as stockreport.rpt. Add two of your custom
components to the report.

Change the ticker property of the second component to '^GSPC' (S&P 500
index) by editing the entry in the New marker property field.
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Run the report. The report provides two tables of data, one for Google and
another for the S&P 500 index. The report showing the resulting tables is
displayed below.
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Stylesheets: An Overview
A stylesheet specifies the formatting and display of a document. Report
Generator uses stylesheets to control settings for documents of the following
kinds:

HTML Uses stylesheets for either single or multiple-page documents

PDF Uses Formatting Object (FO) stylesheet

RTF Uses Document Style Semantics and Specification Language
(DSSSL) stylesheet

How Do Stylesheets Fit into the Report Generator
Process?
Whenever Report Generator creates a report, it first generates a DocBook
XML source file, which it then converts to the formatted document. This
conversion process uses a stylesheet. If you want to generate the same report
in a different format, you can convert the XML document using a different
or modified stylesheet.

When Do You Need to Edit a Stylesheet?
In many cases, the stylesheets provided with the Report Generator are
adequate to meet your needs. Nonetheless, you may want to modify the
built-in styles to meet special requirements.

For example, suppose your company requires a certain size font for the title of
any reports that are part of the company database, and this specification is
not part of the built-in stylesheet that otherwise matches your requirements.
In this case, you can edit the stylesheet you are using to match this special
requirement. You can also create a new stylesheet.
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Working with Stylesheets
Follow these steps to edit and use a built-in Report Generator stylesheet:

1 Open the Stylesheet Editor, which appears as shown:

2 Double-click the stylesheet you want to work on, or click one of the links in
the Properties panel to create a new stylesheet.

3 Give the stylesheet a name and description.

4 Edit the stylesheet properties. You can edit XML directly using advanced
edit mode.

5 Save the stylesheet.

6 Use the stylesheet to convert a report.

7 Close the Stylesheet Editor.

You may also want to

• Delete a stylesheet.
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• Create a new stylesheet.

Opening the Stylesheet Editor
To begin the stylesheet editing process, open the Stylesheet Editor in any
of the following ways:

• From the menu bar in Report Explorer, select Tools > Edit stylesheet.

• From the Outline panel of Report Explorer, right-click Report Generator
and select Edit stylesheet.

• From the Outline panel of Report Explorer, right-click a report (if one is
displayed) and select Edit stylesheet.

• From the Properties panel in Report Explorer, click Create or modify
document conversion stylesheet.

• At the command line in MATLAB, type rpteditstyle.

Editing Stylesheet Properties
To edit properties of an existing stylesheet,

1 Open the stylesheet for editing in any of the following ways:

• Drag a stylesheet from the Options panel to the Stylesheet Editor.

• Select the stylesheet from the list displayed in the Options panel and
click Edit stylesheet in the Properties panel.

• Double-click the name of the stylesheet.

The Properties panel now contains editable fields and a list of the
customizations in the selected stylesheet.

2 Add to or change the text in the property fields.

After you edit the properties for the stylesheet, you may want to “Editing
Style Data Items” on page 6-17 for the styles you want to customize.

See “Editing Style Data Items” on page 6-17 for more information about
editing data items.

6-4



Stylesheets: An Overview

Sample Stylesheet Properties
In the following illustration,

• The ch1–tutorial.rpt report is open in the Report Generator and is
displayed in the Outline panel.

• The Stylesheet Editor is open and is displayed in the Outline panel.

• The default print stylesheet is of type fo and is open in the Stylesheet
Editor and contains customizations.

• The Options panel lists all styles that are available for the current
stylesheet.

• The Properties panel contains

- Editable fields describing the selected stylesheet

- A list of any customizations in the selected stylesheet

- Transform type

- A Send to Source File Converter button
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Saving a Stylesheet
To save a stylesheet,

1 In the Outline panel, select the stylesheet that you want to save.

2 Do one of the following:

• Select File > Save from the menu bar.

• Select File > Save As from the menu bar.

• Right-click and select Save from the shortcut menu.

• Right-click and select Save As from the shortcut menu.

If you choose Save, the Stylesheet Editor saves the file with the current
filename in its current location. You cannot overwrite the built-in stylesheets;
instead use Save as and give the stylesheet a new name.

If the file has not yet been saved, the Stylesheet Editor prompts you for a
filename and a location for the file.

Note By convention, files containing Report Generator stylesheets have .rgs
as their filename extension.

Typically you should choose a location that is in your MATLAB path, and the
filename must be unique in the MATLAB path. If the file is not saved to your
MATLAB path, the stylesheet does not appear in the Report Explorer.

If you choose Save As, the Stylesheet Editor prompts you for a filename
and location.

You must save a stylesheet before you can use it for converting a source file
or associating with a report.

Using Unique Filenames. Report Generator identifies stylesheets
internally by filename without any path information. Thus, stylesheet
filenames must be unique across all paths. Repeated filenames may cause
certain stylesheets to be ignored upon generation.
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For example, if you have a stylesheet ~/project1/largetype.rgs, you
cannot also have a stylesheet ~/project2/largetype.rgs. If you try to save
a file with a duplicate filename, Report Generator prompts you to change
the filename.

Converting a Report Using a New Stylesheet
Use a modified or newly created stylesheet just as you would use a built-in
stylesheet. Keep in mind that you do not need to generate a new report to
make the changes in styles; you can skip the generation step and go directly
to the conversion step.

For example, click Edit in the Convert Source File area of Report Explorer
if you want to edit a stylesheet before converting the report.

You can also use a customized stylesheet for conversion by clicking Send to
File Converter in the Stylesheet Editor, as shown:

See “Converting XML Documents with Report Explorer” on page 2-8 for
information about converting XML file source files that are generated by
Report Generator.

Closing the Stylesheet Editor
Close the Stylesheet Editor in either of the following ways:

• Right-click the Stylesheet Editor in the Outline panel and select Close.

• Select Stylesheet Editor in the Outline panel and press Ctrl+W.

Deleting a Stylesheet
To delete a stylesheet that you created,

6-7



6 Creating and Using Customized Styles

1 Select the Stylesheet Editor in the Outline panel.

2 Select the stylesheet to delete from the Stylesheet Editor Options panel.

3 Click Delete stylesheet in the stylesheet’s Properties panel.

Note You cannot delete the built-in stylesheets.

Deletions or renaming of stylesheets from the file system may not appear in
the Options panel until you restart MATLAB.

Deleting a Customized Style
To delete a customized data item,

1 Right-click the customized data item in the Outline panel.

2 Select Delete.

Creating a New Stylesheet
To create a new stylesheet,

1 Open the Stylesheet Editor.

2 In the Properties panel do any of the following:

• Click New HTML to create a new stylesheet for HTML reports.

• Click New multi-page HTML to create a new stylesheet for HTML
reports with more than one page.

• Click New FO (PDF) to create a new stylesheet for PDF reports.

• Click New DSSSL (RTF) to create a new stylesheet for RTF reports.

The new stylesheet appears in the Outline panel.

3 In the Properties panel, modify the properties for the stylesheet as needed.

4 Add styles to the new stylesheet:

6-8



Stylesheets: An Overview

a Drag the style you want to add from the Options panel to the stylesheet
in the Outline panel.

b In the Properties panel, edit the data items for the selected style.

5 Save the stylesheet.
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Understanding the Stylesheet Graphical User Interface
This section covers the following topics:

• “Stylesheet Editor ” on page 6-10

• “Main Stylesheet Properties” on page 6-13

• “Data Properties Panel” on page 6-14

Stylesheet Editor
When you start the Stylesheet Editor, Report Explorer opens as shown.
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• The Report Generator in the Outline panel contains the Stylesheet Editor.

• The Options panel lists the available stylesheets.
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Note By default, the folders in the Options panel are open. You might
want to close them to see all categories at once. Whenever you are in the
Options panel, double-click a folder to close it.

Alternatively, you can right-click each folder and select the Hide/show
category menu item.

The Properties panel shows the Stylesheet Editor (which is currently selected
in the Outline panel).
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From the Stylesheet Editor, the tasks shown in the following table.

Task Panel to
Use

Action

Create a new stylesheet. Properties Click the link that corresponds
to the kind of stylesheet you
want to create.

Open a custom stylesheet
that has already been
created.

Properties Click the name of the
stylesheet, which should appear
in the Open Stylesheets area.

Select a stylesheet to use
when converting an XML
source file.

Option Select a stylesheet.

View a list of customized
styles in a stylesheet.

Outline Expand any open stylesheet.

View a list of styles in a
stylesheet.

Outline or
Options

Double-click the stylesheet.

View a list of stylesheets
available for editing in each
category.

Options Double-click the folder that
corresponds to the kind of
output you want (that is,
HTML, PDF, or RTF).

View stylesheets that are
currently open.

Outline Expand the Stylesheet Editor.

Main Stylesheet Properties
When you open a stylesheet, Report Explorer displays the following
information:

• The Outline panel shows the name of the current stylesheet and any
customized styles that it contains.

• The Options panel shows folders containing all the style data items
available for the current stylesheet.
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• The Properties panel displays Stylesheet Editor: Main and shows
the properties of the stylesheet, such as name and description, and
customizations, if any, that belong to the stylesheet.

From the Stylesheet Editor: Main you can perform the following tasks.

Task Panel to Use Action

Change the name or description
of the current stylesheet.

Properties Edit the text in the
Display Name or
Description field

Convert an XML source file using
the current stylesheet.

Properties Click Send to Source
File Converter in
the Properties panel.

Edit style data that is already
customized.

Properties Click the style data
item, which appears
in the Stylesheet
Customizations
area.

Open a style data item for editing
or viewing.

Options Double-click the data
item that you want to
edit.

View a list of style data that is
already customized.

Outline Expand the
stylesheet.

Data Properties Panel
When you open a style data item, Report Explorer appears as follows.

• The Outline panel shows the name of the current style data item inside
its stylesheet.

• The Options panel shows a list of all available stylesheet data items.

• The Properties panel displays Stylesheet Editor: Data and shows the
following.

- The value of the data item is in a pane labeled Value or Value (XML),
depending on the current edit mode for the data item.
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- To the right of the value is the Edit as toggle button. You can edit the
value using simple or advanced edit mode.

- The Preview pane contains a fragment of the stylesheet that specifies
the data item. You cannot edit this pane.

- The Help pane contains information about the data item. You cannot
edit this information.

Simple and Advanced Edit Modes
You edit values for most data items in PDF and HTML stylesheets in either
simple edit mode or advanced edit mode. You edit values for RTF stylesheets
only in simple edit mode.

Simple edit mode means that you are editing a simple string that corresponds
to the data in the stylesheet. This string appears in the field to the right of
the Value label. For some values you can use a drop-down list to change
the value instead of typing in text.

Advanced edit mode means that you are editing the XML code directly. To
switch from simple to advanced edit mode, click Edit as XML.

The user interface is set to simple edit mode when the data item is displayed
in a pane labeled Value and to advanced edit mode when the data item is
displayed in a pane labeled Value (XML).

Note To modify content for headers and footers you edit stylesheet cells,
which do not appear in either simple or advanced mode. See “Stylesheet Cells”
on page 6-28 for more information.

6-15



6 Creating and Using Customized Styles

Working with Data Items in the Stylesheet Editor
Use the Properties panel to modify the values for each data item that you
want to customize. You use different methods of editing the stylesheet
according to the kind of data item you are editing.

Stylesheet Editing Methods

Type of Data How to Edit For More Details

Attribute sets Type text in the Inherit Attribute sets field. See “Attribute Sets” on
page 6-25.

Boolean values

Enumerated
values

See “Boolean and
Enumerated Values”
on page 6-18.

Strings

Use simple or advanced edit mode according to
whether you want to edit a string (simple) or
edit the XML directly (advanced).

See “Strings” on page 6-20.

Title Placement
Properties

Use drop-down menus to indicate whether title
should go before or after the figure or table.

See “Title Placement
Properties” on page 6-25.

TOC Generation
Properties

Use check boxes to indicate which components
of the document should have which level of
TOC.

See “TOC Generation
Properties” on page 6-24.

XML Expressions Use simple or advanced edit mode according to
whether you want to edit a string (simple) or
edit the XML directly (advanced).

See “XML Expressions” on
page 6-21.

Stylesheet cells Use templates to specify XML code that defines
the content for a header or footer.

See “What Is A Stylesheet
Cell?” on page 6-29 and
“Using Templates to Add
Content to Headers and
Footers” on page 6-32
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Editing Style Data Items
The styles that the file converter uses for a report are specified in a stylesheet
as values for data items such as parameters and attributes. The data items
are of several types. Each type requires a different way of editing.

See “Working with Data Items in the Stylesheet Editor” on page 6-16 for an
overview of editing data items.

See the following sections for details about working with each particular
type of data item.

• “Boolean and Enumerated Values” on page 6-18

• “Strings” on page 6-20

• “XML Expressions” on page 6-21

• “TOC Generation Properties” on page 6-24

• “Title Placement Properties” on page 6-25

• “Attribute Sets” on page 6-25

• “Attributes” on page 6-26

• “Cell Groups ” on page 6-28

• “Stylesheet Cells” on page 6-28

Note See the Help area at the bottom of the Properties panel for a
description of a specific data item that you are editing.
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Boolean and Enumerated Values
For most stylesheets, you can use either simple or advanced edit mode to edit
data items of Boolean type and to edit data items that have finite enumerated
values.

To use simple edit mode, set the Properties panel to display the string value
in a pane labeled Value.

Note If the pane is labeled Value (XML) you are in advanced mode. Click
Edit as String to switch to simple edit mode.

To use advanced edit mode, click Edit as XML. In advanced mode, the
Properties panel displays the data item as Value (XML).

Here is an example of the Properties panel for a data item in the Default
print stylesheet, namely the Show Comments data item.
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As shown in this example, the value of the data item is of type Boolean and
the current value is specified as true(1). The Properties panel is set to simple
edit mode.

To change this value, use the drop-down menu for the value field and click a
different value. In this case, the only other possible value is false(2).

For more complex editing, click Edit as XML.

Note You cannot use advanced edit mode for any data items in RTF
stylesheets.

In advanced edit mode, the Properties panel for this data item appears as
shown:
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Strings
For the values of some data items, the Stylesheet Editor displays text in the
Value field. This text is not an XML expression, and you can edit it freely in
the Value field. The text does not have to be specified as an XML expression,
but you have the option of typing XML characters.

If you prefer to edit the XML directly, use advanced edit mode as follows:

1 Click Edit as XML.

2 Edit the XML in the Value (XML) pane.

Note You cannot edit data items for RTF stylesheets as XML.
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XML Expressions
If you want to make complex changes to a stylesheet, consider using advanced
edit mode, that is, edit XML expressions directly in the Value (XML) pane. If
this pane is not displayed, click Edit as XML to switch to advanced edit mode.

When you edit XML expressions, you must make sure that you type valid
XML in the Value (XML) pane. Any values that are not legal generate an
error. The error appears at the top of the Property panel.

Here is an example of the display for XML that is missing a right-angle
bracket:
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Note If you get an error, you can fix the problem in the Value (XML) pane
and try again. The Stylesheet Editor does not allow you to use illegal XML
code in the report generation process.
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Editing Font Size as a Derived Value in XML
You might want to edit in XML directly if you need to change conditional
values or values derived from others.

To see an example of values derived from others,

1 Open the default print stylesheet for PDF documents.

2 In the Options panel, select and expand the Property Sets folder.

3 In the Options panel, double-click the Section Title Level1 Properties
data item.

The Properties panel appears as shown:

4 In the Attributes area of the Properties panel, click Font size - <xml>.

The Report Explorer appears as shown:
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Notice that the value is specified as a product of $body.font.master and
2.0736. To change the font size to a larger size, you could change the
multiplication factor to 3.0736.

Note The value for the $body.font.master data item is specified in the
Body Font Master property, which is in the Pagination and General Style
category in the Options panel. The default value is 10. Changing this value
causes the derived values to change accordingly.

TOC Generation Properties
To change values for generation of the table of contents (TOC) you use simple
edit mode and select the values you want from a matrix of check boxes.

Here is an illustration of the Report Explorer ready for editing the values for
the Generate Toc data item, which belongs to the Simple Print stylesheet.
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Title Placement Properties
The Title Placement data items are in the Miscellaneous category. They
control the position of titles for figures and tables. You can edit the values
for these items in simple edit mode.

When you select one of these data items for editing, the Property panel shows
the possible values in a drop-down menu. Use the menu to indicate whether
you want the title to go before or after the figure or the table.

Attribute Sets
An attribute set is a group of attributes. When you select an attribute set in
the Outline panel, the Property panel lists the attributes that belong to the set.

To edit an attribute, expand the attribute set in the Outline panel and select
the attribute.
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To edit the attribute set, type text in the Inherit attribute sets area of the
Property panel.

An example of an attribute set is Formal Object Properties, a data item
in the Property Sets category of the default print stylesheet for PDF
documents.

Here is an example of the Report Explorer showing the Formal Object
Properties attribute set in the Properties panel.

Attributes
An attribute is a data item that specifies information for an XML element.
An attribute must be a child of an Attribute Set.
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You can edit the values for attributes in either simple or advanced edit mode.

Note The information in the Help area of the Property panel for an attribute
describes the set to which the attribute belongs.

An example of an attribute is the Space Before Minimum attribute in the
attribute set Formal Object Properties. The Report Explorer appears as
shown.

Varpair Values
All the data items in RTF stylesheets are represented as varpair data items,
which are name/value pairs of information. RTF stylesheets are the only type
of Report Generator stylesheets that have varpair data.

You can edit varpair data items only as strings or as Boolean values. Boolean
values are represented as true (#t) and false (#f).

You cannot edit RTF stylesheet data items as XML.
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Note Because the varpair data is sometimes represented in the stylesheet as
DSSSL rather than XML, the code that is displayed in the Preview pane of
the Properties panel looks different from the code associated with other kinds
of stylesheets supported by Report Generator.

Cell Groups
There are two cell groups: Header Content and Footer Content, which are
available for PDF reports. A cell group contains one or more stylesheet cells.
A stylesheet cell is a set of values that determine the content of a particular
portion of the header or footer for a page.

The Properties panel for each of cell group lists the current stylesheet cell
definitions for the group in a two-column list called Conditional cell values.
The first column displays the name of a condition and the second column
displays the content and default value to be used if a specified condition is met.

For instance, Page sequence - Blank is the name of a stylesheet cell. It
specifies the content for a blank page; by default the content is set to empty.
Similarly, Cell - Right Side specifies the content for the right side of the
header on every page.

There are many combinations of conditions and values that you can use to
customize the content of headers and footers. Report Generator provides
several predefined conditions that are frequently used. These predefined
cells are listed in the Properties panel for Header Content and for Footer
Content cell groups.

See “Stylesheet Cells” on page 6-28 for more information about stylesheet
cells and how the File Converter works with them.

Stylesheet Cells
This section covers the following topics:

• “What Is A Stylesheet Cell?” on page 6-29

• “Specifying Content for Headers and Footers” on page 6-31
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• “Using Templates to Add Content to Headers and Footers” on page 6-32

• “Note on the Relationship Between Properties and Cells for Headers and
Footers” on page 6-33

What Is A Stylesheet Cell?
For purposes of specifying the content for headers and footers, Report
Generator defines a page to include six possible locations, or cells. These
positions correspond to the left, right, and center of the header and the left,
right, and center of the footer.

Conditions and Their Values. A stylesheet cell contains a condition and
content. For example, say you want the right side of the top of all pages to
have a page number. In this case you could define a basic stylesheet cell in the
Header Content cell group to have a condition set to right and content set to
be the current page number. To view this example:

1 Open the stylesheet editor for a PDF stylesheet.

2 Double-click Header Content in the Options panel.

3 Click Position - Right in the Properties panel.

For Position - Right, the XML code for the condition and content appear
as shown:
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As you can see, the XML code for the condition is

$position='right'

In this example the code for content is empty. Select a template and click
Append to add the content that you need for your particular report.

See “Using Templates to Add Content to Headers and Footers” on page 6-32
for more information about templates.

Complex Conditions. You can specify more complex conditions. Complex
conditions typically specify not only the position on the page but other
settings, such as whether the content should appear on a titlepage (The
condition of being on a titlepage belongs to the $pageclass condition.)

You can use standard logical operators (such as = , != , and, or) to specify a
complex condition. You can also use nested expressions (characters between
parentheses are an expression within an expression).

For instance, you can specify that the center position of the header should be
empty if a title page is being generated, but that the center should contain
the company logo if a body page is being generated. This specification
corresponds to a default stylesheet cell named Body page Center, which
is defined as follows:

($sequence='odd' or $sequence='even') and
$position='center' and
$pageclass != 'titlepage'

This expression indicates a condition where the page is either odd or even,
the position must be the center (of the header or footer), and the page is not
a titlepage.

See “Adding a Company Logo to Headers in a PDF Report” on page 6-37 for
an example of how to make this particular customization.

When the File Converter processes a page it evaluates the settings that are
relevant to each of the six cells on the page and adds content accordingly. If
there are no conditions in effect for a cell, the File Converter uses the default
values as defined in the cell group.

6-30



Editing Style Data Items

The possible conditions and their values as coded in XML are shown in the
following table.

Name of
Condition

Possible Values
for the Condition

Sample XML Code

$position right
center
left

$position='right'
$position='center'
$position='left'

$sequence odd
even
first
blank

$sequence=odd
$sequence=even
$sequence=first
$sequence=blank

$double-sided 0
1

$double-sided=0
$double-sided=1

$pageclass $titlepage
$lot
$body

$pageclass=$titlepage
$pageclass=$lot
$pageclass=$body

Specifying Content for Headers and Footers
Use the Properties panel for a stylesheet cell to specify content according
to conditions.

The Properties panel for a stylesheet cell displays the following areas:

Label Definition Description

Condition Condition that must
be satisfied for the
content to be used.

This is a drop-down list of frequently used and
predefined conditions. They are listed by their display
names. Click Edit to view or change the XML code
that goes with the name.

See “What Is A Stylesheet Cell?” on page 6-29 for more
information about the concept of s stylesheet cell.
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Label Definition Description

Value(XML) Content to be used if
the condition is met.

This is an editable field where you modify or create the
XML code that specifies the content.

Append
Template

Name of the template
you want to use to
add content.

To help you specify the values for a stylesheet cell,
the Stylesheet Editor provides templates that contain
some or all of the XML code needed to add some kinds
of content. See “Using Templates to Add Content
to Headers and Footers” on page 6-32 for more
information about this feature.

Using Templates to Add Content to Headers and Footers
To specify content without using a template, type XML code directly into
the Value (XML) text box.

To use a template to specify content:

1 In the Append template drop-down list, select the kind of content you
want to add.

2 Click Append.

The Properties panel displays the XML code for the default content of that
kind. You can edit the XML to change the default.

There are templates available for adding text, author names, page numbers,
titles for chapters and sections, chapter numbering, draft information,
comments, and graphics.

For example, to specify text as the content:

1 Select Text from the Append template drop-down list

2 Click Append.

3 Edit the value for xsl:text.

The default content is Confidential.
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Note Templates used by the File Converter are Extensible Style Language
Transformations (XSLT), which is a language for transforming XML
documents into other XML documents. For more information about XSLT, see
the website for the World Wide Web Consortium (W3C).

Note on the Relationship Between Properties and Cells for
Headers and Footers

• “Modifying Fonts and Other Properties” on page 6-33

• “Inserting Graphics Files” on page 6-33

Modifying Fonts and Other Properties. You cannot use stylesheet cells
to modify the font family or other such properties of headers and footers. To
specify the style of the content in headers and footers, use Header Content
Properties and Footer Content Properties, which are attribute sets.

Each of these attribute sets is a pagination style data item for PDF stylesheets.
You modify an attribute in the set, such as the Font Family attribute in
Header Content Properties, by selecting the attribute in the Outline panel.

Inserting Graphics Files. When you add content in the form of a graphics
file, you must specify not only the name of the file in the stylesheet cell that
belongs to Header Content or Footer Content; you must also edit other
pagination properties to allow room for the graphic to appear where you
specify. Typically you can do this by selecting and editing the values of the
Region Before Extent and Region After Extent data items, which are in
the Pagination and General Styles folder of the Options pane for PDF
formatting.

See “Adding a Company Logo to Headers in a PDF Report” on page 6-37 for
an example of adding a graphic.

Note Only bitmap images (.bmp files) are supported by the Stylesheet Editor
as image content in headers and footers.
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Making Some Specific Stylesheet Changes
This section provides the following extended examples:

• “Making Changes in Font Size, Page Orientation, and Paper Type” on page
6-34

• “Adding a Company Logo to Headers in a PDF Report” on page 6-37

See also “Editing Font Size as a Derived Value in XML” on page 6-23 for
another short example.

Making Changes in Font Size, Page Orientation, and
Paper Type
This example shows how to

• Generate an XML source file without converting it to a report

• Make the section headers larger in a report

• Change the page orientation to landscape

• Change the paper type to A4 (a popular paper size in Europe)

For this example you create a new stylesheet by editing an existing stylesheet.
The purpose of creating the new stylesheet is to change the appearance of
wsvar-report, a demo that is provided with the Report Generator.

1 Generate a source file for the report.

For this example, you convert the same report several times. If you start
by generating the report to XML without any formatting, you can use the
source file more than once without regenerating the report.

a. From the command line, issue the following command:

setedit wsvar-report

b. In the Report Format and Stylesheet panel, change the format to
DocBook (no transform).

c. Select File > Report to generate the report.
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Report Generator creates an XML source file without converting it to
a standard documentation format. The XML source file appears in the
MATLAB editor when the report is created.

2 Convert the report to see how it looks.

a. Select Tools > Convert Source File to open the File Converter.

b. From the Source file drop-down menu, select wsvar-report.xml.

c. From the Format drop-down menu select PDF.

d. From the Stylesheet drop-down menu, select Unnumbered
Chapters and Sections.

e. Click Convert File.

Report Generator converts the XML source file for wsvar-report to a
PDF and opens the PDF in your viewer for PDF files.

3 Change the specification for the section headers to make the headers more
prominent.

a. In the File Converter, click Edit.

Report Generator opens the Stylesheet Editor displaying the
settings associated with the Unnumbered Chapters and Sections
stylesheet.

b. In the Properties panel, change the name of the stylesheet to Custom
Large Section Headers.

c. Type in the description as No chapter and section numbering,
larger section titles.

d. In the Outline panel, select the Custom Large Section Headers
stylesheet (or any of its children), if not already selected.

e. In the Options panel, select Section Title Level 1 Properties.

f. In the Properties panel, click Add to current stylesheet.

The Section Title Level 1 Properties data item appears in the
Outline panel as a child of the custom stylesheet. Because this data
item is an attribute set, it has child members (that is, attributes)
displayed as well.
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g. In the Outline panel, select Font Size, a data item that is one of the
attributes in the set.

The Properties panel displays an XML expression specifying a font
size as a multiple of the Body Font Size attribute.

h. Click Edit as string.

The Stylesheet Editor converts the XML expression to a simple string,
which is displayed in a pane labeled Value.

i. Type in the value as 18pt.

This change in the stylesheet causes the size of the font to be
absolutely 18 points, rather than a multiple of the body font size
attribute.

j. Select File > Save to save the stylesheet.

Report Generator prompts you for a filename because it does not allow
you to overwrite built-in stylesheets.

k. Save the stylesheet to a directory on your MATLAB path with the
name customheader.rgs.

The customheader.rgs stylesheet appears as an available stylesheet in
the Options panel of the Stylesheet Editor. It also appears as an option
in the File Converter.

4 Use the new stylesheet to convert the current XML source file.

a. In the Stylesheet Editor: Main Properties panel, click Send to
File Converter

The File Converter appears with customheader.rgs stylesheet
selected.

b. Click Convert file.

5 Change additional specifications (page orientation and paper type).

a. On the File Converter Properties panel, click Edit.

b. In the Options panel, double-click the Page Orientation data item.
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c. In the Properties panel, use the drop-down menu to change the value
of the data item to landscape.

d. In the Options panel, double-click Paper Type, which is also in the
Pagination and General Styles folder.

e. In the Properties panel, use the drop-down menu to select A4.

f. Save the stylesheet.

6 Convert wsvar-report.xml using the Custom Large Section Headers
stylesheet.

The PDF shows a horizontally oriented page with slightly different
dimensions.

Adding a Company Logo to Headers in a PDF Report
This example shows how to edit the default header content for a PDF
stylesheet so that body pages will have an image in the center. The report that
is used in the example is mfile-report.rpt, a sample report that documents
the peaks.m file.

The image to be used for the content can be any bitmap image you choose. You
must know the size of the image so that you can allow enough room for it in the
header. The image used here is named sample_logo.bmp. It is 50x44 pixels,
which is about an inch on each side when printed on paper. It looks like this:

Note Keep in mind that only bitmap images (.bmp files) are supported by the
Stylesheet Editor as image content in headers and footers.

Here are the steps to include sample_logo.bmp in the center of the header for
each body page in a PDF version of mfile-report.rpt; that is, exclude the
image only from the titlepage and from the first page in each chapter.
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1 Open mfile-report.rpt by typing the following at the MATLAB command
prompt:

setedit mfile-report

2 Create a new stylesheet:

a. Open the Stylesheet Editor and double-click it in the Outline panel.

b. Click New FO (PDF) in the Properties panel.

c. Type Logo stylesheet for PDF as the Display name and Company
logo in center of header as Description.

d. Click File > Save and save the file as logo_stylesheet.rgs in your
MATLAB path.

3 Open the cell group for editing:

a. Scroll through the Options panel to the Pagination and General
folder.

b. Double-click Header Content in the Options panel.

c. Click Body – page Center from the list of cells in the Properties
panel.

The Properties panel appears as shown:
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d. Select and delete all of the text currently in the Value (XML) area.

e. Select Graphic from the Append template drop-down menu, and
click Append:

The Properties panel shows the XML code that tells the File Converter
to include the graphic. You must edit this code to specify the name
of the file and the space needed for it in the header. By default, the
name of the graphic is logo.bmp, as shown:

4 Add the name of your bitmap file to replace logo.bmp where it appears in
the Value(XML) code.

5 Click File > Save.
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6 Make sure that the amount of room available in the header is at least
as large as the icon image file. You can set this with the parameter
region.before.extent as follows:

a. In the Options panel, double-click Region Before Extent, which is
in the Pagination and General Styles folder.

By default the value for the height of the header is 0.4 inches, as
shown:

b. Type the value as 1.0in to replace 0.4in.

c. Click File > Save.

7 Generate the report with the new styles:

a. Select mfile-report.rpt in the Outline panel.

b. Set the drop-down menus in the Report Format and Stylesheet
text box of the Properties panel to specify Logo stylesheet for PDF
and Acrobat (PDF)

c. Click Report on the toolbar, which appears as .
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Stylesheet Reference Information
See the following table for a list of the properties for a Report Generator
stylesheet.

Stylesheet Properties

Name Description

Description An explanation of the features that distinguish the
stylesheet. This is an editable field.

Display name The name that you want to display in the Options
panel. This is not the same as the name of the .rgs
file that you specify to store the stylesheet. This is an
editable field.

Transform type The process that Report Generator uses to generate
reports that use this particular stylesheet. The types
are
• FO (Formatting Object) for PDF reports

• HTML

• DSSSL (Document Style Semantics and Specification
Language) for RTF reports

This is not an editable field.
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Categories of Stylesheets Within Each Type
The categories for the styles that you can edit for each kind of stylesheet are
listed in the following tables:

• Categories of Editable Styles in PDF (FO) Stylesheets on page 6-43

• Categories of Editable Styles in HTML Stylesheets on page 6-44

• Categories of Editable Styles in RTF (DSSSL) Stylesheets on page 6-45
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Categories of Editable Styles in PDF (FO) Stylesheets

Category Description of Data Items in the Category

Automatic labelling Options for enumeration of parts of the report,
such as chapters and sections.

Callouts Options and specifications related to callouts,
such as defaults, use of graphics, size, path,
fonts, characters, and extensions.

Font Families Specification of defaults for body text, copyright,
quotes, symbols, dingbats, monospace, sans
serif, and titles.

Graphics Specification of default width and options
related to scaling attributes.

Lists Specification of spacing related to lists and list
items.

Meta/*Info Options related to year ranges.

Miscellaneous Options and specifications for placement
of titles, comments, variable lists, block
quotations, ulinks, hyphenations of URLs,
verbatim environment display, use of SVG, table
footnote numbers, superscript, and subscript.

Pagination and General
Styles

Specifications of page orientation, margins,
double-sided, paper type, alignment,
hyphenation, line height, columns, master font,
draft mode, watermark, blank pages, rules for
headers and footers, and content of headers and
footers.

Properties Specification and options related to figure titles,
monospace properties, verbatim text, section
titles, and levels of sections.

Stylesheet Extensions Line numbering and table columns extensions.
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Categories of Editable Styles in PDF (FO) Stylesheets (Continued)

Category Description of Data Items in the Category

Table of Contents
(TOC)/List of Tables
(LOT)/Index Generation

Specifications for layout of TOC, depth of
sections, indentation, and margins.

Tables Specifications for size of tables and their
borders.

Categories of Editable Styles in HTML Stylesheets

Category of Style Description of Data Items in the Category

Automatic labeling Options for enumeration of parts of the report,
such as chapters and sections.

Callouts Options and specifications related to callouts,
such as defaults, use of graphics, size, path,
fonts, characters, and extensions.

Chunking Options related to using an explicit TOC for
chunking, depth of section chunks, navigational
graphics, and display of titles in headers and
footers.

Extensions Line numbering, graphic size, and table columns
extensions.

Graphics Specification of default width and depth, use of
HTML embed for SVG, viewports, and options
related to scaling attributes.

HTML Specifications related to dynamically served
HTML, base and head elements, type of
stylesheet, css, propagation of styles, longdesc,
validation, cleanup, draft mode, watermark,
and generation of abstract.

Linking Specification of Mailto URL and target for
ulinks

Meta/*Info Options related to year ranges.
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Categories of Editable Styles in HTML Stylesheets (Continued)

Category of Style Description of Data Items in the Category

Miscellaneous Options and specifications for comments,
verbatim environment pixels, em space, use of
SVG, and table footnote numbers.

Table of Contents
(TOC)/List of Tables
(LOT)/Index Generation

Specifications for layout of TOC, depth of
sections, indentation, and margins.

Tables Specifications for size of tables, table cell
spacing and padding, and borders.

XSLT Processing Options related to header and footer navigation
and rules.

Categories of Editable Styles in RTF (DSSSL) Stylesheets

Category of Style Description of Data Items in the Category

Admonitions Options and path for admonition graphics.

Backends Options for Tex, MIF, and RTF back end usage.

Bibliographies Options related to checking citations;
suppressing, enumerating, and using titles of
entries.

Fonts Specifications for font family and size to use for
some elements.

Footnotes Options for ulinks as footnotes and page
location.

Graphics Specifications for file extensions, filenames, and
loading library database.

Indents Specifications for hanging indents, first
paragraphs, and start of blocks.

Labelling Enumeration of sections and other elements.
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Categories of Editable Styles in RTF (DSSSL) Stylesheets (Continued)

Category of Style Description of Data Items in the Category

Miscellaneous Options for floating formal objects, punctuation
for run-in heads and honorifics, bold for first use
of term, minimum leading between lines, and
automatic hyphenation.

OLinks Using an extension for finding outline
information.

Object Rules Specifications for placement and width of rules.

Paper/Page
Characteristics

Specifications for paper type; page numbers;
width of pages, margins, and columns;
heading-levels; sides; and writing mode (such as
left-to-right).

Quadding Specifications for justifying paragraphs.

RefEntries and Functions Options related to generation and display of
reference entries and synopses for functions.

Running heads Options for generating and displaying running
heads of chapters.

Table of Contents
(TOC)/List of Tables
(LOT)

Options to produce or display TOC for sets,
books, parts, references, articles. Options to
display TOC on title page.

Tables Specification of width in simple list.

Titlepages Options to produce and display title pages for
sets, books, parts, references, articles. Options
for author’s name and ordering elements.

VariableLists Options and specifications for term length and
formatting.

Verbatim Environment Specifications for width, enumeration, size,
indentation, line frequency, and callouts.

Vertical Spacing Specifications for space between lines and
paragraphs.
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Components — By Category

Formatting Components (p. 7-2) Insert documentation elements

Report Generator Components
(p. 7-5)

General-purpose components

Logic and Flow Control Components
(p. 7-7)

Specify when and how often child
components execute

Handle Graphics Components
(p. 7-10)

Report on Handle Graphics figures

MATLAB Components (p. 7-13) Interact with MATLAB workspace

Requirements Management
Interface Component (p. 7-14)

Report requirements information

Simulink Components (p. 7-15) Report on Simulink models

Simulink Blocks Components
(p. 7-19)

Report on specified Simulink block
types

Stateflow Components (p. 7-20) Report on Stateflow models

Simulink Fixed Point Components
(p. 7-23)

Report on Simulink Fixed Point
blocks

Real-Time Workshop Components
(p. 7-25)

Report on code generated by
Real-Time Workshop
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Formatting Components
You can use Formatting components to insert documentation elements in
your report. Formatting components must have the following parent/child
relationships.
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Formatting Components

The following table describes the Formatting components.

Component Description

Chapter/Subsection Groups portions of the report into sections. The
following rules apply to the Chapter/Subsection
component:

• Children of the Chapter/Subsection
component are placed inside the section
created by this component.

• The Chapter/Subsection component can
nest inside another Chapter/Subsection
component.

Image Inserts an image into the report. The Image
component can have the Chapter/Subsection or
Paragraph component as its parent.

Link Inserts a link or anchor into the report. The
Link component should have the Paragraph
component as its parent. If you select Anchor
in the Link Type list, the Link component can
also have the Chapter/Subsection component
as its parent.

List Inserts a bulleted or numbered list into the
report. The List component must have the
Chapter/Subsection or Paragraph component
as its parent.

Paragraph Inserts a paragraph into the report. The
Paragraph component must have the
Chapter/Subsection component as its parent.
The Paragraph component can have child
components, or it can have text. Text must be
entered in the Paragraph Text parameter
field.
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Component Description

Table Converts an array into a table in the report.
The Table component can have either the
Chapter/Subsection or Paragraph component as
its parent and cannot have children.

Text Inserts text into the report. In general, the
Text component should have the Paragraph
component as its parent.

Title Page Inserts a title page at the beginning of the
report. The Title Page component should have
the Report component as its parent and should
be the first component that inserts information
into the report. This component cannot have
any children. If your report contains a title
page, it should also contain Chapter/Subsection
components.
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Report Generator Components
Report Generator components are general "utility" components. The following
table describes the Report Generator components.

Component Description

Comment Inserts a comment into the DocBook source file
created by the report generation process. The
comment is not visible in the generated report,
but you can edit the DocBook source file to make
the component appear in the report.

Empty Component Does not insert anything into the report and can
have any component as a child. It can be used to
group components so that the components can
be moved or activated/deactivated together, or it
can create a blank space in a list.

Import File Imports plain text, DocBook XML, HTML, or
RTF documents into the report.

Nest Setup File Inserts a setup file at the point where the Nest
Setup File component is listed in the current
setup file. The Nest Setup File component allows
one setup file (.rpt) to run inside another.

The components of the inserted setup file enter
the current setup file at the level of the Nest
Setup File component. Thus, the inserted
components have the same parent component as
the Nest Setup File component. You must make
sure that the inserted components can have this
parent component.
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Component Description

Stop Report
Generation

Halts report generation. The Stop Report
Generation component acts like the Stop button
during report generation, and can be used to halt
report generation under specified conditions.

Time/Date Stamp Inserts the time and date of report generation.
The Time/Date Stamp component behaves like a
Text component; it must be inside a paragraph
or title.
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Logic and Flow Control Components
Logical and Flow Control components execute conditionally, enabling you
to decide when a child component executes or how many times a child
component executes.

Logical and Flow Control components have the following parent/child
relationships.
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The following table describes the Logical and Flow Control components.

Component Description

For Loop This component runs its child components
iteratively. The For Loop component must
have at least one child. The purpose of this
component is to run its children several times.
If it does not have any children, this component
does not add anything to the report.

Logical Else When the parent if condition is false, only the
children of the else component run.

Logical Elseif When the parent if condition is false, the
process checks all the elseif statements in
order, and the children of the first true elseif
statement run.

Logical If if statement for report generation. When the
if statement results in true, the component
runs its child components.

Logical Then When the parent if condition is true, only the
children of the then component run.

While Loop This component loops while a workspace
expression is true. This component runs its
child components until its conditional string is
true. The number of repetitions can be limited
to prevent infinite loops. Like the For Loop
component, the While Loop component must
have at least one child. If it does not have any
children, this component does not add anything
to the report.
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Logic and Flow Control Components

You can use the Logical components, including Logical If, Logical Then,
Logical Else, and Logical Elseif, in the following ways.

Component
Used

Appearance in the
Outline

How the Components
Execute

Logical If if When the if condition is
true, this component runs its
children.

Logical If Logical
Then Logical Else

if

then
else

• When the if condition is
true, only the children of
the then component run,
and the process exits the if
family.

• When the if condition is
false, only the children of
the else component run.

Logical If Logical
Then Logical
Elseif Logical Else

if

then
elseif
elseif

.

.

.

else

• When the if condition is
true, only the children of
the then component run,
and the process exits the if
family.

• When the if condition is
false, the process checks all
the elseif statements in
order, and the children of the
first true elseif statement
run. The process then exits
the if family.

• If none of the elseif
statements is true, the
process runs the children of
the else statement.

Note that only one of the
conditional statements
(then, else, elseif)
actually executes.
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Handle Graphics Components
Handle Graphics components report on Handle Graphics figures. The
following figure shows the Handle Graphics component hierarchy.
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Handle Graphics Components

The following table describes the Handle Graphics components.

Component Description

Axes Loop Runs its child components for all axes objects
for the current figure.

Axes Snapshot Inserts an image of the current axes into the
generated report.

Figure Loop Runs its children for each Handle Graphics
figure that you select. If a Handle Graphics
component does not have the Figure Loop
component as its parent, it operates on the
current figure.

Figure Snapshot Inserts an image of a figure window into your
report. The Handle Graphics Figure Snapshot
component behaves like the Image component
and expects the Figure Loop component as its
parent.

Handle Graphics
Linking Anchor

Designates a location to which other links
point. This component should have a looping
component as its parent.

Handle Graphics
Object Loop

Runs its child components for each Handle
Graphics object in the current figure or axes.

Handle Graphics Name Inserts the name of a Handle Graphics object
into your report. The Handle Graphics Name
component behaves like the Text component
and expects the Figure Loop component as its
parent.

Handle Graphics
Property Table

Creates and inserts a property name/property
value table for Handle Graphics figures,
axes, or other objects. The Handle Graphics
Property Table component behaves like the
Table component and expects the Figure Loop
component, Axes Loop component, or Object
Loop component as its parent.
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Component Description

Handle Graphics
Parameter

Inserts a single property name/property value
pair from a Handle Graphics figure, axes, or any
other Handle Graphics object into your report.

Handle Graphics
Summary Table

Inserts a table that summarizes many Handle
Graphics objects’ properties. You can specify the
object properties to be included in the report.

This is an example of how Handle Graphics components can be used in a
setup file.

Report
Figure Loop
Chapter/Subsection
Name
Anchor
Property Table
Summary Table
Axes Loop
Chapter/Subsection
Name
Anchor
Axes Snapshot
Property Table
Summary Table
Object Loop
Chapter/Subsection
Name
Anchor
Property Table
Summary Table
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MATLAB Components
You can use MATLAB components to interact with the workspace. The
following table describes the MATLAB components.

Component Description

Evaluate MATLAB
Expression

Evaluates a specified MATLAB expression.
The result of the evaluation and/or MATLAB
expression (M-code) can appear in the report.

Insert Variable Inserts a specified variable into the report.

MATLAB/Toolbox
Version Number

Creates a table that shows the version number,
release number, and/or release date of any
MathWorks software you are currently using.

MATLAB Property Table Creates a table that includes variables from the
MATLAB workspace. The MATLAB Property
Table component behaves like the Table
component.

Variable Table Creates a table that includes all variables in
the MATLAB workspace. The Variable Table
component behaves like the Table component.
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Requirements Management Interface Component
You can use the Requirements Management Interface component to include
information about requirements in your report.

Component Description

Requirements Table Creates a table that contains information from
Simulink Verification and Validation.
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Simulink Components

Simulink Components
You can use Simulink components to include information on Simulink models
in your report. Simulink components can report on four levels of a Simulink
model: model, system, block, and signal.

Simulink components have the following parent/child relationships.
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The following table describes the Simulink components.

Component Description

Block Execution Order
List

Creates and inserts a list or table of all blocks in
the model (displayed in order of their execution
sequence) into the report. The Block Execution
Order List component should have the Model
Loop component as its parent. If you place this
component inside the System Loop component,
you will get the same list over and over again.

Block Loop Specifies the blocks to be included in the report.
The Block Loop component can have the Model
Loop, System Loop, or Signal Loop component
as its parent.

Block Type Count Counts the number of each block type in a model
or system. The Simulink Block Type Count
component can have either the Model Loop or
the System Loop as its parent.

Model Advisor Report Inserts a Model Advisor report.

Model Change Log Constructs a model history table that displays
information about each logged revision to a
model. This component must be executed before
the Model Simulation component.

Model Loop Runs its child components for all selected
Simulink models and systems. The Model Loop
component can run its child components for a
specific model, all models, or the current model.

Model Simulation Simulates the current Simulink model. The
Model Simulation component expects the
Model Loop component as its parent.

Signal Loop Runs its child components for each signal in its
parent loop. The Signal Loop component can
have the Model Loop, System Loop, or Block
Loop component as its parent.
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Component Description

Simulink Automatic
Table

Creates a two-column property name/property
value table.

Simulink Dialog
Snapshot

Takes snapshots of Simulink editor dialogs

Simulink Functions
and Variables

Inserts a table listing all workspace variables
and functions used by the blocks that are
reported on in the current model. The Simulink
Functions and Variables component expects
the Model Loop component, System Loop
component, or Block Loop component as its
parent.

Simulink Library
Information

Inserts a table listing all blocks, libraries,
reference blocks, and link status for the current
model.

Simulink Linking
Anchor

Acts like a link in a paragraph or title. This
component can have any Simulink looping
component as its parent.

Simulink Name Inserts the name of the current system, model,
block, or signal, according to the option you
specify. The Simulink Name component can
have any Simulink looping component as its
parent. This component behaves like the Text
component.

Simulink Property Inserts a single property name/property value
pair for a Simulink object as text. The Simulink
Property component can have any Simulink
looping component as its parent.

Simulink Property
Table

Inserts a property name/property value table
for the model, system, block, or signal specified
by the Model Loop component. The Simulink
Property Table component has the Model Loop
component as its parent.
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Component Description

Simulink Summary
Table

Inserts a table that lists several Simulink
objects and their properties. The Simulink
Summary Table component can have the Model
Loop as its parent if you are creating the
table for systems, blocks, or signals. If you are
creating the table for blocks and signals, the
System Loop component can be its parent.

System Filter Runs its children only if certain conditions are
met by the current system. The System Filter
component expects the System Loop component
as its parent.

System Hierarchy Inserts a list of the names of parent and child
systems in the current system; child systems are
shown indented under the parent systems. The
System Hierarchy component can have either
the Model Loop or System Loop component as
its parent.

System Loop Runs its child components for each system
defined in the Model Loop component. The
System Loop component must have the Model
Loop component as its parent.

System Snapshot Inserts a picture of the current system into
the report. The current system is defined by
the System Loop component. The System
Snapshot component should have the System
Loop component as its parent.
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Simulink Blocks Components
You can use the Simulink Blocks components to include information in
the generated report about specific Simulink block types. Simulink Blocks
components can be used in model, system, or block loops to report on block
types in context.

The following table describes the Simulink Blocks components.

Component Description

Bus Creates a list of all signals exiting from a Bus
Selector block. The list can contain only those
signals leaving from the reported block or it can
be hierarchical and display downstream buses
and signals.

Documentation Inserts text extracted from doc blocks in
Simulink models. The Documentation
component can have the Model Loop, the
System Loop, or the Block Loop as its parent.

Look-Up Table Reports on lookup table blocks; it inserts a
figure and/or table into the report. The table
contains input and output numeric values, and
the figure is a plot of the values.

Scope Snapshot Inserts a snapshot of all scope blocks and
XY plots in your report. The Scope Snapshot
component can have any Simulink looping
component as its parent.

To Workspace Plot Captures a plot created in the MATLAB
workspace. This component inserts a figure
and/or table into the report. The table contains
input and output numeric values and the figure
is a plot of the values.
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Stateflow Components
You can use Stateflow components to include information on Stateflow models
in your report. The following figure shows the parent/child relationships of
Stateflow components.
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The following table describes the Stateflow components.

Component Description

Chart Loop Runs its children for each Stateflow chart that
you choose. The Chart Loop component can
have the Simulink Model Loop, System Loop,
Signal Loop, or Block Loop component as its
parent.

Machine Loop Runs its child components for all selected
Stateflow machines. The Machine Loop
component can run its child components for a
specific machine, all machines, or the current
machine.

Stateflow Count Counts the number of Stateflow objects
in the current system. See the Stateflow
documentation for a description of Stateflow
objects.

Stateflow Dialog
Snapshot

Takes snapshots of Stateflow editor dialogs.

Stateflow Filter Runs its children only if the current object
type (set by the parent State Loop) matches
the component’s object type. The Stateflow
Filter component must have the Stateflow Loop
component as its parent.

State Loop Runs its children for each Stateflow object
defined by its parent component. The State
Loop component must have the Model Loop,
System Loop, Signal Loop, Block Loop, Chart
Loop. or Machine Loop component as its parent.

Stateflow Automatic
Table

Inserts a table that contains the properties of a
Stateflow object.

Stateflow Hierarchy
Loop

Runs its child components on the entire
Stateflow object hierarchy from the current
point down.
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Component Description

Stateflow Linking
Anchor

Acts like a link. This component must have
the State Loop, Chart Loop, or Stateflow Filter
component as its parent.

Stateflow Name Inserts the name of the Stateflow object
specified by its parent component into the
report. This component must have the State
Loop, Chart Loop, or Stateflow Filter component
as its parent.

Stateflow Hierarchy Inserts a tree representation into a generated
report that describes the Stateflow object
hierarchy.

Stateflow Object Loop Runs its child components for each terminal
Stateflow object. The component inserts a list of
object types.

Stateflow Property Inserts a table, text, or paragraph that contains
details of the selected Stateflow object property.

Stateflow Property
Table

Inserts a property name/property value table
for a Stateflow object into the report. The
Stateflow Property Table component must have
the Stateflow Filter component as its parent.

Stateflow Snapshot Inserts an image of a Stateflow object into the
report. The Stateflow Snapshot component is
only valid for certain object types.

Stateflow Summary
Table

Shows properties or parameters of the selected
Stateflow objects in a table. The Stateflow
Summary Table component can have the Chart
Loop or any Simulink looping component (Model
Loop, System Loop, Block Loop, State Loop, or
Signal Loop) as its parent.

Truth Table Inserts a table. The component must have the
State Loop component as its parent.
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Simulink Fixed Point Components
You can use Simulink Fixed Point components to include information on
Simulink Fixed Point blocks in your report. The following figure shows the
parent/child relationships of the Simulink Fixed Point components.
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The following table describes the Simulink Fixed Point components.

Component Description

Fixed Point Block
Loop

Runs its children for the Simulink model,
system, or signal defined by its parent
component. For example, if the Fixed Point
Block Loop is parented by the Simulink Model
Loop, it runs its children for all fixed-point
blocks in the Simulink model. The Fixed Point
Block Loop component can have either the
Simulink Model Loop, System Loop, or Signal
Loop component as its parent.

Fixed Point Logging
Options

Sets fixed-point options similar to those set
in the Fixed Point Settings interface. You can
use this component before a Model Simulation
component in order to control how the model
behaves during simulation.

Fixed Point Property
Table

Inserts a property name/property value table for
a fixed-point block. The Fixed Point Property
Table component must have the Fixed Point
Block Loop component as its parent.

Fixed Point Summary
Table

Shows properties or parameters of the selected
fixed-point blocks in a table. The Fixed Point
Summary Table component must have the Fixed
Point Block Loop as its parent.

7-24



Real-Time Workshop Components

Real-Time Workshop Components
You can use Real-Time Workshop components to include information on code
generated by Real-Time Workshop in your report.

The following table describes the Real-Time Workshop components.

Component Description

Code Generation
Summary

Reports version information, a list of the
generated files, code generation configuration
information, and, if the model includes
subsystems, a subsystem map.

Import Generated Code Imports source and header (include) files
generated by Real-Time Workshop and any
custom files you specify as part of your model.
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Annotation Loop

Category Simulink

Description A Simulink annotation is a text area that you can edit directly in
the block diagram. You typically use an annotation to display quick
information about a subsystem.

The Annotation Loop component runs its child components multiple
times for each Simulink annotation in the current context.

If the Annotation Loop is nested inside a Model Loop, it reports on all
annotations inside the reported portion of the reported model.

If the Annotation Loop is nested inside a System Loop, it reports on all
annotations inside the current system.

Annotation Loop components nested inside a Block or Signal Loop
component do nothing.

Attributes The following figure shows the Annotations Loop Properties panel:
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Annotation Loop

Loop
Options

The Loop Options pane displays information about the current context.

All child components of the Annotation Loop consider their context to be
annotations when the report is running.

For example, the following components report on the looped annotation

• Simulink Automatic Table

• Simulink Linking Anchor

• Simulink Name

• Simulink Property

• Simulink Property Table

You can also show annotation objects in reports by using a summary
table component. The summary table components create a single table
with each reported annotation on a single row of the table.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.
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Axes Loop

Category Handle Graphics

Description The Axes Loop component runs its child components for all axes objects
in the MATLAB workspace. For more information about working with
looping components, see “Working with Looping Components” on page
4-2.

Attributes The following figure shows the Axes Loop Properties panel:

Object
Selection

Loop type
To loop on all axes objects, select All axes. To loop on the selected
axes object, select Current axes.
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Axes Loop

Exclude objects which subclass axes
Select this option to exclude objects such as legends and color bars.

Loop Menu
To loop only on visible axes objects, select Loop on axes with
handle visibility "on". To loop on all axes objects, select Loop
on all axes.

Search terms
Enter search terms for the loop. For example, to search for Tag
and My Data, enter "Tag", "My Data".

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, inserts a section if the Create section for each object in loop
option is selected.

Filename rptgen_hg.chg_ax_loop
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Axes Snapshot

Category Handle Graphics

Description The Axes Snapshot component inserts an image of the selected axes
objects in MATLAB into the generated report.

Attributes The following figure shows the Axes Snapshot Properties panel:

Format Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic HG Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
viewer can read. Automatic HG Format is the default option.
The options include
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Axes Snapshot

• Automatic HG Format (uses the Handle Graphics file format
selected in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed

• Windows metafile
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Capture figure from screen
Select this option to capture the figure for the generated report
directly from the screen. This option executes faster, but is not
applicable for all formats. Also, the image to be captured might be
obscured by other windows on the screen.

Print
Options

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper
orientation, or you can choose the Use figure orientation
option. For information about paper orientation, see the reference
page for the orient command.

Image size
Select Use figure PaperPositionMode setting to use the
PaperPositionMode property of the Handle Graphics figure to
set the image size in the report. See the orient command for
information about paper position mode.

Select the Automatic (same size as onscreen) option if you
want the image in your report to be the same size as the image
on the screen.

Select the Custom option to choose a custom image size. If you
choose this option, specify the image size in the Size field and
Units list.

• Size: Enter the size of the Handle Graphics figure snapshot in
the form [w h] (width height). This field is active only if you
choose Custom in the Image size list box.

• Units: Enter the units for the size of the Handle Graphics
figure snapshot. This field is active only if you choose Set
image size in the Custom list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This
parameter inverts colors for printing; i.e., it changes dark colors
to light colors and vice versa.
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Select one of the following options:

• Automatic — Select this option to automatically change dark
axes colors to a light axes color. If the axes color is a light color,
it is not inverted.

• Invert — Select this option to change dark axes colors to light
axes colors and vice versa.

• Don't invert — Select this option if you do not want to change
the colors in the image displayed on the screen for printing.

• Use figure's InvertHardcopy setting — Select this option
to use the InvertHardcopy property set in the Handle Graphics
image.

• Make figure background transparent — Select this option
to make the image background transparent.

Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.

Insert
Anything
into
Report?

Yes. Image.

Filename rptgen_hg.chg_ax_snap
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Block Execution Order List

Category Simulink

Description The Block Execution Order List component creates a list or table of all
nonvirtual blocks in the model, showing the order in which they are
executed. See the Simulink documentation for a definition and a list
of virtual and nonvirtual blocks.

Attributes The following figure shows the Block Execution Order List
Properties panel:

List Title
To generate a title automatically, select Automatic. To enter a
custom title, select Custom. Enter a title in this field if you want
to have a title for the table or list. If you have a title for a table, it
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is included in the List of Tables if the stylesheet you chose in the
Report Options attribute page supports it.

Include block type information
Select this option if you want to include each block’s BlockType
property in the list or table.

Look under nonvirtual subsystems

• On

• Off

• Automatic (On for models, Off for systems)

For example, the Simulink model Demo_System appears similar to the
following figure:

Insert
Anything
into
Report?

Yes. List.

Filename rptgen_sl.csl_blk_sort_list
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Block Loop

Category Simulink

Description The Block Loop component runs its child components for each block
contained in the current system, model, or signal. For more information
about working with looping components, see “Working with Looping
Components” on page 4-2.

Attributes The following figure shows the Block Loop Properties panel:

Report On This pane describes what the Block Loop component is operating on.

Automatic list from context
Select this option to report on all blocks in the current context. The
context is set by the Block Loop component’s parent component:
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• If the parent component is the Model Loop, selecting this
option causes the Block Loop component to report on all blocks
in the current model.

• If the parent component is a System Loop, selecting this option
causes the Block Loop component to report on all blocks in the
current system.

• If the parent component is the Signal Loop, selecting this
option causes the Block Loop component to report on all blocks
connected to the current signal.

• If the Block Loop does not have the Model Loop, System Loop,
Signal Loop, or Block Loop component as its parent, selecting
this option causes the Block Loop component to report on all
blocks in all models.

Custom - use block list
Select this option to report on a list of blocks that you specify and
enter the block names in the corresponding field. You must use
the full pathname when specifying blocks. If you want to sort
the blocks in this list, select the Sort blocks in list option
and then select a sorting option from the Sort blocks option (in
the Loop Options section). Blocks are reported on in the order
that they are sorted. If you do not select this option, blocks are
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can
be a string or cell array. See “%<VariableName> Notation” on
page 8-253 in the Text component reference page for more details.

For example, if you want to report on the theta dot integrator
block and the theta integrator block in the demo model simppend,
you could enter the following in the block list.

simppend/theta dot

%<Z>
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If you define Z in the workspace as the following,

Z={'simppend/theta'}

then the Report Generator reports on the following blocks.

simppend/theta dot

simppend/theta

Loop
Options

You can choose block sorting options and reporting options in this pane.

Sort blocks
Use this option to select how the blocks are sorted:

• Select Alphabetically by block name to sort blocks
alphabetically by their names.

• Select Alphabetically by system name to sort systems
alphabetically.

In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.

• Select Alphabetically by full Simulink path to sort blocks
alphabetically by Simulink path.

• Select By block type to sort blocks alphabetically by block
type.

• Select By block depth to sort blocks by their depth in the
model.

• Select By traversal order to sort blocks by traversal order.

• Select By simulation order to sort blocks by execution order.

Search for property name/property value pairs
Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.
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Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each block found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the block in the
generated report.

Insert
Anything
into
Report?

Yes, inserts section if the Create section for each object in loop
option is selected.

Filename rptgen_sl.csl_blk_loop
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Block Type Count

Category Simulink

Description The Block Type Count component counts the number of each block type
in the current model or system. See the Simulink documentation for a
description of block type.

Attributes The following figure shows the Block Type Count Properties panel:

Count
Types

This pane describes where block types are being counted.

• If the Block Type Count component has the Model Loop as its parent,
it reports all block types in the current model.

- Use the All blocks in model option to count block types in the
entire model.

- Use the All blocks in reported systems option to count block
types only in systems that are included in the report.
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• If the Block Type Count component has the System Loop as its
parent, it reports all block types in the current system.

• The Block Loop and the Signal Loop components are not valid
parents for the Block Type Count component.

Table
Content

Table title
Enter the title of the table in this field.

Show block names in table
Select this option to include a column that displays all block
names in the table.

Sort table
To sort blocks alphabetically by block type, select Alphabetically
by block type.

To sort by decreasing number of occurrences, select By number
of blocks.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_blk_count
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Category Simulink Blocks

Description The Bus component creates a list of all signals exiting from a Bus
Selector block. The list can contain only those signals leaving from the
reported block or it can be hierarchical and display downstream buses
and signals.

When working with the Bus component, keep the following points in
mind:

• If the Bus component has the Model Loop as its parent, it includes
all buses in the current model.

• If the Bus component has the System Loop as its parent, it includes
all buses in the current system.

• If the Bus component has the Block Loop as its parent, it includes
the current block if it is a bus.

• If the Bus component has the Signal Loop as its parent, it includes
all buses connected to the current signal.

• If the Bus component does not have any of the Simulink looping
components as its parent, it includes all buses in all open models.

Attributes The following figure shows the Bus Properties panel:
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Show Bus Hierarchy
Use this option to specify whether or not the list should display
downstream buses in a hierarchical form.

Hierarchical list:

List Title
Bus Selector

signal3
signal2
signal4

Bus Selector1
signal3

Bus Selector2
signal2
signal1
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Bus Selector3
signal2
signal1

Nonhierarchical list:

List Title
Bus Selector
signal3
signal2
signal4

List Title
Bus Selector1

signal3
List Title

Bus Selector2
signal2
signal1

List Title
Bus Selector3

signal2
signal1

Insert linking anchor for bus blocks
When this option is selected, the Report Generator inserts a
linking anchor for each bus block. This designates the list item as
the location to which other links for that block will point. (See the
Simulink Linking Anchor or Link components for more help.)
You should not use this option if you have already specified an
anchor location for the bus block with an Object Linking Anchor
component.

Insert linking anchor for signals
When this option is selected, the Report Generator inserts a
linking anchor for each signal. This designates the list item as the
location to which other links for that signal will point. (See the
Simulink Linking Anchor or Link components for more help.)
You should not use this option if you have already specified an
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anchor location for the signal with an Object Linking Anchor
component.

Title
Use this option to insert a title before each list. Note that this
attribute supports the %<varname> notation.

Insert
Anything
into
Report?

Yes. List.

Filename rptgen_sl.csl_blk_bus
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Chapter/Subsection

Category Formatting

Description The Chapter/Subsection component groups portions of the report into
sections. Each section has a title and some content. The following rules
apply to the Chapter/Subsection component:

• Children of the Chapter/Subsection component are placed inside the
section created by this component.

• The Chapter/Subsection component takes paragraph-level children
unless you select the Get title from first child component check
box. In this case, a Chapter/Subsection component’s first child must
be a Text component.

• The Chapter/Subsection component can be the child of another
Chapter/Subsection component.

Sections can be nested, and titles automatically become smaller inside
subsections. There are seven levels of nesting possible.

Chapter
Section 1
Section 2
Section 3
Section 4
Section 5
Section 6

No Section

Any Chapter/Subsection components beyond the sixth section do not
create a titled section, although the child components of these sections
do insert information into the report.

Chapter Numbering

By default, chapters are numbered and sections are not numbered.
Chapter and section numbering are specified by the stylesheet you
choose in the Report Options attribute page. See “Setting the Report
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Format” on page 2-3 for chapter and section numbering options in Web
and print stylesheets.

Attributes The following figure shows the Chapter/Subsection Properties panel:

Section
Title

Title
Choose a title for the display in the generated report. To generate
a title automatically, select Automatic. To enter a title, select
Custom.

Numbering
Choose a numbering style for the report. To number by context,
select Automatic. To create your own numbering style, select
Custom.

Section Type
The item in the Section Type pane shows you what level the
selected section is residing in.
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Insert
Anything
into
Report?

Yes. Chapter or section.

Filename rptgen.cfr_section
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Chart Loop

Category Stateflow

Description The Chart Loop component runs its children for each Stateflow chart
that you choose. The Chart Loop component can have the Model Loop,
System Loop, Signal Loop, or Block Loop component as its parent.

Attributes The following figure shows the Chart Loop properties page.

Report On Automatic list from context
Select this option to report on all charts in the current context. The
context is set by the Chart Loop component’s parent component:

• If the parent component is the Model Loop, selecting this
option causes the Chart Loop component to report on all
reported Stateflow charts in the current model.
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• If the parent component is the System Loop, selecting this
option causes the Chart Loop component to report on all
Stateflow charts in the current system.

• If the parent component is the Signal Loop, selecting this
option causes the Chart Loop component to report on all
Stateflow charts connected to the current signal.

• If the parent component is the Machine Loop, selecting this
option causes the Chart Loop component to report on the
current Simulink block if it is a Stateflow chart.

• If the Chart Loop does not have the Model Loop, System Loop,
Signal Loop, or Block Loop component as its parent, selecting
this option causes the Chart Loop component to report on all
Stateflow charts.

Custom - use chart list
Select this option to report on a list of Stateflow charts that you
specify, and enter the chart names in the corresponding field. If
you want to sort the charts in this list, select the Sort charts in
list option and then select a sorting option from the Sort charts
option (in the Loop Options section). Charts are reported on in
the order that they are sorted. If you do not select this option,
charts are reported on in the order that they are listed in the
chart list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can
be a string or cell array. See “%<VariableName> Notation” on
page 8-253 in the Text component reference page for more details
and the Custom - use block list section in the Simulink Block
Loop reference page for an example.

Loop Options

You can choose chart sorting options and reporting options in this pane.
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Sort charts
Use this option to select how the blocks are sorted (this option is
available if you select the Automatic list from context option
in the Report On section or if you select Custom - use chart
list and the Sort charts option):

• Select Alphabetically by block name to sort blocks
alphabetically by name.

• Select Alphabetically by system name to sort systems
alphabetically by name.

• In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.

• Select Alphabetically by full Simulink path to sort
models alphabetically by their full path name.

• Select By block type to sort blocks alphabetically by block
type.

• Select By depth to sort blocks by their depth in the model.

• Select By simulation order to sort blocks by execution order.

Search Stateflow
Select this option to report only on Stateflow charts with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Section
Options

Create section for each object in loop
Select this option to insert a section for each object found in the
loop in the generated report.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.
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Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, inserts section if the Create section for each object in loop
option is selected.

Filename rptgen_sf.csf_chart_loop
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Code Generation Summary

Category Real-Time Workshop

Description The Code Generation Summary component reports

• Version information

• List of generated files

• Code generation configuration information

• Subsystem map

Attributes The following figure shows the Code Generation Summary
Properties panel.
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General information
Select this option to include the following information in the
report:

• Model name and version

• Real-Time Workshop version

• List of full paths for generated files
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Configuration settings
Select this option to include in the report tables that list
optimization and Real-Time Workshop target selection and build
process Configuration Parameter settings.

Subsystem map
If your model includes at least one subsystem, select this option
to include in the report a mapping between subsystem numbers,
uniquely assigned by Simulink, and subsystem labels in the
model.

Insert
Anything
into
Report?

Yes. Tables and list.

Filename RptgenRTW.CCodeGenSummary
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Comment

Category Report Generator

Description The Comment component inserts a comment into the XML source file
created by the report generation process. The comment is not visible in
the generated report.

This component can have children. Child components insert their
output into the XML source file, but this output appears inside comment
tags and does not appear in the final report.

If you want the comment text to appear in the report, follow these steps:

1 Edit the XML source file (the XML source file has the same name
as your report file, but has a .xml extension). Note that you must
generate a report to create the XML source file.

2 Find the comment area in the XML source file by locating the
comment tags <-- and -->. Remove both of these tags.

3 Convert the XML source file using the rptconvert command (For
more details on the rptconvert command, see “Converting XML
Documents” on page 2-8).

Attributes The following figure shows the Comment Properties panel:
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Comment text
Enter the comments that you want to include in the report.

Show comment in Generation Status window
Select this option if you want to display the comment in the
Generation Status tab when the report is generating.

Status message priority level
This option is only available if you select the Show comment in
Generation Status window option. Select the status message
priority level that is displayed during report generation.
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Insert
Anything
into
Report?

No, but this component inserts a comment into the XML source file,
which can appear in the report.

Filename rptgen.crg_comment
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Documentation

Category Simulink Blocks

Description The Documentation component inserts text extracted from doc blocks
in Simulink models. The Documentation component can have either
the Model Loop, the System Loop, or the Block Loop component as its
parent. If the report format is set to HTML, you can import HTML
documentation. If the report format is set to RTF, you can import RTF
documentation.

Attributes The following figure shows the Documentation Properties panel:
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Import file as
Indicate what kind of format to use for the imported file. There
are five formats to choose from. To illustrate how they each work,
the following text is used as the input text:

First row.
Second row.

Third row follows blank line.

• Plain text (ignore line breaks): Select this option to
import plain text without any line breaks (no paragraphs). The
following output is produced:

First row. Second row. Third row follows blank line.

• Paragraphs defined by line breaks: Select this option to
import the text contained in paragraphs defined by line breaks
(hard returns or carriage returns). The following output is
produced:

First row.

Second row.

Third row follows blank line.

• Paragraphs defined by empty rows: Select this option
to import text contained in paragraphs defined by empty
rows (rows that do not contain text). The following output is
produced:

First row. Second row.

Third row follows blank line.

• Text (retain line breaks): Select this option to import
plain text, including line breaks. The following output is
produced:

First row.
Second row.
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Third row follows blank line.

• Fixed-width text (retain line breaks): Select this option
to import fixed-width text (all letters have the same width
or size) including line breaks. This option is best suited for
importing M-files. The following output is produced:

First row.
Second row.

Third row follows blank line.

Insert linking anchor for blocks
Select this option to insert a linking anchor for each doc block.
This designates the location to which other links for that block will
point. (See the Simulink Linking Anchor or Link components
for more help.) You should not use this option if you have already
specified an anchor location for the doc block with an Object
Linking Anchor component.

Insert
Anything
into
Report?

Yes. Text, paragraph, or external RTF/HTML.

Filename rptgen_sl.csl_blk_doc
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Category Report Generator

Description The Empty Component does not insert anything into the report and can
have any component as a child. You can use it to group components
together so that the components can be moved or activated/deactivated
easily, or to create a blank space in a list.

If the Report Generator does not recognize a component when loading
a setup file, it replaces the unrecognized component with the Empty
Component.

Attributes The following figure shows the Empty Component Properties panel:

Insert
Anything
into
Report?

No.
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Filename rptgen.crg_empty
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Evaluate MATLAB Expression

Category MATLAB

Description The Evaluate MATLAB Expression component evaluates a specified
MATLAB expression in the workspace. The code and/or command line
output can be inserted into the report.

Attributes The following figure shows the Evaluate MATLAB Expression
Properties panel:

Insert MATLAB expression in report
Select this option if you want the MATLAB expression that is
evaluated by this component to appear in the report.

Display command window output in report
Select this option if you want to include the command window
output that results when the MATLAB expression is evaluated.
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Expression to evaluate in the base workspace
Enter the expression that you want to evaluate in the MATLAB
workspace.

Evaluate this expression if there is an error
Select this option if you want to evaluate another MATLAB
expression if the evaluated expression produces an error. Enter
the expression that should be evaluated in case of an error in
this field.

Insert
Anything
into
Report?

Inserts text if you select one of the following options:

• Insert MATLAB expression string in report

• Display command window output in report

Otherwise, this component does not insert anything into the report.

Filename rptgen.cml_eval
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Figure Loop

Category Handle Graphics

Description The Figure Loop component applies each child component to graphics
figures specified in the attribute page.

See “Working with Looping Components” on page 4-2 for a discussion
of this component.

Attributes The following figure shows the Figure Loop Properties panel:

Figure
Selection

You can choose to loop on

• The current figure

• All visible figures

• Figures with certain tags
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Include figures
To include only the current figure in the report, select the Current
figure only option.

To loop on all visible figures, select the Visible figures option.
This option executes child components for all figures that are
currently open and visible. The Data figures only option is
checked by default and excludes figures with HandleVisibility
= 'off' from the loop.

To loop on figures with certain tags, select the All figures with
tags option. When you are selecting a tag, all figures with that
tag are included, regardless of whether the figure is visible or
whether HandleVisibility is 'on' or 'off'. The tag list box
(located under the All figures with tags option) shows the
selected tags. To add a tag to the tag list box, select the tag from
the list on the right and click Add. The tag list shows a list of tags
for figures that are open. If you want to add a tag that does not
appear in the tag list, you can type in the tag.

Loop Figure List
The Loop Figure List shows you the figures that would be
looped on given the current set of figures.

Note If your setup file generates new figures or changes existing
figures, the figures in the Loop Figure List will not be the
figures that are actually reported on.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.
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Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_hg.chg_fig_loop

8-44



Figure Snapshot

Category Handle Graphics

Description The Figure Snapshot component inserts a snapshot of a Handle
Graphics figure.

Attributes The following figure shows the Figure Snapshot Properties panel:

Format Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.,) from this
list. Select Automatic HG Format to automatically choose the
format best suited for the output format that you chose in the
Report component. Otherwise, choose an image format that your
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output viewer can read. Automatic HG Format is the default
option. The options include

• Automatic HG Format (uses the Handle Graphics file format
selected in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed
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• Windows metafile

Capture picture from screen
Use the option to capture a figure from the screen.

Print
Options

Use the attributes in this section to set printing parameters.

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper
orientation, or you can choose the Use figure orientation
option. See the orient command for information about paper
orientation.

Image size
Select Use figure PaperPositionMode setting to use the
PaperPositionMode property of the Handle Graphics figure to
set the image size in the report. See the orient command for
information about paper position mode.

Select the Automatic (same size as on screen) option if you
want the image in your report to be the same size as the image
on the screen.

Select the Custom option to choose a custom image size. If you
choose this option, specify the image size in the Size field and
Units list.

• Size: Enter the size of the Handle Graphics figure snapshot in
the form wxh (width times height). This field is active only if
you choose Custom in the Image size list box.

• Units: Enter the units for the size of the Handle Graphics
figure snapshot. This field is active only if you choose Custom
in the Image size list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This
parameter inverts colors for printing; i.e., it changes dark colors
to light colors and vice versa.
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Select one of the following options:

• Automatic — Select this option to automatically change dark
axes colors to a light axes color. If the axes color is a light color,
it will not be inverted.

• Invert — Select this option to change dark axes colors to light
axes colors and vice versa.

• Don't invert — Select this option if you do not want to change
the colors in the image displayed on the screen for printing.

• Use figure's InvertHardcopy setting — Select this option
to use the InvertHardcopy property set in the Handle Graphics
image.

• Make figure background transparent — Select this option
to make the image background transparent.

Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.

Insert
Anything
into
Report?

Yes. Image.

Filename rptgen_hg.chg_fig_snap
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Fixed Point Block Loop

Category Simulink Fixed Point

Description The Fixed Point Block Loop component runs its children for the
Simulink model, system, or signal defined by its parent component. For
example, if the Fixed Point Block Loop is parented by the Simulink
Model Loop, it runs its children for all fixed-point blocks in the Simulink
model. The Fixed Point Block Loop component can have the Simulink
Model Loop, System Loop, or Signal Loop component as its parent.

Attributes The following figure shows the Fixed Point Block Loop Properties
panel:

Report On Automatic list from context
Select this option to report on all fixed-point blocks in the
current context. The context is set by the Fixed Point Block
Loop component’s parent component. For example, if the parent
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component is the Simulink System Loop, this component reports
on all fixed-point blocks in the current system.

If the Fixed Point Block Loop component does not have a
Simulink Model Loop, System Loop, Block Loop, or Signal
Loop component as its parent, selecting this option causes the
component to report on all fixed-point blocks in all models.

Custom - use block list
Select this option to report on a list of blocks that you specify, and
enter the block names in the corresponding field. If you want to
sort the blocks in this list, select the Sort blocks in list option
and then select a sorting option from the Sort blocks list (in
the Loop Options section). Blocks are reported on in the order
that they are sorted. If you do not select this option, blocks are
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can
be a string or cell array. See “%<VariableName> Notation” on
page 8-253 in the Text component reference page for more details.

For example, if you want to report on the A2D block and the D2A
block in the demo model fxpdemo_feedback, you could enter the
following in the block list:

A2D

Z

If you define Z in the workspace as the following,

Z={'fxpdemo_feedback/D2A'}

then the Report Generator will report on the following blocks,

A2D
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D2A

Loop
Options

You can choose block sorting options and reporting options in this pane.

Sort blocks
Use this option to select how the blocks are sorted (this option is
available if you select the Automatic list from context option
in the Report On section or if you select Custom - use block
list and the Sort blocks option):

• Select Alphabetically by fixed point block name to sort
blocks alphabetically by their names.

• Select Alphabetically by system name to sort systems
alphabetically.

In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.

• Select By fixed point block type to sort blocks
alphabetically by block type.

• Select By fixed point block depth to sort blocks by their
depth in the model.

• Select By simulation order to sort blocks by execution order.

Search for property name/property value pairs
Select this option to report only on fixed-point blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.
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Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, inserts section if the Create section for each object in loop
option is selected.

Filename rptgen_fp.cfp_blk_loop
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Category Simulink Fixed Point

Description The Fixed Point Logging Options component sets fixed-point options
similar to those set in the Fixed Point Settings interface. You can set
the following options with this component:

• Logging options

• Doubles override

• Log mode

You can use this component before a Model Simulation component in
order to control how the model behaves during simulation.

Attributes The following figure shows the Fixed Point Logging Options
Properties panel:
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Log Min
and Max

You can select logging minimum and maximum options in this section.
If a fixed-point block is logged, minimum and maximum simulation
values are logged to the workspace. See the Simulink Fixed Point
documentation for more information about logging simulation results.

All fixed point blocks
Select this option to log all fixed-point blocks.

No logging
Select this option if you do not want to any fixed-point block to
be logged.

Use block dolog parameter
Select this option to use the fixed-point blocks’ dolog parameters.

Doubles
Override

You can select whether you want to override the fixed-point blocks’
parameters and output data types with doubles, i.e, represent the
parameters and outputs using double-precision floating-point numbers
and perform all calculations with floating-point arithmetic. See the
Simulink Fixed Point documentation for more information about
overriding with doubles.

All fixed point blocks
Select this option to override the output data type with doubles.

No doubles
Select this option to have no output data types that are doubles.

Use block DblOver parameter
Select this option to use the fixed-point blocks’ DblOver
parameters.

Log Mode Select how you want logs to be recorded in this section.

Override log
Select this option if you want all simulation logs to overwrite the
previous simulation logs.
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Merge log
Select this option if you want to append all simulation logs to
the previous simulation logs.

Insert
Anything
into
Report?

No.

Filename rptgen_fp.cfp_options
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Category Simulink Fixed Point

Description The Fixed Point Property Table inserts a table that reports on
fixed-point block property name/property value pairs.

Attributes The following figure shows the Fixed Point Property Table
Properties panel:

Table A preset table is a table that is already formatted and set up. You can
select a preset table in the preset table list in the upper left corner of
the attributes page. To apply a preset table, select the table and click
Apply.

Preset table
Choose a type of table to display the object property table:

• Defaults

• Callbacks
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• Graphics

• Printing

• Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into
separate cells. To have the property name and property value
appear in adjacent horizontal cells in the table, select the Split
property/value cells check box. In this case, the table is in split
mode and there can be only one property name/property value
pair in a cell. If you have more than one name/property pair in a
cell, only the first pair is displayed in the report. All subsequent
pairs are ignored.

To have the property name and property value appear together in
one cell, deselect the Split property/value cells. This is nonsplit
mode. In nonsplit mode, you can have more than one property
name/property value pair and you can also have text.

If you want to switch from nonsplit mode to split mode, make
sure that you have only one property name/property value pair
per table cell before you switch modes. If you have more than
one property name/property value pair or any text, only the
first property name/property value pair appears in the report;
subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the
generated report.

Table Cells
Use this field to select table properties to modify. The selection in
this pane affects the available fields in the Cell Properties pane.

Title
Properties

Contents
Use this field to modify the contents of the table cell selected in
the Table Cells pane.
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Show as
Choose the format for the contents of the table cell:

• Value

• Property Value

• PROPERTY Value

• Property: Value

• PROPERTY: Value

• Property - Value

• PROPERTY - Value

Creating Custom Tables

To create a custom table, you can first select a preset table and then
edit it. You might want to start with the Blank 4x4 preset table. You
can add and delete rows and you can add properties. To open the Edit
Table dialog box, click Edit. The dialog box appears:
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For more information about using this dialog box to create custom
property tables, see “Working with Property Table Components” on
page 4-13.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_fp.cfp_prop_table
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Category Simulink Fixed Point

Description The Fixed Point Summary Table component shows properties or
parameters of the selected fixed-point blocks in a table.

Attributes The following figure shows the Fixed Point Summary Table
Properties panel:

Table title
Choose a title for the summary table in the generated report:

• Automatic — Select this option to generate a title automatically
from the parameter.

• Custom — Select this option to enter a title manually.
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Property
Columns

Property columns
This figure displays the object properties to be included in the
summary table in the generated report. To add a property,
select the appropriate property level in the menu. Next, in the
contextual list below the menu, select the property that you want

to add and click Add . To delete a property, select the property
name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary
table in the generated report. Entered widths should be in
percentages.

Object
Rows

Insert anchor for each row
Select this option to insert an anchor for each row in the summary
table.

Report On
Use this option to select the blocks that are reported on.

• Automatic list from context — Select this option to report
on all blocks in the current context.

• Custom -- use block list — Select this option to report on
a list of blocks that you specify, and enter the block names in
the corresponding field. You must use the full pathname when
specifying blocks.

Loop
Options

Sort blocks
Use this option to select how the blocks are sorted:

• Select Alphabetically by block name to sort blocks
alphabetically by their names.

• Select Alphabetically by system name to sort systems
alphabetically.

In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.
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• Select Alphabetically by full Simulink path to sort blocks
alphabetically by Simulink path.

• Select By block type to sort blocks alphabetically by block
type.

• Select By block depth to sort blocks by their depth in the
model.

• Select By traversal order to sort blocks by traversal order.

• Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_fp.cfp_summ_table
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Category Logical and Flow

Description The For Loop component iteratively executes its child components
and must have at least one child component to execute properly. This
component functions like the for loop in MATLAB, except that instead
of executing a statement, it executes its child components while one of
the following loops is active:

for varname=x:y:z
for varname=[a b c ...]

where varname must be a string that is valid as a variable name. x, y, z
can be scalar numbers or workspace expressions that are evaluated in
the workspace as scalar numbers. If any one of these is a string that
cannot be evaluated as a scalar number, the For Loop does not execute.

For example, if red is a workspace variable, the following is a valid
for statement.

for i=1:1:length(red)

length(red) is 3, which is a scalar number.

Attributes The following figure shows the For Loop Properties panel:
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Loop Type In this section you can choose the loop type to be incremented indices or
a vector of indices. See the MATLAB documentation for more details
on the for loop and indices.

Incremented indices
Choose this option to execute a for loop of the following form:

for varname=x:y:z

Enter the appropriate values in the following fields:

• Start corresponds to x in the for loop shown above.

• Increment corresponds to y in the for loop shown above.

• End corresponds to z in the for loop shown above.
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Vector of Indices
Choose this option to execute a for loop of the following form:

for varname=[a b c ...]

Enter the appropriate values in the Vector field in the form a
b c ...

Workspace
Variable

Show index value in base workspace
Use this option to place the loop index (the value of the for loop
variable) in the workspace while other components are executing.

Variable name
Enter the variable name in this field. The variable name is
varname in the for loop forms described above.

Remove variable from workspace when done
Use this option to remove the loop index from the workspace. This
option is only available if you selected the Show index value in
base workspace option.

Insert
Anything
into
Report?

No.

Filename rptgen_lo.clo_for
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Category Handle Graphics

Description The Handle Graphics Linking Anchor component designates a location
to which other links point. This component should have a looping
component as its parent.

Attributes The following figure shows the Handle Graphics Linking Anchor
Properties panel:

Insert text
If you want text to appear after the linking anchor, enter the text
in this field.
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Link from current
This option sets the current model, system, block, or signal as
the linking anchor:

• Select Automatic to automatically select the appropriate
figure, axes, or object as a linking anchor. If the Figure Loop
component is the parent component, the linking anchor is set
on the current figure. Similarly, if the Object Loop is the parent
component, the linking anchor is inserted for the current object.

• Select Figure to set the linking anchor to the current figure.

• Select Axes to set the linking anchor to the current axes.

• Select Object to set the linking anchor to the current object.

Insert
Anything
into
Report?

Yes. Anchor.

Filename rptgen_hg.chg_obj_anchor
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Category Handle Graphics

Description The Handle Graphics Name component inserts the name of a Handle
Graphics object into the report as text.

You can use this component to create a section title based on the current
figure. First, make sure that this component is the first child component
of a Chapter/Subsection component, and select the Get title from
first child component option in the Chapter/Subsection component.

Attributes The following figure shows the Handle Graphics Name Properties
panel:
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Display name as
Select Figure to show the name of the current Handle Graphics
figure. The name of the current figure comes from the first
nonempty figure parameter in the following order:

• Name

• Tag

• FileName

• Handle

Select Axes to show the name of the current axes. The name of
the current axes comes from the first nonempty axes parameter in
the following order:

• Title

• Xlabel

• Ylabel

• Zlabel

• Tag

• Handle

Select the Other Object option to take the name of the current
object from the figure’s CurrentObject parameter and its first
nonempty figure parameter in the following order:

• uicontrol

- String

- Style

- Handle

• uimenu

- Label
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- Accelerator

- Tag

- Handle

• uicontextmenu, image, light, line, patch, or surface

- Tag

- Handle

• text

- String

- Tag

- Handle

See the MATLAB graphics documentation for more information.

Show name of current
Select one of the three options listed below Name (example: Name)

• Figure

• Axes

• Other Object

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen_hg.chg_obj_name
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Category Handle Graphics

Description The Handle Graphics Object Loop component runs its child components
for each Handle Graphics object currently open in the MATLAB
workspace. The component inserts a table into the generated report.

Attributes The following figure shows the Handle Graphics Object Loop
Properties panel:

Select
Objects

Exclude GUI objects (uicontrol, uimenu, ...}
Select this option to exclude GUI objects, such as uicontrol and
uimenu, from the loop.

Loop list
Use this list to select the loop level for Handle Graphics objects:
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• Loop on objects with handle visibility "on"

• Loop on all objects

Search for
Enter search terms in this field. Separate search terms with a
space.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_hg.chg_obj_loop
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Category Handle Graphics

Description The Handle Graphics Parameter component inserts a single property
name/property value pair from a Handle Graphics figure, axes, or other
object.

Attributes The following figure shows the Handle Graphics Parameter
Properties panel:

Property
Selection

Get property from current
Select a Handle Graphics object to report on:

• Select Figure to insert a figure’s property name/property value
pair.
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• Select Axes to insert an axes’ property name/property value
pair.

• Select Object to insert an object’s property name/property
value pair.

Figure property
Choose the type of property you want to include from the list in
this section. All shows every parameter for the current object.
Select the property you want to include in the report from the
list box in this section.

Display
Options

Title
Choose a title for the display in the generated report. To generate
a title automatically from the parameter, select Automatic. To
enter a title, select Custom. To specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated
report. Units are in pixels. When creating a table, the size limit is
the hypotenuse of the table width and height [sqrt(w^2+h^2)].
When creating text, the size limit is the number of characters
squared. If the size limit is exceeded, the variable is rendered in
condensed form, such as [64x64 double]. Setting a size limit of
zero will ignore the size limit and always display the variable, no
matter how large.

Display as
Choose a display style from the menu:

• Auto table/paragraph — Displays as a table or paragraph
based on the information.

• Inline text — Displays as inline, which fits in line with the
surrounding text.

• Paragraph — Displays as a text paragraph.

• Table — Displays as a table.
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Ignore if value is empty
Select this option to exclude empty parameters in the generated
report.

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen_hg.chg_property
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Category Handle Graphics

Description The Handle Graphics Property Table component inserts a table that
reports on property name/property value pairs.

See “Working with Property Table Components” on page 4-13 for a
tutorial on the Handle Graphics Property Table component.

Attributes The following figure shows the Handle Graphics Property Table
Properties panel:

Select
Graphics
Object

Object type
Choose the object type for the generated report:

• Figure

• Axes

• Object
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Filter by class
Select this option to filter the object by the specified class or
classes. This option enables you to select a specific class for the
table. For example, when selecting type Object, you can filter by
class line. If the object is type surface, it does not generate a
property table.

Table A preset table is a table that is already formatted and set up. You can
select a preset table in the preset table list in the upper left corner of
the attributes page. To apply a preset table, select the table and click
Apply.

Preset table
Choose a type of table to display the object property table:

• Defaults

• Callbacks

• Graphics

• Printing

• Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into
separate cells. To have the property name and property value
appear in adjacent horizontal cells in the table, select the Split
property/value cells check box. In this case, the table is in split
mode and there can be only one property name/property value
pair in a cell. If you have more than one name/property pair in a
cell, only the first pair is displayed in the report. All subsequent
pairs are ignored.

To have the property name and property value appear together in
one cell, deselect the Split property/value cells. This is nonsplit
mode. In nonsplit mode, you can have more than one property
name/property value pair and you can also have text.
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If you want to switch from nonsplit mode to split mode, make
sure that you have only one property name/property value pair
per table cell before you switch modes. If you have more than
one property name/property value pair or any text, only the
first property name/property value pair appears in the report;
subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the
generated report.

Table Cells
Use this pane to select table properties to modify. The selection in
this pane affects the available fields in the Title Properties pane.

Title
Properties

The visible options in the Title Properties pane depend on the object
selected in the Table Cells pane. If Figure Properties is selected,
only the Contents and Show options are displayed. If any other object
is selected in the Table Cells pane, the Alignment, Lower border,
and Right border options are displayed.

Contents
Use this field to modify the contents of the table cell selected in
the Table Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell
in the Table Cells pane:

• Left

• Center

• Right

• Double justified

Show as
Choose the format for the contents of the table cell:

• Value
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• Property Value

• PROPERTY Value

• Property: Value

• PROPERTY: Value

• Property - Value

• PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the
generated report.

Right border
Select this option to display the right border of the table in the
generated report.

Creating Custom Tables

To create a custom table, you can first select a preset table and then
edit it. You might want to start with the Blank 4x4 preset table. You
can add and delete rows and you can add properties. To open the Edit
Table dialog box, click Edit. The dialog box appears, as the following
figure shows:
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For more information about using this dialog box to create custom
property tables, see “Working with Property Table Components” on
page 4-13.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_hg.chg_prop_table
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Category Handle Graphics

Description The Handle Graphics Summary Table component inserts a table that
summarizes Handle Graphics object properties. Each row in the table
represents an object, and each column in the table represents a property.
You can specify the object properties to be included in the report.

Attributes The following figure shows the Handle Graphics Summary Table
Properties panel:

Object type
Choose the object type to display in the generated report:
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• figure

• axes

• object

The available options in the Select Objects pane depend on your
selection in the Object type menu.

Table title
Choose a title for the summary table in the generated report:

• Automatic — Select this option to generate a title automatically
from the parameter.

• Custom — Select this option to enter a title manually.

Property
Columns

Property columns
This figure displays the object properties to be included in the
summary table in the generated report. To add a property,
select the appropriate property level in the menu. Next, in the
contextual list below the menu, select the property that you want

to add and click Add . To delete a property, select the property
name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary
table in the generated report. Entered widths should be in
percentages.

Object
Rows

Insert anchor for each row
Select this option to insert an anchor for each row in the summary
table.

Object
Selection

The options displayed in the Object Selection pane depend on the
object type selected in the Object type list. If figure is selected in
Object type, the following options are displayed:
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Include figures
To include only the current figure in the report, select the Current
figure only option.

To loop on all visible figures, select the Visible figures option.
This option executes child components for all figures that are
currently open and visible. The Data figures only option is
checked by default and excludes figures with HandleVisibility
= 'off' from the loop.

To loop on figures with certain tags, select the All figures with
tags option. When you are selecting a tag, all figures with that
tag are included, regardless of whether the figure is visible or
whether HandleVisibility is 'on' or 'off'. The tag list box
(located under the All figures with tags option) shows the
selected tags. To add a tag to the tag list box, type in the tag.

Loop Figure List
The Loop Figure List shows you the figures that would be
looped on given the current set of figures.

If axes is selected in Object type, the following options are displayed:

Loop type
To loop on all axes objects, select All axes. To loop on the selected
axes object, select Current axes.

Exclude objects which subclass axes
Select this option to exclude objects such as legends and color bars.

Loop Menu
To loop only on visible axes objects, select Loop on axes with
handle visibility "on". To loop on all axes objects, select Loop
on all axes.

Search terms
Enter search terms for the loop. For example, to search for Tag
and My Data, enter "Tag", "My Data".
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If object is selected in Object type, the following options are displayed:

Exclude GUI objects (uicontrol, uimenu, ...}
Select this option to exclude GUI objects, such as uicontrol and
uimenu, from the loop.

Loop menu
Use this menu to select the loop level for Handle Graphics objects:

• Loop on objects with handle visibility "on"

• Loop on all objects

Search for
Enter search terms in this field. Separate search terms with a
space.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_hg.chg_summ_table
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Category Formatting

Description The Image component inserts an image from an external file into the
report. The Image component can have the Chapter/Subsection or
Paragraph component as its parent. If the Paragraph component is its
parent, the Insert as inline image check box must be checked.

Attributes The following figure shows the Image Properties panel:

File Name File name
Enter the image filename in this field or use the browse button
(...) to find the file that contains the image.
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Make sure that the image is in a format that your viewer can
read. Your viewer depends on the report format you selected in
the Report Options page in Report Explorer. For a discussion on
report format options, see “Setting Report Output Options” on
page 2-2

You can use the %<VariableName> notation. See
“%<VariableName> Notation” on page 8-253 in the Text
component reference.

Copy to local report files directory
Select this option to save a copy of the image to a local report
files directory.

Display
Options

Image Title
Choose a title option in this section:

• No title: Select this option if you do not want an image title.

• Title: Select this option and type the image title in the
corresponding field if you want an image title that is not the
same as the image file name.

• Title from filename: Select this option if you want the image
title to be the same as the image filename.

Insert as inline image
Select this option if you want to insert an inline image in a
paragraph. This option is available only when the image does not
have a title, i.e., if you select the No title option in the Image
Title option. To make this a valid option, the Image component
must have the Paragraph component as its parent and Text
components as its peers.

For example, if the following components are included in a setup
file,

paragraph
text - "This is an example of an inline image."

8-86



Image

text - "This is an example."
image - *image.jpg*
text - "This is an example of an inline image."

and you select the Insert as inline image option, the report
would contain the following paragraph:

This is an example of an inline image. This
is an example. *image.jpg* This is
an example of an inline image.

If you do not select the Insert as inline image option, the report
would contain the following paragraph (notice that the image is
not inline).

This is an example of an inline image. This
is an example.
*image.jpg*
This is an example of an inline image.

Caption
Enter a short text description for the image.

Preview The Preview pane shows the image that you specify in the Image
file name field. You cannot preview PostScript images or images with
formats that are not supported by the imread function, such as .gif.

If you click the image in the Preview pane, it is displayed in full size on
the screen.

Insert
Anything
into
Report?

Yes. Image.

Filename rptgen.cfr_image
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Import File

Category Report Generator

Description The Import File component imports an ASCII text file.

Attributes The following figure shows the Import File Properties panel:

File name
Enter the name of the file to import in the text field in this section
or use the browse button (...) to find the file. This component
executes only if you enter a valid filename in this field.

Import file as
Indicate what kind of format to use for imported file

• Plain text (ignore line breaks): Select this option to import
the file as plain text without any line breaks (no paragraphs). If
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you select this option, the Import File component acts like the Text
component and should have the Paragraph component as its parent.

In this example and subsequent examples, the following text is used
as the input file.

This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

With the Plain text (ignore line breaks) option, the following
is produced.

This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

• Paragraphs defined by line breaks: Select this option to import
the file as text contained in paragraphs defined by line breaks (hard
returns or carriage returns).

With the Paragraphs defined by line breaks option, the
following is produced.

This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

• Paragraphs defined by empty rows: Select this option to import
the file as text contained in paragraphs defined by empty rows (rows
that do not contain text).

With the Paragraphs defined by empty rows option, the following
is produced.

This is the first row of text from the imported file.
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The second row follows a line break in the first row.

There is a blank line above the third row.

• Text (retain line breaks): Select this option to import the file as
plain text, including line breaks.

With the Text (retain line breaks) option, the following is
produced.

This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

• Fixed-width text (retain line breaks): Select this option to
import the file as fixed-width text (all letters have the same width or
size) including line breaks. This option is best suited for importing
M-files.

With the Fixed-width text (retain line breaks) option, the
following is produced.

This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

• DocBook XML: Select this option if the inserted text file is in an XML
source file. The format of the inserted XML file is not changed.

• Formatted Text (RTF/HTML): Select this option if the inserted text
file is in an RTF or HTML source file. The format of the inserted RTF
or HTML source file is not changed.

• Syntax highlighted M-code: Select this option if the inserted text
file is an M-file containing highlighted M-code.
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Ths File Contents field displays the first few lines of the file to be
imported.

Insert
Anything
into
Report?

Yes. Inserts text if you select one of the following options:

• Plain text (ignore line breaks)

• Text (retain line breaks)

• Fixed-width text (retain line breaks)

Inserts paragraphs if you select one of the following options:

• Paragraphs defined by line breaks

• Paragraphs defined by empty rows

Inserts the contents of the XML file if you select the DocBook XML
option. This can include text, paragraphs, tables, etc.

Inserts the contents of the RTF or HTML file if you select the Formatted
text (RTF/HTML) option. This can include text, paragraphs, tables, etc.

Filename rptgen.crg_import_file
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Category Real-Time Workshop

Description The Import Generated Code component imports source and header files
generated by Real-Time Workshop and any custom files you specify as
part of your model.

Attributes The following figure shows the Import Generated Code Properties
panel.
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Source files (auto-generated)
Select this option to include the following files in the report:

• .c and .cpp source files Real-Time Workshop generates based
on your model

• Real-Time Workshop source files, such as the template main
file and other support files in the build directory

Clear the check box to omit source files. This option is selected
by default.

Header files (auto-generated)
Select this option to include the following files in the report:

• .h and .hpp header files Real-Time Workshop generates based
on your model

• Real-Time Workshop header files in the build directory

Clear the check box to omit header files. This option is selected
by default.

Custom files
Select this option to include custom source files that you specify
in the Real-Time Workshop > Custom Code pane of the
Configuration Parameters dialog box. This option is cleared by
default.

Insert
Anything
into
Report?

Yes. Generated code listings.

Filename RptgenRTW.CImportCode
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Category MATLAB

Description The Insert Variable component takes one of the following variables and
inserts its value (and name, if you choose to do so) into the report:

• A variable from the MATLAB workspace

• A variable from a MAT-file

• A global variable

Attributes The following figure shows the Insert Variable Properties panel:

Source Variable name
Enter the name of the variable in this field.
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You can use %<VariableName> to insert the value of a variable
from the MATLAB workspace. For example, if you enter the
following expression in this field,

%<my_variable>

and you have the following in your MATLAB workspace:

my_variable='velocity'
velocity=50

then your report will contain the following:

50

If you enter %<velocity> in this field, and your MATLAB
workspace contains the same information, your report will also
contain 50.

Variable location
Select one of the following options:

Base Workspace — This option gets a variable from the MATLAB
workspace.

MAT File — This option gets a variable from a binary file with a
.mat extension.

Global variable — This option gets a global variable.

Display
Options

Title
Choose a title for the display in the generated report. To generate
a title automatically from the parameter, select Automatic. To
enter a title, select Custom. To specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated
report. Units are in pixels. When creating a table, the size limit is
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the hypotenuse of the table width and height [sqrt(w^2+h^2)].
When creating text, the size limit is the number of characters
squared. If the size limit is exceeded, the variable renders in
condensed form, such as [64x64 double]. Setting a size limit of
zero will ignore the size limit and always display the variable, no
matter how large.

Display as
Choose a display style from the menu:

• Auto table/paragraph — Displays as a table or paragraph
based on the information.

• Inline text — Displays as inline, which fits in line with the
surrunding text.

• Paragraph — Displays as a text paragraph.

• Table — Displays as a table.

Ignore if value is empty
Select this option to exclude empty parameters in the generated
report.

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen.cml_variable
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Category Formatting

Description The Link component inserts linking anchors or pointers into the report.

Attributes The following figure shows the Link Properties panel:

Link type
Select the type of link to insert into the report:

• Linking Anchor: An anchor is the object to which something
links; i.e., links "link" to an anchor.

• Internal Document Link: A link takes you to the location in
your report (specified by an anchor) to which it points when
you click it.

• URL (external) Link: A URL link is a link to a Web site. It
takes you to the location on the Web to which your link points
when you click it.
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Link identifier
The link identifier options are context sensitive and change
depending on the link type selected above. The Link identifier
field marks the location to which the link points. The link is not
visible in the report.

Link text
Enter text to use in the link.

Emphasize link text
Select this option to italicize the link text.

Insert
Anything
into
Report?

Yes. Text or anchor.

Filename rptgen.cfr_link
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Category Formatting

Description The List component creates a bulleted or numbered list from a cell
array or from child components.

Attributes The following figure shows the List Properties panel:

List
Content

Create list from workspace cell array
Enter the name of the 1-by-n or n-by-1 cell array from which the
list will be created in this field. This option is not available when
this component has child components, because the list is then
automatically generated from the child components.

List title
Enter the title of the list in this field.
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List
Formatting

List style
Select either Bulleted list or Numbered list. If you
choose Numbered list, you can select numbering options in the
Numbering style field.

Numbering style
Select a numbering style in this pull-down menu if you selected
Numbered List for the List style. The options are

• 1,2,3,4,...

• a,b,c,d,...

• A,B,C,D,...

• i,ii,iii,iv,...

• I,II,III,IV,...

Show parent number in nested list (1.1.a)
Select this option to show all level numbers in a nested list. You
can create a nested list by putting one cell array inside another
or by nesting one List component inside another. If you choose
this option, your list will have this type of appearance (the actual
appearance depends on the option chosen in the Numbering
style field).

1. Example
2. Example
2.1. Example
2.2. Example
2.2.a. Example
2.2.b. Example

3. Example

Note that this option is not available if you select the Show only
current list value (a) option.

Show only current list value (a)
Select this option to show only the current list value. If you
choose this option, the list shown above will have this type of
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appearance (the actual appearance depends on the option chosen
in the Numbering style field).

1. Example
2. Example
1. Example
2. Example
1. Example
2. Example

3. Example

Note that this option is not available if you select the Show parent
number in nested list (1.1.a) option.

Continue numbering from previous list
Select this option to continue list numbering from a previous list.
Note that this option is not available if you select the Always
start at 1 option.

Always start at 1
Select this option to always start list numbering at 1. Note that
this option is not available if you select the Continue numbering
from previous list option.

Example1: Creating a Nested List

You can create a nested list by putting one cell array inside another or
by nesting one List component inside another.

For example, if you have the following setup file, with one List
component nested inside another List component,

[-] Report - Unnamed.rpt
[-] Bulleted list from child components

[ ] Text - sky
[ ] Table - varname
[ ] Image - test.jpg
[ ] Text - grass
[-] Bulleted list from child components
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[ ] Text - clouds
[ ] Text - sun

[-] Paragraph - information

then the report would contain the following bulleted lists:

• sky

• Table from variable — varname

• Snapshot of image — test.jpg

• grass

- clouds

- sun

• information

Example 2: Creating the Same List with Child Components
and a Cell Array

Setup file with child components:

[-] Report - Unnamed.rpt
[-] Bulleted list from child components

[ ] Text - red
[ ] Text - green
[ ] Text - blue

Setup file calling a cell array:

[-] Report - Unnamed.rpt
[-] Bulleted list from cell array called colors

Cell array:

colors={'red','green','blue'}
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Using either of these two setup files, the report contains the following
bulleted list:

• red

• green

• blue

Insert
Anything
into
Report?

Yes. List.

Filename rptgen.cfr_list
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Category Logical and Flow

Description The Logical Else component acts as an else when it is the child of the
Logical If component. There are two ways to use this component:

if
then
else

or

if
then
elseif
elseif

.

.

.
else

Attributes The following figure shows the Logical Else Properties panel:
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If component has no children, insert text
When the Logical Else component has no child components, the
string in this field is inserted into your report. In this case, this
component acts like the Text component.

Insert
Anything
into
Report?

Depends on whether if or elseif statement is true.

Filename rptgen_lo.clo_else
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Category Logical and Flow

Description The Logical Elseif component acts as an elseif when it is the child
of the Logical If component. You must use this component in this
format:

if
then
elseif
elseif

.

.

.
else

Attributes The following figure shows the Logical Elseif Properties panel:
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Test expression
Enter a MATLAB expression to evaluate.

If component has no children, insert text
When the Logical Elseif component has no child components, the
string in this field is inserted into the report. In this case, this
component acts like the Text component.

Insert
Anything
into
Report?

Yes, only when parent if statement is false.
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Filename rptgen_lo.clo_else_if
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Category Logical and Flow

Description The Logical If component acts as a logical if; it can have the Logical
Then, Logical Elseif, and Logical Else components as its child
components. This component executes its child components when the
given workspace expression is true. It displays a specified string when
it has no child components. There are three ways to use this component:

if
then

or

if
then
else

or

if
then
elseif
elseif

.

.

.
else

Attributes The following figure shows the Logical If Properties panel:
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Test expression
Enter a MATLAB expression to evaluate.

If component has no children, insert text
When the Logical If component has no child components, the
string in this field is inserted into your report.

Insert
Anything
into
Report?

Depends on attributes.

Filename rptgen_lo.clo_if
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Category Logical and Flow

Description The Logical Then component acts as a then when it is the child of the
Logical If component. There are three ways to use this component:

if
then

or

if
then
else

or

if
then
elseif
elseif

.

.

.
else

Attributes The following figure shows the Logical Then Properties panel:
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If component has no children, insert text
When the Logical Then component has no child components, the
string in this field is inserted into your report. In this case, this
component acts like the Text component.

Insert
Anything
into
Report?

Yes, only when parent if statement is true.

Filename rptgen_lo.clo_then
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Category Simulink Blocks

Description The Look-Up Table component reports on the following lookup table
blocks: Lookup Table, Lookup Table (2-D), Lookup Table (n-D), and
PreLookup Index Search.

This component inserts a figure and/or table into the report; the table
contains input and output numeric values, and the figure is a plot of
the values.

Attributes The following figure shows the Look-Up Table Properties panel:
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Look-Up
Table
Options

This pane allows you to specify the types of Look-Up Table blocks that
are included in the report and how they are displayed. If none of the
check boxes in this pane are selected, the component does not insert
anything into the report.

These options display the lookup tables, depending on what the
component is operating on:

• If the Look-Up Table has the Model Loop as its parent, it
includes all lookup tables in the current model.

• If the Look-Up Table has the System Loop as its parent, it
includes all lookup tables in the current system.

• If the Look-Up Table has the Block Loop as its parent, it
includes the current block if it is a look-up table.

• If the Look-Up Table has the Signal Loop as its parent, it
includes all lookup tables connected to the current signal.

• If the Look-Up Table does not have any of the Simulink looping
components as its parent, it includes all lookup tables in all
open models.

Plot 1-D data
Select this option to plot data from a Look-Up Table block
and choose the plot type (Line plot or Bar plot) from the
corresponding list. See theMATLAB graphics documentation for
more information on line plots and bar plots. The input data is
shown on the horizontal or x-axis and the output data is shown
on the vertical or y-axis.

Create table for 1-D data
Select this option to create a table that contains numeric data
values from the Look-Up Table block.

Plot 2-D data
Select this check box to include a plot of 2-D Look-Up Table blocks.
You can specify whether the data appears as a surface plot or a
line plot. The line plot is best for small data sets and the surface
plot is most appropriate for larger tables. See the MATLAB
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graphics documentation for more information on surface plots
and line plots.

Create table for 2-D data
Select this option to create a table that contains numeric data
values from the Look-Up Table (2-D) block.

Create table for N-D data
Select this option to create a table that contains numeric data
values from the Look-Up Table (n-D) block. Note that this is a
2-D slice through the N-D data.

Print
Options

Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic HG Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
viewer can read. Automatic HG Format is the default option.
The options include

• Automatic SL Format (Uses the Simulink file format selected
in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)
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• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed

• Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper
orientation, or you can choose the Use figure orientation
option. See the orient command for information about paper
orientation.

Image size
Select Use figure PaperPositionMode setting to use the
PaperPositionMode property of the Handle Graphics figure to
set the image size in the report. See the orient command for
information about paper position mode.

Select the Automatic (same size as on screen) option if you
want the image in your report to be the same size as the image
on the screen.

Select the Custom option to choose a custom image size. If you
choose this option, specify the image size in the Size field and
Units list.
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• Size: Enter the size of the Handle Graphics figure snapshot in
the form wxh (width times height). This field is active only if
you choose Custom in the Image size list box.

• Units: Enter the units for the size of the Handle Graphics
figure snapshot. This field is active only if you choose Custom
in the Image size list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This
parameter inverts colors for printing; i.e., it changes dark colors
to light colors and vice versa.

Select one of the following options:

• Automatic — Select this option to automatically change dark
axes colors to a light axes color. If the axes color is a light color,
it is not inverted.

• Invert – Select this option to change dark axes colors to light
axes colors and vice versa.

• Don't invert— Select this option if you do not want to change
the colors in the image displayed on the screen for printing.

• Use figure's InvertHardcopy setting — Select this option
to use the InvertHardcopy property set in the Handle Graphics
image.

• Make figure background transparent — Select this option
to make the image background transparent.

Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.
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Insert
Anything
into
Report?

Yes. Figure and/or table.

Filename rptgen_sl.csl_blk_lookup
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Category Stateflow

Description The Machine Loop component runs its child components for all selected
Stateflow machines. The Machine Loop component is context sensitive
of its parent component. If no parent, the Machine Loop runs its child
components for all machines. If a model is its parent, it runs its child
components for all machines in the model.

Attributes The following figure shows the Machine Loop Properties panel:

Loop
Options

Search States
Select this option to search states that you specify in the field that
appears below the check box.
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Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_sf.csf_machine_loop
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Category MATLAB

Description The MATLAB Property Table inserts a table that reports on MATLAB
object property name/property value pairs.

Attributes The following figure shows the MATLAB Property Table Properties
panel:

Table A preset table is a table that is already formatted and set up. You can
select a preset table in the preset table list in the upper left corner of
the attributes page. To apply a preset table, select the table and click
Apply.

Preset table
Choose a type of table to display the object property table:

• Defaults

• Callbacks
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• Graphics

• Printing

• Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into
separate cells. To have the property name and property value
appear in adjacent cells, select the Split property/value cells
check box. In this case, the table is in split mode and there can be
only one property name/property value pair in a cell. If you have
more than one name/property pair in a cell, only the first pair is
displayed in the report. All subsequent pairs are ignored.

To have the property name and property value appear together in
one cell, deselect the Split property/value cells. This is nonsplit
mode. In nonsplit mode, you can have more than one property
name/property value pair and you can also have text.

If you want to switch from nonsplit mode to split mode, make sure
that you have only one property name/property value pair per
table cell before you switch modes.

Display outer border
Select this option to display the outer border of the table in the
generated report.

Table Cells
Use this field to select table properties to modify. The selection in
this pane affects the available fields in the Cell Properties pane.

Title
Properties

The visible options in the Title Properties pane depend on the object
selected in the Table Cells pane. If Workspace Properties is selected,
only the Contents and Show options are displayed. If any other object
is selected in the Table Cells pane, the Alignment, Lower border,
and Right border options are displayed.
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Contents
Use this field to modify the contents of the table cell selected in
the Table Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell
in the Table Cells field:

• Left

• Center

• Right

• Double justified

Show as
Choose the format for the contents of the table cell:

• Value

• Property Value

• PROPERTY Value

• Property: Value

• PROPERTY: Value

• Property - Value

• PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the
generated report.

Right border
Select this option to display the right border of the table in the
generated report.

Creating Custom Tables

To create a custom table, you can first select a preset table and then
edit it. You might want to start with the Blank 4x4 preset table. You
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can add and delete rows and you can add properties. To open the Edit
Table dialog box, click Edit. The dialog box appears:

For more information about using this dialog box to create custom
property tables, see “Working with Property Table Components” on
page 4-13.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen.cml_prop_table
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MATLAB/Toolbox Version Number

Category MATLAB

Description The MATLAB/Toolbox Version Number component creates and inserts
a table that shows the version number, release number, and/or release
date of any MathWorks software you are currently using. You can get a
list of all your toolboxes by typing ver at the command line.

Attributes The following figure shows the MATLAB/Toolbox Version Number
Properties panel:

Table Title Table title
Enter the title of the table in this field.
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Table
Columns

Version number
Select this option to include the version number of any MathWorks
software you are currently using.

Release number
Select this option to include the release number of any MathWorks
software you are currently using.

Release date
Select this option to include the release date of any MathWorks
software you are currently using.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen.cml_ver
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Category Simulink

Description The Model Advisor Report component inserts a Model Advisor report for
the current model into the report.

Attributes The following figure shows the Model Advisor Report attribute panel:

Use existing report
Select the Use existing report check box to include an existing
Model Advisor report in the report. If this check box is cleared, a
new Model Advisor report is generated. Use existing report is
selected by default.

Insert
Anything
into
Report?

Yes, a Model Advisor report.
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Filename rptgen_sl.CModelAdvisor
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Model Change Log

Category Simulink

Description The Model Change Log component uses a reported model’s
ModifiedHistory parameter to construct a model history table that
displays information about each logged revision to the model. This
model history table can contain information about any of the following:

• Author of each change

• Model version of the change

• Time and date of the change

• Description of the change

To see the model revision history parameters, select Model Properties
from the model’s File menu, which displays the Block Diagram
Properties dialog box. The Model Properties tab in this dialog box
contains the model revision history parameters.

The Options tab in the Block Diagram Properties dialog box
controls how the version number is incremented. The History tab
controls history updates and lets you edit the ModifiedHistory string.
You must select the Prompt For Comments When Save option from the
Modified History Update list in order to save your revisions. This
component does not run if the model’s ModifiedHistory parameter
is empty or if you edit the parameter in such a way that the Report
Generator cannot parse it; in these cases, the Comment component
cannnot produce the table.

For more information on the Block Diagram Properties dialog box
and model history, see the Simulink documentation.

Note that if your model has a long revision history, you might want to
limit the number of revisions reported.

The Model Change Log component should run before the Model
Simulation component.

Attributes The following figure shows the Model Change Log Properties panel:
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Table
Columns

You can choose the information displayed in the model revision table
in this section.

Author name
Select this option if you want to include the name of the person
responsible for the revision of the model.

Version
Select this option if you want to include the version number of
the model.
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Date changed
Select this option if you want to include the date on which the
model was revised.

Description of change
Select this option if you want to include a description of the
revision to the model.

Table
Rows

Limit displayed revisions to
Select this option to limit the number of revisions that is displayed
in the report. Enter the number in the corresponding text field.

Show revisions since date
Select this option to limit the number of revisions that is displayed
in the report by date. Enter the date in the corresponding
text field. The %<varname> notation is legal. For example,
%<datestr(now-14)> returns the revisions for the last two weeks.

Table
Display

You can choose how the model revision history table is displayed in
this section.

Table title
Enter the title of the table in this field.

Example

This is an example of a report generated from a setup file with the
Model Change Log component.
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Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_mdl_changelog
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Category Simulink

Description The Model Loop component runs its child components for all selected
Simulink models and systems. The Model Loop component can run its
child components for a specific model, such as the demo model F14, or it
can run its child components for all models or the current model.

Because Simulink components are context sensitive, they should be
children of the Model Loop (although the Model Loop does not have to
be the immediate parent of some Simulink components).

Attributes The following figure shows the Model Loop attribute panel:

Models to Include

The Models to Include field contains a list of reported models. To add
another model to the list, click Add New Model to List. The following
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table shows the button you should use to move a model up or down in
the list, or to add or delete a model.

Button Action

Move a model up in the list.

Move a model down in the list.

Remove a model from the list.

Add a model to the list.

Model
Options

Active
Select this option to include the active model. If not selected, the
model will be omitted. This option provides a way of temporarily
deactivating a model.

Model name
Choose a model name:

• Enter the model name. The &<varname> notation is allowed.

• Current model

• All models

The selection in the Model name option affects the available
options for the Traverse model option.

Traverse model
Choose system to traverse:

• All systems in model

• Selected system(s) only

• Selected system(s) and ancestors
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• Selected system(s) and children

The options available in the Traverse model list are affected by
the selection in the Model name list.

Starting system(s)
Select the system in which to start the loop. The available options
in the Starting system(s) list are affected by the selection in the
Traverse model list. For example, if All systems in model is
selected in the Traverse model list, the Starting system(s)
list is not relevant.

Look under masks
Simulink systems can have masks. The masks can be functional
or graphical. Choose how to handle masks:

• No masks

• All masks

• Functional masks only

• Graphical masks only

See the Simulink documentation for more information about
masks.

Follow library links
Simulink blocks and systems can be linked to a library. Choose
the library links to include:

• Do not follow library links

• Include library links

• Include unique library links

See the Simulink documentation for more information about
library links.
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Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, if the Create section for each object in loop option is selected.

Filename rptgen_sl.csl_mdl_loop
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Category Simulink

Description The Model Simulation component runs the current model using the
simulation parameters specified in the attributes page. This component
should have the Model Loop component as its parent.

Attributes The following figure shows the Model Simulation Properties panel:

I/O
Parameters

Use model’s workspace I/O variable names
Select this option to use the names of the variables specified in
the Simulation Parameters dialog box. For a description of
these variables, see the Simulink documentation.
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The following options are available if you do not select the Use
model's workspace I/O variable names option:

• Time — Enter a new variable name for the Time parameter in
this field.

• States — Enter a new variable name for the States parameter
in this field.

• Output — Enter a new variable name for the Output
parameter in this field.

Timespan Use model’s timespan values
Select this option to use the model’s Start time and Stop
time values specified in the Solver tab in the Simulation
Parameters dialog box. For a description of these variables, see
the Simulink documentation.

The following options are available if you do not select the Use
model’s timespan values option:

• Start — Enter a new simulation starting time in this field.

• Stop — Enter a new simulation ending time in this field.

Note If your model’s stop time is set to inf (infinity) in
Simulink or on this component’s attribute page, the Report
Generator terminates the model simulation after 60 seconds
to prevent the report from generating for an infinite amount
of time.

Insert
Anything
into
Report?

No.
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Filename rptgen_sl.csl_mdl_sim
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Nest Setup File

Category Report Generator

Description The Nest Setup File component runs another setup file at the point
where the Nest Setup File component is listed in the current setup
file. The Nest Setup File component allows one setup file (.rpt) to run
inside another.

The components of the inserted setup file enter the current setup file
at the level of the Nest Setup File component. Thus, the inserted
components have the same parent component as the Nest Setup File
component. Make sure that the inserted components can have this
parent component.

Attributes The following figure shows the Nest Setup File Properties panel:
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Setup file to run
Enter the name of the setup file to import and run in this field
or use the browse button (...) to find the file. This component
executes only if you enter a valid filename in this field.

Inline nested report in this report
Select this option to insert the nested report at the place in the
original report where this component is located.

Insert link to external report
Select this option to create two separate reports, one with the
original setup file and one with the nested setup file.
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Recursion limit
If you want to nest a setup file inside itself, you can set a recursion
limit in this field. The recursion limit sets a limit on the number
of times the setup file can run itself.

Nest all reports with specified file name
Select this option to nest all reports with the same name as
specified in the Setup file to run option.

Example

In the example shown below, the setup file R2.rpt is nested in R1.rpt.

[-] Report - R1.rpt [-] Report - R2.rpt
[ ] Chapter [ ] 1

[-] B [ ] 2
[ ] Nest Setfile - R2.rpt [-] Chapter
[ ] C [ ] 4

[ ] D [ ] 5

The report executes as if the original setup file looked like this.

[-] Report - R1.rpt
[ ] Chapter
[-] B

[ ] 1
[ ] 2
[-] Section 1

[ ] 4
[ ] 5

[ ] C
[ ] D

Components that determine their behavior from their parents, such as
Chapter/Subsection, are affected by components in the parent setup file
(as shown above). See the Chapter/Subsection reference page for more
details on the Chapter/Subsection component.
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Insert
Anything
into
Report?

Yes, if the nested setup file produces visible output.

Filename rptgen.crg_nest_set
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Paragraph

Category Formatting

Description The Paragraph component inserts a paragraph into the report. The
paragraph text is taken from a child text component or from text that
you enter in the Paragraph Text field.

Attributes The following figure shows the Paragraph Properties panel:

Title
Options

No paragraph title
Select this option if you do not want the paragraph to have a title.

Get title from first child component
Select this option if you want the title of the paragraph to be
taken from the first child component. The first child component
should be a Text component.
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Specify title
Select this option and enter the title of the paragraph in this field
if you do not want the title to come from the first child component.

Paragraph Text
Enter paragraph text in this field. If the Paragraph component
has child components, the paragraph content is taken from the
child components. Otherwise, the Paragraph component inserts
text from this field.

If the Paragraph component does not have any child components
and you do not enter any text in this field, the Paragraph
component does not insert anything into the report.

Note that you can use the %<VariableName> notation in this field
if you want to insert the value of a variable from the MATLAB
workspace. See “%<VariableName> Notation” on page 8-253 in
the Text component reference page

Insert
Anything
into
Report?

Yes. Can be text, an image, etc.; depends on child components.

Filename rptgen.cfr_paragraph
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Category Requirements Management Interface

Description The Requirements Table component creates a table that contains
information from Simulink Verification and Validation. Objects can
have multiple requirements. Each requirement is a row in the table.

Attributes The following figure shows the Requirements Table Properties panel:

Table
Options

Show requirements for current
Select the object type to display.

• Simulink object

• Stateflow object
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Table title
Select a title for the table.

• No title

• Object name

• Custom

Table
Columns

Description
Select this option to include the requirement’s description in the
table.

Document name
Select this option to include the requirement’s document name in
the table.

Locations within document
Select this option to include the requirement’s locations within
the document in the table.

Requirement keyword
Select this option to include the requirement’s requirement
keyword in the table.

Insert
Anything
into
Report?

Yes. Table.

Filename RptgenRMI.CReqTable
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Category Simulink Blocks

Description The Scope Snapshot component inserts images of Simulink scopes and
XY graphs. If the model has not been simulated, scopes are empty. For
more information, see Model Simulation.

Like other components, the Scope Snapshot component must conform to
the Report Generator component hierarchy. When building setup files
with the Scope Snapshot component, keep the following points in mind:

• If the Scope Snapshot has the Model Loop as its parent or if it does
not have any Simulink looping component as its parent, it includes
all XY graphs and scopes in the current model.

• If the Scope Snapshot has the System Loop as its parent, it includes
all XY graphs and scopes in the current system.

• If the Scope Snapshot has the Block Loop as its parent, it includes
the current block if it is an XY graph or scope.

• If the Scope Snapshot has the Signal Loop as its parent, it includes
all XY graphs and scopes connected to the current signal.

• If the Scope Snapshot does not have any of the Simulink looping
components as its parent, it includes all XY graphs and scopes in
all open models.

Attributes The following figure shows the Scope Snapshot Properties panel:
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Scope
Options

Report on closed scopes
Select this option to take a snapshot of all scopes in context. This
option forces closed scopes to open when the report is generating.

Autoscale time axis
Select this option to scale the Simulink scope’s time axis to include
the entire log.

Print
Options

Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic HG Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
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viewer can read. Automatic HG Format is the default option.
The options include

• Automatic HG Format (Uses the Simulink file format selected
in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed
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• Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper
orientation, or you can choose the Use figure orientation
option. See the orient command for information about paper
orientation.

Image size
Enter the size of the Handle Graphics figure snapshot in the
form [w h] (width/height). In the units text box, select Inches,
Centimeters, Points, or Normalized.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This
parameter inverts colors for printing; i.e., it changes dark colors
to light colors and vice versa.

Select one of the following options:

• Automatic — Select this option to automatically change dark
axes colors to a light axes color. If the axes color is a light color,
it is not inverted.

• Invert — Select this option to change dark axes colors to light
axes colors and vice versa.

• Don't invert — Select this option if you do not want to change
the colors in the image displayed on the screen for printing.

• Use figure's InvertHardcopy setting — Select this option
to use the InvertHardcopy property set in the Handle Graphics
image.

• Make figure background transparent — Select this option
to make the image background transparent.

Annotation Title
Select or enter a title for the snapshot figure.

• Block name — Use the block name as the title.
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• Full Simulink path name — Use the Simulink pathname
as the title.

• Custom — Enter a custom title.

Caption
Select or enter a short text description for the snapshot figure.

• No caption

• Automatic (use block description) — Use the Simulink
block’s description as the caption.

• Custom — Enter a short text description for the snapshot figure.

Insert
Anything
into
Report?

Yes. Image.

Filename rptgen_sl.csl_blk_scope
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Signal Loop

Category Simulink

Description The Signal Loop component runs its child components for each signal
contained in the current system, model, or block.

Attributes The following figure shows the Signal Loop Properties panel:
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Select
Signals

Include block input signals
Select this option to loop on signals that feed into blocks. This
option is valid when the Signal Loop component has a Block Loop
component as its parent.

Include block output signals
Select this option to loop on signals that leave the block. This
option is valid when the Signal Loop component has a Block Loop
component as its parent.

Include system input signals
Select this option to loop on signals coming from inports. This
option is valid when the Signal Loop component has a System
Loop component as its parent.

Include system internal signals
Select this option to loop on system internal signals. This option
is valid when the Signal Loop component has a System Loop
component as its parent.

Include system output signals
Select this option to loop on signals going to outports. This option
is valid when the Signal Loop component has a System Loop
component as its parent.

Sort signals
Use this section to select how the signals are sorted:

• Select Alphabetically by signal name to sort signals
alphabetically by name.

• Select Alphabetically by signal name (exclude empty)
to sort signals alphabetically by name as long as the signals
have names.

• Select Alphabetically by system name to sort by parent
systems. In this option, the systems are sorted alphabetically,
and signals in each system are listed, but in no particular order.

• Select By signal depth to sort signals by their depth in the
model.
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Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

When using the Signal Loop component, keep the following points in
mind:

• If the Signal Loop has the Model Loop as its parent, it loops on all
signals in the current model.

• If the Signal loop has the System Loop as its parent, it loops on all
signals in the current system. You can choose not to report on the
following types of signals by deselecting the corresponding option:

- System input signals

- System output signals

- System internal signals

• If the Signal Loop has another Signal Loop as a parent, it loops on
the current signal.

• If the Signal Loop has the Block Loop as a parent, it loops on all
signals connected to the current block. You can choose not to report on
the following types of signals by deselecting the corresponding option:

- Block input signals

- Block output signals

• If the Signal Loop does not have the Model Loop, System Loop,
Signal Loop, or Block Loop as its parent, it loops on all signals in all
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models. You can choose not to report on the following types of signals
by deselecting the corresponding option:

- Block input signals

- Block output signals

- System input signals

- System output signals

- System internal signals

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_sl.csl_sig_loop
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Category Simulink

Description The Simulink Automatic Table component inserts a two-column table
that contains details for the selected model, system, signal, or block into
a generated report.

Attributes The following figure shows the Simulink Automatic Table Properties
panel:

Options Show current
Choose the Simulink feature to include in the generated report:

• Automatic — Uses context of parent loop.

• Model

• System
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• Block

• Signal

Properties list
Choose whether to select the properties manually or automatically:

• Determine properties automatically — Uses blocks and
dialog properties.

• Show properties — Enter properties manually.

Show full path name
Select this option to show the full file pathname for the selected
Simulink model.

Display property names as prompts
Select this option to show property names as prompts in the
generated report. The report includes the dialog string instead of
the underlying code property.

Display
Options

Table title
Choose a title for the display in the generated report. To generate
a title automatically from the parameter, select Name, which uses
the object name as the title. To enter a title, select Custom. To
specify no title, select No title.

Header row
Use this option to select a header row for the table in the
generated report. To include no header row, select No header.
To include a header row with columns for name and object type,
select Type and Name. When selected, this option creates a
header row for the table with object name and type. To include a
custom header, select Custom.

Don’t display if value is empty
Select this option to exclude empty parameters in the generated
report.
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Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_auto_table
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Category The Simulink Dialog Snapshot component takes snapshots of Simulink
editor dialogs. You can display the current settings associated with an
object or document the appearance of your custom mask dialogs.

The Dialog Snapshot component reports on the current reported
Simulink object by context. If it is the child of a Block Loop, the current
reported Block’s dialog is documented. If it is the child of a System
Loop, the current reported System’s dialog is documented.

Attributes The following figure shows the Simulink Dialog Snapshot Properties
panel:

Format Image file format
Choose the format for the snapshot image file. The automatic
format chooses BMP format for PDF files and PNG for other
formats.
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Show all tabs
Select this check box if you want to automatically generate images
for all the tabs for the dialog. If the check box is not selected,
Report Generator creates an image of only the first tab.

Display
Options

Scaling
Select Fixed size to specify the number and type of units.

Select Zoom to specify the percentage, the maximum size, and
the units of measure.

Select Use image size if you want the image in your report to be
the same size as the image on the screen.

Size
Enter the exact size of the snapshot in the form w h (width height)
and press Enter. This field is active only if you choose Fixed size
in the Scaling drop-down list.

Max size
Enter the maximum size of the snapshot in the form w h (width
height) and press Enter. This field is active only if you choose
Zoom in the Scaling drop-down list.

Units
Enter the units for the size of the snapshot. This field is active
only if you choose Zoom or Fixed size in the Image size list box.

Alignment
Values are Auto, Right, Left, and Center.

Title
Type the text you want to appear above the snapshot.

Caption
Type the text you want to appear below the snapshot.
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Insert
Anything
into
Report?

Yes. Snapshot.

Filename rptgen_sl.CDialogSnapshot
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Simulink Functions and Variables

Category Simulink

Description The Simulink Functions and Variables component creates a table that
shows all workspace variables and MATLAB functions used by reported
blocks in a Simulink model. The current model and systems in which
the blocks appear are specified in the Model Loop component.

For example, a Simulink Gain block might have a string cos(x) instead
of a number. Simulink looks for a variable x in the workspace and uses
the cos function.

Attributes The following figure shows the Simulink Functions and Variables
Properties panel:
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Functions Include table of functions
Select this option to include a table of Simulink functions in the
generated report.

Table Title
Choose a title for the table in the generated report:

• Automatic — Select this option to generate a title automatically
from the parameter.

• Custom — Select this option to enter a title manually.

Parent block
Select this option to include a column in the table that includes
the name of the block, which contains the reported variable.

Calling string
Select this option to include the M-code that calls the reported
variable.

Include fixed-point functions (sfix, ufix, sint, ...)
Select this option to include fixed-point functions. If you use any
fixed-point functions in your model and want those functions to
appear in the generated report, select this option.

Variables Include table of variables
Select this option to include a table of Simulink variables in the
generated report.

Table title
Choose a title for the table in the generated report:

• Automatic — Select this option to generate a title automatically
from the parameter.

• Custom — Select this option to enter a title manually.

Include Workspace I/O parameters
Select this option to report on variables that contain parameters
with time vectors and state matrices. These parameters are set in
the Workspace I/O pane in the Simulation Parameters dialog
box in a Simulink model.
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In the following table, if any of the entries in the first column
are on, the component looks for the variable listed in the second
column in the workspace. If the component finds the variable, it
includes it in the report.

LoadExternalInput ExternalInput

SaveTime TimeSaveName

SaveState StateSaveName

SaveOutput OutputSaveName

LoadInitialState InitialState

SaveFinalState FinalStateName

Parent block
Select this option to include the name of the block that contains
the reported variable.

Calling string
Select this option to include the M-code that calls the reported
variable.

Size of variable
Select this option to include the size of the reported variable.

Memory size
Select this option to include the amount of memory in bytes that
the reported variable needs.

Class of variable
Select this option to include the variable class to which the
reported variable belongs.

Value in workspace
Select this option to include the actual value of the reported
variable. Note that very large arrays might be displayed as [MxN
CLASS]. For example, if you have a 300-by-200 double array, it
appears in the report as [300x200 DOUBLE].
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RTW storage class
Select this option to include the storage class of the reported
variable. The title of this column is Storage Class.

This option looks at the model’s TunableVars property to see
if any of the model variables specify their storage class. If the
storage class is specified, the model variables table displays
TunableVarsStorageClass and TunableVarsTypeQualifier in a
table column. The column entries are TunableVarsStorageClass
(TunableVarsTypeQualifier) if TunableVarsTypeQualifier is
not empty. If TunableVarsTypeQualifier is empty, the column
entry is TunableVarsStorageClass.

The values for TunableVarsStorageClass are

• Exported Global

• Auto

• ImportedExtern

• ImportedExtern Pointer

Data object properties
Enter data object properties to report on.

Example

This is an example of a table created by the Model Variables component.
This property table reports on the variables in the Controller in the
F14 demo model.

Variable
Name Parent Blocks

Calling
String Value

Ka f14/Controller/Gain3 Ka 0.677

Kf f14/Controller/Gain Kf -1.746
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Variable
Name Parent Blocks

Calling
String Value

Ki f14/Controller/Proportional
plus integral compensator

[Ki] -3.864

Kq f14/Controller/Gain2 Kq 0.8156

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_obj_fun_var
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Simulink Library Information

Category Simulink

Description The Simulink Library Information component inserts a table that lists
any library links in the currect model, system, or block.

Attributes The following figure shows the Simulink Library Information
Properties panel:

Table
Columns

Block
Select this option to include the Simulink block name in the
generated table.

Library
Select this option to include the Simulink library root name in
the generated table.
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Reference block
Select this option to include the Simulink reference block name
in the generated table.

Link status
Select this option to include the link status in the generated table.

Display
Options

Title
Enter a title for the display in the generated report.

Sort table by
To sort the table by block name, select Block. To sort the table
by library name, select Library. To sort the table by reference
block name, select Reference Block. To sort the table by link
status, select Link Status.

Merge repeated rows
Select this option to merge sorted rows in the generrated table.

Example

If you select the Merge repeated rows option, the generated table
will collapse identical rows into one. For example, the following table,
which is sorted on the Reference Block column, is generated from the
aero_guidance model without the option selected:

Block Library Reference Block Status

Equations
of Motion
(Body Axes)

Aerospace Equations of
Motion (Body
Axes)

resolved

Incidence &
Airspeed

Aerospace Incidence &
Airspeed

resolved

Fin Actuator Aerospace 2nd Order
Non-linear
Actuator

resolved
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Block Library Reference Block Status

3DoF
Animation

Aerospace 3DoF Animation resolved

Atmosphere Aerospace Atmosphere model resolved

Cm Simulink Interpolation (n-D)
using PreLookup

resolved

Cx Simulink Interpolation (n-D)
using PreLookup

resolved

Cz Simulink Interpolation (n-D)
using PreLookup

resolved

Kg Simulink Interpolation (n-D)
using PreLookup

resolved

Ki Simulink Interpolation (n-D)
using PreLookup

resolved

Alpha Index Simulink PreLookup Index
Search

resolved

Mach Index Simulink PreLookup Index
Search

resolved

Mach Index Simulink PreLookup Index
Search

resolved

|Alpha|
Index

Simulink PreLookup Index
Search

resolved

With the Merge repeated rows option selected, the generated table
collapses rows in the Block column so that each row in the Reference
Block column is unique:
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Block Library Reference Block Status

Equations
of Motion
(Body Axes)

Aerospace Equations of
Motion (Body
Axes)

resolved

Incidence &
Airspeed

Aerospace Incidence &
Airspeed

resolved

Fin Actuator Aerospace 2nd Order
Non-linear
Actuator

resolved

3DoF
Animation

Aerospace 3DoF Animation resolved

Atmosphere Aerospace Atmosphere
model

resolved

Cm

Cx

Cz

Kg

Ki

Simulink Interpolation
(n-D) using
PreLookup

resolved

Alpha Index

Mach Index

Mach Index

|Alpha|
Index

Simulink PreLookup Index
Search

resolved

Insert
Anything
Into
Report?

Yes. Table.
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Filename rptgen_sl.CLibinfo
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Simulink Linking Anchor

Category Simulink

Description The Simulink Linking Anchor component designates a location to which
other links point. This component should have the Model Loop, System
Loop, Block Loop, or Signal Loop component as its parent.

Attributes The following figure shows the Simulink Linking Anchor Properties
panel:

Insert text
If you want text to appear after the linking anchor, enter the text
in this field.

Link from current
This option sets the current model, system, block, or signal as
the linking anchor:
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• Select Automatic to select the appropriate model, system, block,
or signal as a linking anchor automatically. If the Model Loop
component is the parent component, the linking anchor is set
on the current model. Similarly, if the System Loop, Block Loop,
or Signal Loop is the parent component, the linking anchor is
inserted for the current system, block, or signal, respectively.

• Select Model to set the linking anchor to the current model.

• Select System to set the linking anchor to the current system.

• Select Block to set the linking anchor to the current block.

• Select Signal to set the linking anchor to the current signal.

Note You should not use the Simulink Linking Anchor
component to create an anchor for an object that has anchor
created elsewhere, such as a loop component or summary table
component. Each object should have only one anchor per report.
See the Simulink Summary Table component reference page.

Insert
Anything
into
Report?

Yes. A link, and possibly text, depending on attribute choices.

Filename rptgen_sl.csl_obj_anchor
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Category Simulink

Description The Simulink Name component inserts the name of a Simulink model,
system, block, or signal into the report.

You can use this component as the first child component of a
Chapter/Subsection component, which allows the current Simulink
model, system block, or signal name to be the chapter or section title.

Attributes The following figure shows the Simulink Name Properties panel:

Display name as
Select one of the options listed below to display the Simulink
object name in the report:

• Name — E.g., f14

• Type Name — E.g., Model f14
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• Type - Name — E.g., Model - f14

• Type: Name — E.g., Model: f14

Object types

• Select Automatic to automatically select the appropriate
model, system, block, or signal name as the Simulink object
name to include in the report. If the Model Loop component
is the immediate parent component, the object name is the
current model name. Similarly, if the System Loop, Block Loop,
or Signal Loop is the parent component, then the object name
is the name of the current system, block, or signal, respectively.

• Select Model to include the current model name in the report.

• Select System to include the current system name in the report.

• Select Block to include the current block name in the report.

• Select Signal to include the current signal name in the report.
If the signal name is empty, the signal <handle> is included in
the report. The signal handle is a unique numerical identifier
to that signal.

Show full path name
Select this option to show the full pathname for a system or block.
For example, if you choose this option for a block, the Simulink
block name appears as <Model Name>/<System Name>/<Block
Name>. Note that this option is not available for models and
signals.

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen_sl.csl_obj_name
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Category Simulink

Description The Simulink Property component inserts a single property
name/property value pair for the current Simulink model, system,
block, or signal.

Attributes The following figure shows the Simulink Property Properties panel:
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Simulink
Object
and
Parameter

Object type
Choose the Simulink object type to include in the report:

• System

• Model

• Block

• Signal

System parameter name
Enter a Simulink parameter name to include in the generated
report. If Model is selected in Object type, this option appears
as Model parameter name. If Block is selected in Object
type, this option appears as Block parameter name. If
Signal is selected in Object type, this option appears as Signal
parameter name.

Display
Options

Title
Choose a title for the display in the generated report. To use the
parameter name as the title, select Automatic. To enter a title,
select Custom. To specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated
report. Units are in pixels. When creating a table, the size limit is
the hypotenuse of the table width and height [sqrt(w^2+h^2)].
When creating text, the size limit is the number of characters
squared. If the size limit is exceeded, the variable is rendered in
condensed form, such as [64x64 double]. Setting a size limit of
zero will ignore the size limit and always display the variable, no
matter how large.

Display as
Choose a display style from the menu:

• Auto table/paragraph — Displays as a table or paragraph
based on the information.
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• Inline text — Displays as inline, which fits in line with the
surrounding text.

• Paragraph — Displays as a text paragraph.

• Table — Displays as a table.

Ignore if value is empty
Select this option to exclude the parameter from the generated
report if the parameter is empty.

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen_sl.csl_property
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Category Simulink

Description The Simulink Property Table component inserts a table that reports on
model-level property name/property value pairs.

Attributes The following figure shows the Simulink Property Table Properties
panel:

Select Object
Choose the object for the property table in the generated report:

• Model

• System

• Block
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• Signal

For more information about selecting object types in property
table components, see “Selecting Object Types” on page 4-24.

Table A preset table is a table that is already formatted and set up. You can
select a preset table in the preset table list in the upper left corner of
the attributes page. To apply a preset table, select the table and click
Apply.

Preset table
Choose a type of table to display the object property table:

• Defaults

• Callbacks

• Graphics

• Printing

• Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into
separate cells. To have the property name and property value
appear in adjacent horizontal cells in the table, select the Split
property/value cells check box. In this case, the table is in split
mode and there can be only one property name/property value
pair in a cell. If you have more than one name/property pair in a
cell, only the first pair is displayed in the report. All subsequent
pairs are ignored.

To have the property name and property value appear together
in one cell, deselect Split property/value cells. This is nonsplit
mode. In nonsplit mode, you can have more than one property
name/property value pair and you can also have text.

If you want to switch from nonsplit mode to split mode, make
sure that you only have one property name/property value pair
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per table cell before you switch modes. If you have more than
one property name/property value pair or any text, only the
first property name/property value pair appears in the report;
subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the
generated report.

Table Cells
Use this field to select table properties to modify. The selection in
this pane affects the available fields in the Cell Properties pane.

Cell
Properties

The visible options in the Cell Properties pane depend on the object
selected in the Table Cells pane. If %<Name> Information is selected,
only the Contents and Show options are displayed. If any other object
is selected in the Table Cells pane, the Alignment, Lower border,
and Right border options display.

Contents
Use this field to modify the contents of the table cell selected in
the Table Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell
in the Table Cells pane:

• Left

• Center

• Right

• Double justified

Show as
Choose the format for the contents of the table cell:

• Value

• Property Value
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• PROPERTY Value

• Property: Value

• PROPERTY: Value

• Property - Value

• PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the
generated report.

Right border
Select this option to display the right border of the table in the
generated report.

Creating Custom Tables

To create a custom table, you can first select a preset table and then
edit it. You might want to start with the Blank 4x4 preset table. You
can add and delete rows and you can add properties. To open the Edit
Table dialog box, click Edit. The dialog box appears:
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For more information about using this dialog box to create custom
property tables, see “Working with Property Table Components” on
page 4-13.

Note that if you do not have Real-Time Workshop®, Summary (req RTW)
is not listed in this list, because summary properties require Real-Time
Workshop. If you are using a setup file that contains a summary
property, the property name appears in the report, but the property
value does not.

Example

The table below is an example of a model property table. It is the
Simulation Parameters preset table. This property table is reporting
the F14 demo model.

Solver ode45 ZeroCross on StartTime 0.0
StopTime 60

RelTol 1e-4 AbsTol 1e-6 Refine 1
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InitialStep auto FixedStep auto MaxStep auto

LimitMaxRows off MaxRows 1000 Decimation 1

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_prop_table

8-185



Simulink Summary Table

Category Simulink

Description The Simulink Summary Table component shows properties or
parameters of the selected Simulink models, systems, blocks, or signals
in a table.

Attributes The following figure shows the Simulink Summary Table Properties
panel for a Block object:
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Object
type

Choose the object type to display in the generated report:

• Model

• System

• Signal
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• Block

The menu item selected in this menu affects the options available in the
Property Columns pane.

Table title Choose a title for the summary table in the generated report:

• Automatic — Select this option to generate a title automatically from
the parameter.

• Custom — Select this option to enter a title manually.

Property
Columns

The list in the left of the Property Columns pane displays the object
properties to be included in the summary table in the generated report.
To add a property, select the appropriate property level in the text box
on the left. Next, in the the text box on the right, select the property

that you want to add and click Add .

To delete a property, select the property name and press the Delete key.

Note The %<SplitDialogParameters> property is a unique property
that you can specify for Simulink summary tables where the object type
is Block. This property of the Simulink Summary Table component
generates multiple summary tables, grouped by block type. Each
summary table group contains the dialog parameters for that block.
Dialog parameters are the specific properties used by that block type
and are usually visible on the block’s editing dialog.

Relative
column
widths

Use this option to enter relative column widths for the summary table
in the generated report. Entered widths should be in percentages.
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Object
Rows

Insert anchor for each row
Select this option to insert an anchor for each row in the summary
table.

Report On

Automatic list from context
Select this option to report on all blocks in the current context.
The context is set by the parent of the Simulink Summary Table
component.

Custom - use block list
Select this option to report on a list of blocks that you specify, and
enter the block names in the corresponding field. You must use
the full pathname when specifying blocks. If you want to sort
the blocks in this list, select the Sort blocks in list option
and then select a sorting option from the Sort blocks list (in
the Loop Options section). Blocks are reported on in the order
that they are sorted. If you do not select this option, blocks are
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can
be a string or cell array. See “%<VariableName> Notation” on
page 8-253 in the Text component reference page for more details.

For example, if you want to report on the theta dot integrator
block and the theta integrator block in the demo model simppend,
you could enter the following in the block list.

simppend/theta dot

%<Z>

If you define Z in the workspace as the following,

Z={'simppend/theta'}
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then the Report Generator reports on the following blocks:

simppend/theta dot

simppend/theta

Loop
Options

You can choose block sorting options and reporting options in this pane.

Sort blocks

Use this option to select how the blocks are sorted:

• Select Alphabetically by block name to sort blocks
alphabetically by their names.

• Select Alphabetically by system name to sort systems
alphabetically.

In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.

• Select Alphabetically by full Simulink path to sort blocks
alphabetically by Simulink path.

• Select By block type to sort blocks alphabetically by block
type.

• Select By block depth to sort blocks by their depth in the
model.

• Select By traversal order to sort blocks by traversal order.

• Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs

• Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.
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Example

If you are reporting on the demo model F14, and you choose the
following options, the summary table shown below is generated:

• Sort on systems by system depth.

• Name and blocks are the system parameters to be included in the
table.

Name Blocks

f14 u, Actuator Model, Aircraft Dynamics Model,
Angle of Attack, Controller, Dryden Wind Gust
Models, Gain, Gain1, Gain2, Gain5, More Info,
More Info1, Nz pilot calculation, Pilot, Pilot G
force Scope, Stick Input, Sum, Sum1, alpha (rad),
Nz Pilot (g)

Aircraft
Dynamics Model

Elevator Deflection d (deg), Vertical Gust wGust
(ft/sec), Rotary Gust qGust (rad/sec), Gain3, Gain4,
Gain5, Gain6, Sum1, Sum2, Transfer Fcn.1,
Transfer Fcn.2, Vertical Velocity w (ft/sec), Pitch
Rate q (rad/sec)

Controller Stick Input (in), alpha (rad), q (rad/sec),
Alpha-sensor Low-pass Filter, Gain, Gain2, Gain3,
Pitch Rate Lead Filter, Proportional plus integral
compensator, Stick Prefilter, Sum, Sum1, Sum2,
Elevator Command (deg)

Dryden Wind
Gust Models

Band-Limited White Noise, Q-gust model, W-gust
model, Wg, Qg

More Info

More Info1

Nz pilot
calculation

w, q, Constant, Derivative, Derivative1, Gain1,
Gain2, Product, Sum1, Pilot g force (g)
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Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sl.csl_summ_table

8-192



State Loop

Category Stateflow

Description The State Loop component runs its children for all states in its context.
For example, if a State Loop component is parented by a Model Loop
component, the State Loop component’s context is the Model Loop. If
the State Loop has no context, it loops on all states in all open models.

When using the State Loop component, keep the following points in
mind:

• If the State Loop has the Model Loop as its parent, it includes all
states in the models.

• If the State Loop has the System Loop as its parent, it includes all
states in the systems.

• If the State Loop has the Machine Loop as its parent, it includes
all states in the machines.

• If the State Loop has the Chart Loop as its parent, it includes all
states in the charts.

• If the State Loop has another State Loop as its parent, it includes all
states in the current state. Use this context with a shallow loop.

Attributes The following figure shows the State Loop Properties panel:
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State
Types

Include “and” and “or” states
Select this option to include AND and OR states in the loop.

Include “box” states
Select this option to include “box” states in the loop.

Include functions
Select this option to include “function” states in the loop.

Include truth tables
Select this option to include truth tables in the loop.

Include embedded MATLAB functions
Select this option to include Embedded MATLAB functions in
the loop.
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Loop
Options

Report depth
Select the level on which to loop:

• All objects

• Local children only

Skip autogenerated charts under truth table
Select this option to keep autogenerated state objects under truth
tables from being displayed in the report.

Search states
Select this option to indicate specific states to include in the loop.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_sf.csf_state_loop
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Category Stateflow

Description The Stateflow Automatic Table component inserts a table that contains
the properties of the current Stateflow object as set in a Machine Loop
component, State Loop component, Chart Loop component, or Object
Loop component.

Attributes The following figure shows the Stateflow Automatic Table Properties
panel:

Display
Options

Table title
Use this option to select a title for the table in the generated
report. To include no title, select No title. To use a name as the
title, select Name. To include a custom title, select Custom.

If Name is selected, select one of the following options:
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• Object name

• Object name with Stateflow path

• Object name with Simulink and Stateflow path

Header row
Use this option to select a header row for the table in the
generated report. To include no header row, select No header.
To include a header row with columns for name and object type,
select Type and Name. When selected, this option creates a
header row for the table with object name and type. To include a
custom header, select Custom.

Don’t display empty values
Select this option to exclude empty values from the generated
report.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sf.csf_auto_table
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Category Stateflow

Description The Stateflow Count component counts the number of Stateflow objects
in the current context, such as system, model, signal, and so on. See the
Stateflow documentation for a description of Stateflow objects.

Attributes The following figure shows the Stateflow Count Properties panel:

Search depth
Choose the search depth for the count:

• All descendants — Searches all children of the Stateflow
object.
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• Immediate children only — Searches only children one level
below the Stateflow object.

Sort results
Choose the sort method for the count results:

• Numerically decreasing by object count

• Alphabetically increasing by object type

Include a list of objects in table
Select this option to insert a column containing the counted
objects.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sf.csf_count
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Category Stateflow

Description The Stateflow Dialog Snapshot component takes snapshots of Stateflow
editor dialogs. You can display the current settings associated with an
object or document the appearance of your custom mask dialogs.

The Stateflow Dialog Snapshot component reports on the current
reported Stateflow object. If the component is the child of a State Loop,
for example, the current reported State’s dialog is documented.

Attributes The following figure shows the Stateflow Dialog Snapshot Properties
panel:

Format Image file format
Choose the format for the snapshot image file. The automatic
format chooses BMP format for PDF files and PNG for other
formats.

8-200



Stateflow Dialog Snapshot

Show all tabs
Select this check box if you want to automatically generate images
for all the tabs for the dialog. If the check box is not selected,
Report Generator creates an image of only the first tab.

Display
Options

Scaling
Select Fixed size to specify the number and type of units.

Select Zoom to specify the percentage, the maximum size, and
the units of measure.

Select Use image size if you want the image in your report to be
the same size as the image on the screen.

Size
Enter the exact size of the snapshot in the form w h (width height)
and press Enter. This field is active only if you choose Fixed size
in the Scaling drop-down list.

Max size
Enter the maximum size of the snapshot in the form w h (width
height) and press Enter. This field is active only if you choose
Zoom in the Scaling drop-down list.

Units
Enter the units for the size of the snapshot. This field is active
only if you choose Zoom or Fixed size in the Image size list box.

Alignment
Values are Auto, Right, Left, and Center.

Title
Type the text you want to appear above the snapshot.

Caption
Type the text you want to appear below the snapshot.
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Insert
Anything
into
Report?

Yes. Snapshot.

Filename rptgen_sl.CDialogSnapshot
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Category Stateflow

Description The Stateflow Filter component is a filter that runs its children only if
the current object type (set by the parent Stateflow Hierarchy Loop
component) matches the selected object type. The Stateflow Filter
component must have the Stateflow Loop component as its parent.

Attributes The following figure shows the Stateflow Filter Properties panel:

Object type
Choose the Stateflow object type to include in the report. The
current object type (set by the parent State Loop) must match
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this selected object type in order for the current object to be
included in the report.

Run only if Stateflow object has at least the following number
of Stateflow children

Use this option to limit the number of Stateflow objects that is
reported on. If you enter a number in this field, a Stateflow object
is not included in the report unless it has at least that number
of children.

Automatically insert linking anchor
Select this option to insert a linking anchor before the reported
object. If an anchor for this object already exists (inserted by the
Stateflow Linking Anchor component), a second anchor is not
created.

Insert
Anything
into
Report?

No.

Filename rptgen_sf.csf_obj_filter
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Category Stateflow

Description The Stateflow Hierarchy component inserts a tree representation that
describes the Stateflow object’s hierarchy.

Attributes The following figure shows the Stateflow Hierarchy Properties panel:

Tree
Options

Construct tree from
Select the object to use for the tree representation.

• Current object

• Root of current object — Starts from the top of the
hierarchy.
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Emphasize current object in tree
Select this option to highlight the current object in the tree
representation.

Show number of parents
Enter the number of parents to allow in the tree representation.

Show siblings
Select this option to display siblings in the tree represenation.

Show children to depth
Enter the depth of children to display for each object in the tree
representation.

Children Show junctions
Select the level of junction detail to display in the generated
report.

• All

• Non-redundant

• None

Show transitions
Select the level of transition detail to display in the generated
report.

• All

• Labeled or non-redundant

• Non-redundant

• Labeled

• None

Skip autogenerated charts under truth tables
Select this option to not include autogenerated charts beneath
truth tables.
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List
Formatting

List style
Select either Bulleted list or Numbered list. If you choose
Numbered list, you can select numbering options in the
Numbering style section.

Numbering style
Select a numbering style from the menu.

• 1,2,3,4...

• a,b,c,d...

• A,B,C,D...

• i,ii,iii,iv...

• I,II,III,IV...

To show the parent number in each list entry, select Show parent
number in nested list (1.1.a). To show only the current
number or letter, select Show only current list value (a).

Insert
Anything
into
Report?

Yes. Tree.

Filename rptgen_sf.csf_hier
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Category Stateflow

Description The Stateflow Hierarchy Loop component runs its child components
on the Stateflow object hierarchy.

Attributes The following figure shows the Stateflow Hierarchy Loop Properties
panel:

Loop
Options

Minimum legible font size
Enter the minimum font size to use in the report. The default font
size, 8, is the smallest recommended font size.

Skip autogenerated charts under truth tables
Select this option to exclude autogenerated charts under truth
tables in the report.
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Search Stateflow
Select this option to report only on Stateflow charts with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

No.

Filename rptgen_sf.csf_hier_loop
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Category Stateflow

Description The Stateflow Linking Anchor component designates a location to which
other links point. The linking anchor is set to the current object, which
is defined by the parent component. This component must have the
Chart Loop, State Loop, Machine Loop, Terminal Loop, or Stateflow
Filter component as its parent.

Attributes The following figure shows the Stateflow Linking Anchor Properties
panel:

Insert text
If you want text to appear after the linking anchor, enter the text
in this field.
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Note You should not use the Stateflow Linking Anchor
component to create an anchor for an object that is anchored in
the object summary table. See the Simulink Summary Table
component reference page.

Insert
Anything
into
Report?

Yes. A link, and possibly text, depending on attribute choices.

Filename rptgen_sf.csf_obj_anchor
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Category Stateflow

Description The Stateflow Name component inserts the name of the Stateflow object
specified by its parent component into the report. This component must
have the State Loop, Chart Loop, or Stateflow Filter component as
its parent.

You can use this component as the first child component of a
Chapter/Subsection component, which allows the current Stateflow
object name to be the chapter or section title.

Attributes The following figure shows the Stateflow Name Properties panel:

Display name as
Select one of the options listed below to display the Stateflow
object name in the report:
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• Name — E.g., Object

• Type Name — E.g., Object <ObjectName>

• Type - Name — E.g., Object - <ObjectName>

• Type: Name — E.g., Object: <ObjectName>

Display name as
Select one of the options listed below to display the Stateflow
object name in the report:

• Object name

• Object name with Stateflow path

• Object name with Simulink and Stateflow path

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen_sf.csf_obj_name
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Category Stateflow

Description The Stateflow Object Loop component runs its child components for
each Stateflow object. The component inserts a table into the generated
report.

Attributes The following figure shows the Stateflow Object Loop Properties
panel:

Object
Types

Report on “Data” objects
Select this option to include Stateflow data objects in the loop.

Report on “Event” objects
Select this option to include Stateflow event objects in the loop.
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Report on “Transition” objects
Select this option to include Stateflow transition objects in the
loop.

Report on “Junction” objects
Select this option to include Stateflow junction objects in the loop.

Report on “Target” objects
Select this option to include Stateflow target objects in the loop.

Report on “Note” objects
Select this option to include Stateflow note objects in the loop.

Loop
Options

Report depth
Select the level on which to loop.

• All objects — Reports on all Stateflow objects.

• Local children only — Reports only on children one level
down.

Skip autogenerated charts under truth tables
Select this option to exclude autogenerated charts under truth
tables from the report.

Remove objects which do not contain more information than a snapshot
Select this option to exclude objects that only contain a snapshot.
Other information can include a document link or a description.

Search Stateflow
Select this option to report only on Stateflow charts with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.
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Create link anchor for each object in loop
Select this option to create a hyperlink to the Stateflow object
in the generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_sf.csf_obj_loop
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Category Stateflow

Description The Stateflow Property component inserts a table, text, or paragraph
that contains details of the selected Stateflow object property.

Attributes The following figure shows the Stateflow Property Properties panel:

Property
to Display

Property name
Enter the Stateflow property name to display.

Display
Options

Title
Choose a title for the display in the generated report. To use the
parameter name as the title, select Automatic. To enter a title,
select Custom. To specify no title, select None.
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Size limit
Use this size to limit the width of the display in the generated
report. Units are in pixels. When creating a table, the size limit is
the hypotenuse of the table width and height [sqrt(w^2+h^2)].
When creating text, the size limit is the number of characters
squared. If the size limit is exceeded, the variable is rendered in
condensed form, such as [64x64 double]. Setting a size limit of
zero will ignore the size limit and always display the variable, no
matter how large.

Display as
Choose a display style from the menu:

• Auto table/paragraph — Displays as a table or paragraph
based on the information.

• Inline text — Displays as inline, which fits in line with the
surrounding text.

• Paragraph — Displays as a text paragraph.

• Table — Displays as a table.

Ignore if value is empty
Select this option to exclude empty parameters in the generated
report.

Insert
Anything
into
Report?

Yes. Text, paragraph, or table.

Filename rptgen_sf.csf_property
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Category Stateflow

Description The Stateflow Property Table component inserts a property-value
table for a Stateflow object into the report. This object is defined
by the Stateflow Filter component, which must be the parent of
the Stateflow Property Table. For more information about working
with property table components, see “Working with Property Table
Components” on page 4-13.

Attributes The following figure shows the Stateflow Property Table Properties
panel:

Table A preset table is a table that is already formatted and set up. You can
select a preset table in the preset table list in the upper left corner of
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the attributes page. To apply a preset table, select the table and click
Apply.

Preset table
Choose a type of table to display the object property table:

• Defaults

• Callbacks

• Graphics

• Printing

• Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into
separate cells. To have the property name and property value
appear in adjacent horizontal cells in the table, select the Split
property/value cells check box. In this case, the table is in split
mode and there can be only one property name/property value
pair in a cell. If you have more than one name/property pair in a
cell, only the first pair is displayed in the report. All subsequent
pairs are ignored.

To have the property name and property value appear together in
one cell, deselect the Split property/value cells. This is nonsplit
mode. In nonsplit mode, you can have more than one property
name/property value pair and you can also have text.

If you want to switch from nonsplit mode to split mode, make
sure that you have only one property name/property value pair
per table cell before you switch modes. If you have more than
one property name/property value pair or any text, only the
first property name/property value pair appears in the report;
subsequent pairs and text are omitted.
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Display outer border
Select this option to display the outer border of the table in the
generated report.

Table Cells
Use this field to select table properties to modify. The selection in
this pane affects the available fields in the Cell Properties pane.

Title
Properties

The visible options in the Title Properties pane depend on the object
selected in the Table Cells pane. If %<Name> is selected, only the
Contents and Show options is displayed. If any other object is selected
in the Table Cells pane, the Alignment, Lower border, and Right
border options is displayed.

Contents
Use this field to modify the contents of the table cell selected in
the Table Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell
in the Table Cells pane:

• Left

• Center

• Right

• Double justified

Show as
Choose the format for the contents of the table cell:

• Value

• Property Value

• PROPERTY Value

• Property: Value

• PROPERTY: Value
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• Property - Value

• PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the
generated report.

Right border
Select this option to display the right border of the table in the
generated report.

Creating Custom Tables

To create a custom table, you can first select a preset table and then
edit it. You might want to start with the Blank 4x4 preset table. You
can add and delete rows and you can add properties. To open the Edit
Table dialog box, click Edit. The dialog box appears:

For more information about using this dialog box to create custom
property tables, see “Working with Property Table Components” on
page 4-13.
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Note that available properties and preset tables depend on the
Stateflow Filter parent component.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sf.csf_prop_table
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Category Stateflow

Description The Stateflow Snapshot component inserts a snapshot of a Stateflow
object (defined by the Stateflow Filter component) into the report.
The Stateflow Snapshot component must have the Stateflow Filter
component as its parent.

This component only executes if the selected object in the Stateflow
Filter component is a graphical object. The following are graphical
Stateflow objects:

• Chart

• State

• Transition

• Frame

Attributes The following figure shows the Stateflow Snapshot Properties panel:

8-224



Stateflow Snapshot

Image Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic SF Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
viewer can read. Automatic SF Format is the default option.
The options include

• Automatic SF Format (uses the Handle Graphics file format
selected in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)
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• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed

• Windows metafile

Size menu
Choose the aspect ratio for the snapshot in the generated report:

• Custom (maintain aspect ratio)

• Shrink image to minimum font size set in Stateflow
Loop
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Maximum size
Enter the maximum size for the snapshot in the generated report
in the selected units. Use [width height] format. In the units
text box, select Inches, Centimeters, Points, or Normalized.

Properties Include callouts to describe visible objects
Select this option to display descriptive callouts for visible objects.

Insert anchors for transitions and junctions
Select this option to insert anchors for transitions and junctions
into the report.

• None

• Redundant children only

• All

Run only if Stateflow object has at least the following number
of children

To run this component only when the current Stateflow object
has at least a certain number of children, enter that number
in this field. The current Stateflow object is specified by the
Stateflow Filter component. This option is not active unless
the selected object in the Stateflow Filter (the parent component)
is a graphical object.

This option lets you decrease the size of the report by excluding
certain images. You might want to use this option when you have
a large model.

Image title
Choose No title, Object name, Object name (full Stateflow
path), Object name (full Simulink and Stateflow path), or
Custom to specify whether or not you want a title for the image.
The default is no title. If you choose Custom, you need to type
in the title you want to appear.
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Insert
Anything
into
Report?

Yes. Image.

Filename rptgen_sf.csf_obj_snap
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Category Stateflow

Description The Stateflow Summary Table component shows properties or
parameters of the selected Stateflow objects in a table. The Stateflow
Summary Table component can have the following parents:

• Any Stateflow looping component, except Terminal Loop

• Any Simulink looping component (Model Loop, System Loop, Block
Loop, or Signal Loop)

Attributes The following figure shows the Stateflow Summary Table Properties
panel:
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Object type
Choose the object type to display in the generated report. The
menu item selected in this menu affects the options available in
the Property Columns pane.

Table title
Choose a title for the summary table in the generated report:

• Automatic — Select this option to generate a title automatically
from the parameter.

• Custom — Select this option to enter a title manually.
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Property
Columns

Property columns
This figure displays the object properties to be included in the
summary table in the generated report. To add a property, select
the appropriate property level in the text box. Next, in the
contextual list below the text box, select the property that you

want to add and click Add . To delete a property, select the
property name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary
table in the generated report. Entered widths should be in
percentages.

Object
Rows

Insert anchor for each row
Select this option to insert an anchor for each row in the summary
table.

Report On Automatic list from context
Select this option to report on all blocks in the current context.
The context is set by the Stateflow Summary Table component’s
parent component.

Custom - use block list
Select this option to report on a list of blocks that you specify and
enter the block names in the corresponding field. You must use
the full pathname when specifying blocks. If you want to sort
the blocks in this list, select the Sort blocks in list option
and then select a sorting option from the Sort blocks list (in
the Loop Options section). Blocks are reported on in the order
that they are sorted. If you do not select this option, blocks are
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can
be a string or cell array. See “%<VariableName> Notation” on
page 8-253 in the Text component reference page for more details.
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For example, if you want to report on the theta dot integrator
block and the theta integrator block in the demo model simppend,
you could enter the following in the block list.

simppend/theta dot

%<Z>

If you define Z in the workspace as the following,

Z={'simppend/theta'}

the Report Generator reports on the following blocks:

simppend/theta dot

simppend/theta

Loop
Options

You can choose block sorting options and reporting options in this pane.

Sort blocks

Use this option to select how the blocks are sorted:

• Select Alphabetically by block name to sort blocks
alphabetically by their names.

• Select Alphabetically by system name to sort systems
alphabetically.

In this option, the systems are sorted alphabetically, and blocks
in each system are listed, but in no particular order.

• Select Alphabetically by full Simulink path to sort blocks
alphabetically by Simulink path.

• Select By block type to sort blocks alphabetically by block
type.
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• Select By block depth to sort blocks by their depth in the
model.

• Select By traversal order to sort blocks by traversal order.

• Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Search Stateflow
Select this option to report only on Stateflow charts with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen_sf.csf_summ_table
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Stop Report Generation

Category Report Generator

Description The Stop Report Generation component halts report generation. This
component acts like Stop during report generation.

You can use this component inside an if/then statement by using
Logical and Flow Control components to halt the report generation
process under a certain condition. Note that when report generation is
halted, the XML source file is produced, but not converted.

Attributes The following figure shows the Stop Report Generation Properties
panel:
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Confirmation
Properties

Confirm before stopping generation
Select this option to generate a confirmation dialog box before
stopping report generation.

Confirmation question
Enter a confirmation question for the prompt.

Halt button name
Enter a name for the button that stops report generation.

Continue button name
Enter a name for the button that continues report generation.

Example

The setup file in this example creates a simple report that takes a
snapshot of the current figure. If there is no current figure, the report
generation automatically halts.

[-] Report - figure-report.rpt
[-] if (isempty(get(0,'CurrentFigure')))
[ ] Stop Generation

[-] Figure Loop - current
[-] Chapter - <Title from SubComponent1>
[ ] Figure Name
[ ] Graphics Figure Snapshot
[ ] Figure Prop Table - Figure Properties

Insert
Anything
into
Report?

No.

Filename rptgen.crg_halt_gen
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Category Simulink

Description The System Filter component runs child components only if the current
systems meets the conditions specified in the attribute page.

Attributes The following figure shows the System Filter Properties panel:

Report only if system has at least N blocks
Enter a number to execute child components only if there are at
least the specified number of blocks in the system. Note that if
you enter 0, there is no filtering; child components are executed
regardless of the number of blocks in the system.
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Report only if system has at least N subsystems
Enter a number to execute child components only if there are at
least the specified number of subsystems in the system. Note that
if you enter 0, there is no filtering; child components are executed
regardless of the number of subsystems in the system.

Report only if system mask type is
Choose what masks to include in the generated report:

• Either masked or unmasked

• Masked

• Unmasked

Insert
Anything
into
Report?

No.

Filename rptgen_sf.csf_obj_filter

8-237



System Hierarchy

Category Simulink

Description The System Hierarchy component creates a nested list that shows the
hierarchy of the system specified in the attribute page. The list can
display all systems in a model or it can show the parents and children of
the current system.

Attributes The following figure shows the System Hierarchy Properties panel:

Starting
System

Build list from
Select the system or model from which the list will be built.

• Current system

• Current model
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Emphasize current system
Select this option to highlight the current system or model in the
generated report.

Display
Systems

Show number of parents
Enter the number of parents to list.

Display peers of current system
Select this option to show the current system’s peers in the
generated report.

Show children to depth
Enter the depth of children to list.

List
Formatting

List style
Select either Bulleted list or Numbered list. If you choose
Numbered list, you can select numbering options in the
Numbering style section.

Numbering style
Select a numbering style in this drop-down menu if you selected
Numbered List for the List style. The options are

• 1,2,3,4,...

• a,b,c,d,...

• A,B,C,D,...

• i,ii,iii,iv,...

• I,II,III,IV,...

Insert
Anything
into
Report?

Yes. List.

Filename rptgen_sl.csl_sys_list
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System Loop

Category Simulink

Description The System Loop component runs its child components for each system
defined by the Model Loop. The System Loop component must have the
Model Loop component as its parent.

Attributes The following figure shows the System Loop Properties panel:
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Report On Loop on Systems

Select systems automatically
Select the Select systems automatically option to report on all
systems in the current context. The context is set by the System
Loop component’s parent component:

• If the parent component is the Model Loop, selecting this
option causes the System Loop component to report on systems
in the current model.

• If the parent component is another System Loop, selecting
this option causes the System Loop component to report on
the current system.

• If the parent component is the Signal Loop, selecting this
option causes the System Loop component to report on the
current signal’s parent system.

• If the parent component is the Block Loop, selecting this
option causes the System Loop component to report on the
current block’s parent system.

• If the System Loop does not have the Model Loop, System
Loop, Signal Loop, or Block Loop component as its parent,
selecting this option causes the System Loop component to
report on all systems in all models.

Custom - use system list
Select this option to report on a list of systems that you specify,
and enter the system names in the corresponding field. You must
use the full pathname when specifying systems. If you want to
sort the systems in this list, select the Sort systems in list option
and then select a sorting option from the Sort Systems option (in
the Loop Options section). Systems are reported on in the order
that they are sorted. If you do not select this option, systems are
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of
a variable from the MATLAB workspace. The %<> notation can be
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a string or cell array. See “%<VariableName> Notation” on page
8-253 in the Text component reference page for more details.

For example, if you want to report on the Controller system and
the Nz pilot calculation system in the demo model f14, you
could enter the following in the block list:

f14/Nz pilot calculation

%<Z>

If you define Z in the workspace as the following,

Z={'f14/Controller'}

the Report Generator reports on the following systems.

f14/Nz pilot calculation

f14/Controller

Loop
Options

Sort Systems
Use this section to select how the systems are sorted:

• Select By number of blocks in system to sort systems by
the number of blocks in the system. The list shows systems by
decreasing number of blocks; i.e., the system with the largest
number of blocks is listed first.

• Select Alphabetically by system name to sort systems
alphabetically by name.

• Select By traversal order to sort systems in the order they
are traversed.

• Select By system depth to sort systems by their depth in the
model.
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Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain
property name/property value pairs. Enter the property name and
the property value in the appropriate fields.

Section
Options

Create section for each object in loop
Select this option to insert a section in the generated report for
each object found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the
section title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the
generated report.

Insert
Anything
into
Report?

Yes, section, if the Create section for each object in loop option
is selected.

Filename rptgen_sl.csl_sys_loop
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System Snapshot

Category Simulink

Description The System Snapshot component inserts a snapshot of the current
system in your report.

Attributes The following figure shows the System Snapshot Properties panel:

Snapshot Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic SL Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
viewer can read. Automatic SL Format is the default option.
The options include
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• Automatic SL Format (uses the Handle Graphics file format
selected in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed

• Windows metafile
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Paper orientation
You can choose Largest dimension vertical, Landscape,
Portrait, or Use system orientation as the paper orientation.

The Use system orientation option uses the PaperOrientation
parameter in Simulink, which you can set as Landscape,
Portrait, or Rotated.

Image Size
Select Automatic to automatically scale the image to output
dimensions. Select Custom to specify image size. The default for
this field is Automatic. Note that if Use printframe is selected,
the Custom option is deactivated and the image is automatically
scaled to the print frame size.

Use printframe
Choose this option to print a frame around the image. You can use
the default Report Generator frame, rptdefaultframe.fig , or
you can use the Frame Editor to build a custom frame.

To build a custom frame, type frameedit at the command line to
invoke the Print Frame Editor. For help with the Print Frame
Editor, select Print Frame Editor Help from the Help menu.
See frameedit in the MATLAB reference pages for a discussion of
the frameedit command.

The default Report Generator frame is five inches wide and four
inches high. It includes the name of the system and the model
directory. This frame is optimized for use with a portrait paper
orientation. The Aircraft Dynamics Model in the f14 Simulink
demo model is shown below with the default Report Generator
frame option.
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Display
Options

Scaling
Select Fixed size to specify the number and type of units.

Select Zoom to specify the percentage, the maximum size, and
the units of measure.

Select Use image size if you want the image in your report to be
the same size as the image on the screen.

Size
Enter the exact size of the snapshot in the form w h (width height)
and press Enter. This field is active only if you choose Fixed size
in the Scaling drop-down list.

Max size
Enter the maximum size of the snapshot in the form w h (width
height) and press Enter. This field is active only if you choose
Zoom in the Scaling drop-down list.

8-247



System Snapshot

Units
Enter the units for the size of the snapshot. This field is active
only if you choose Zoom or Fixed size in the Image size list box.

Alignment
Values are Auto, Right, Left, and Center.

Image title
Choose No title, System name, System name (full path), or
Custom to specify whether or not you want a title for the image.
The default is no title. If you choose Custom, you need to type
in the title you want to appear.

Caption
Choose None, Description (use system description), or
Custom to specify whether or not you want a caption for the image.
The default is no caption. If you choose Custom, you need to type
in the caption you want to appear.

Insert
Anything
into
Report?

Yes. Image.

Filename rptgen_sl.csl_sys_snap
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Table

Category Formatting

Description The Table component converts a rectangular cell array into a table and
inserts the table into the report.

Attributes The following figure shows the Table Properties panel.

Table
Content

Workspace variable name
Enter the workspace variable name with which to construct the
table.

Collapse large cells to a single description
Select this option to consolidate large cells into one description.
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Formatting
Options

Table title
Enter the title of your table. If you have a title for a table, it is
included in the list of tables if the stylesheet you chose in the
Report Options attribute page supports it. To find stylesheets that
have a list of tables, see “Setting the Report Format” on page 2-3

Cell alignment
Select a cell alignment option (left, center, right, or double
justified).

Column widths
Input a vector with m elements where m equals the number of
columns in the table. Column sizing is relative and normalized to
page width. For example, if you have a 2-by-3 cell array and input
the following into the Column widths field,

[1 2 3]

the report output format for the cell array would be the second
column is twice the width of the first column and the third column
is three times the width of the first column. Note that if the vector
is greater than the number of columns in the table, the vector is
truncated so that the number of elements equals the number of
columns. If m is less than the number of columns in the table, the
vector is padded with 1’s so that the number of elements equals
the number of columns.

Table grid lines
Select this option if you want to have grid lines in your table. Grid
lines create borders between the fields.

Table spans page width
Select this option if you want the table to have the same width as
the page on which it appears.
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Header/Footer
Options

Designating a row as a header or footer row causes the contents of the
row to be displayed in boldface.

Number of header rows
Enter the number of header rows (from the top): 0 = none, 1 = 1
row from the top, 2 = two rows from the top, etc.

Footer list
If you do not want a footer, select No footer. If you want to select
a footer that is different from your header, select Last N rows of
cell array are footer and enter the number of footer rows
(from the bottom) in the corresponding field: 0 = none, 1 = one row
from the bottom, 2 = two rows from the bottom, etc.

Example

For example, if you have the following cell array in the MATLAB
workspace,

{'foo','bar';[3],[5]}

the resulting cell table has the following appearance.

foo bar

3 5

Note that the table has no headers or footers and no title. The table
does have grid lines.

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen.cfr_table
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Text

Category Formatting

Description The Text component formats text and inserts it into your report. The
text component should have the Paragraph component as its parent.

Attributes The following figure shows the Text Properties panel:

Text to include in report
Enter the text you want to include in your report in this field.

Show text as syntax-highlighted M-code
Select this option to display text as highlighted M-code.

Emphasize text
If you want to have the text appear italicized in the report, select
this option.
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Retain spaces and carriage returns
If you want to keep spaces and carriage returns in your text,
select this option. If you do not select this option, the text still
inserts one space any time you have one or more spaces; it does
not keep any carriage returns.

%<VariableName> Notation

You can enter %<VariableName> in this field (and in any field where
the text appears blue) to include the value of a variable from the base
MATLAB workspace. You cannot enter more than one variable in the
%<>. If you enter an invalid variable name, the report will contain
%<VariableName> instead of the value of the variable.

Example 1

If you enter the following,

I have a %<ObjName> and it has %<NumLeaves> leaves. The word
'%<ObjName>' has %<size(ObjName)> letters.

and if ObjName = "plant" and NumLeaves = 3 in the MATLAB
workspace, the report contains the following.

I have a plant and it has 3 leaves. The word 'plant' has 5 letters.

Example 2

If you enter the following,

%<help('peaks')>

the report contains the text that you get when you type help peaks at
the command line.

Insert
Anything
into
Report?

Yes. Text.
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Filename rptgen.cfr_text
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Time/Date Stamp

Category Report Generator

Description The Time/Date Stamp component inserts the time and date of the
report generation into your report as text. It must have the Paragraph
or Chapter/Subsection component as its parent.

Attributes The following figure shows the Time/Date Stamp Properties panel:

Prefix Include text before stamp
Select this option to include text before the time/date stamp, and
enter the text in the corresponding field.
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Time
Stamp
Properties

Include current time in stamp
Select this option to insert the current time in the time/date
stamp.

Time display
Use this option to select the appearance of the time display. The
following options are available:

• 12-hour

• 24-hour

Time Separator
Use this option to select a separation marker between hours,
minutes, and seconds. The following options are available for the
separator:

• Blank space ( ) - E.g., Hour Minute Second

• Colon (:) - E.g., Hour:Minute:Second

• Period (.) - E.g., Hour.Minute.Second

• None () - E.g., HourMinuteSecond

Include seconds in time stamp
Select this option to display seconds in the time/date stamp.

Date
Stamp
Properties

Include current date in stamp
Select this option to insert the current date in the time/date stamp.

Date order
Use this option to select the order in which the day, month, and
year should appear. The following options are available for this
order:

• Day Month Year

• Month Day Year

• Year Month Day
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Date separator
Use this option to select a separation marker between day, month,
and year. The following options are available for the separator:

• Blank space ( ) — E.g., Day Month Year

• Colon (:) — E.g., Day:Month:Year

• Slash (/) — E.g., Day/Month/Year

• Period (.) — E.g., Day.Month.Year

• None () — E.g., DayMonthYear

Month display
Use this option to select the appearance of the month display. The
following options are available for the display:

• Long (December)

• Short (Dec)

• Numeric (12)

Year display
Use this option to select the appearance of the year display. The
following options are available for the display:

• Long (1998)

• Short (98)

Preview This pane displays the time/date stamp as it will appear in the report.

Insert
Anything
into
Report?

Yes. Text.

Filename rptgen.crg_tds
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Title Page

Category Formatting

Description The Title Page component creates and inserts a title page at the
beginning of the report. The Title Page component can be used as a
child component to a Chapter/Subsection component, or it can be used
alone in a setup file.

Attributes The following figure shows the Title Page Properties panel:

All the text fields in this attribute page can contain the
%<VariableName> notation. See “%<VariableName> Notation” on page
8-253 in the Text component reference page.
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Title Title
Enter the title of the report in this field. The title will appear
in a large font.

Subtitle
Enter the subtitle in this field. The subtitle will appear under the
title, in a smaller font than the title.

Options Image file name
Enter the filename for an image you want to appear on the title
page. The image will appear under the subtitle.

Author
Enter the author in this field. The author will appear under the
subtitle, in a smaller font than the subtitle.

Include report creation date
Select this option if you want to include the report creation date,
and choose the date format in the corresponding list.

Include copyright holder and date
Select this option to include copyright holder and year information.

Abstract
Enter the abstract for the report in this field. This is optional.

Legal notice
Enter the legal notice for the report in this field. This is optional.

Insert
Anything
into
Report?

Yes. Title page.

Filename rptgen.cfr_titlepage
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To Workspace Plot

Category Simulink Blocks

Description The To Workspace Plot component captures a plot figure created in the
MATLAB workspace. This component inserts a figure and/or table into
the report; the table contains input and output numeric values, and
the figure is a plot of the values.

Attributes The following figure shows the To Workspace Plot Properties panel:

Print
Options

Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list.
Select Automatic HG Format to automatically choose the format
best suited for the output format that you chose in the Report
component. Otherwise, choose an image format that your output
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viewer can read. Automatic HG Format is the default option.
The options include

• Automatic HG Format (Uses the Simulink file format selected
in the Preferences dialog box)

• Adobe Illustrator

• Bitmap (16m-color)

• Bitmap (256-color)

• Black and white encapsulated PostScript

• Black and white encapsulated PostScript (TIFF)

• Black and white encapsulated PostScript2

• Black and white encapsulated PostScript2 (TIFF)

• Black and white PostScript

• Black and white PostScript2

• Color encapsulated PostScript

• Color encapsulated PostScript (TIFF)

• Color encapsulated PostScript2

• Color encapsulated PostScript2 (TIFF)

• Color PostScript

• Color PostScript2

• JPEG high quality image

• JPEG medium quality image

• JPEG low quality image

• PNG 24-bit image

• TIFF - compressed

• TIFF - uncompressed
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• Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper
orientation, or you can choose the Use figure orientation
option. See the orient command for information about paper
orientation.

Image size
Select Use figure PaperPositionMode setting to use the
PaperPositionMode property of the Handle Graphics figure to
set the image size in the report. See the orient command for
information about paper position mode.

Select the Automatic (same size as on screen) option if you
want the image in your report to be the same size as the image
on the screen.

Select the Custom option to choose a custom image size. If you
choose this option, specify the image size in the size and unit
fields.

• Size: Enter the size of the Handle Graphics figure snapshot in
the form wxh (width times height). This field is active only if
you choose Custom in the Image size list box.

• Units: Enter the units for the size of the Handle Graphics
figure snapshot. This field is active only if you choose Set
image size in the Custom list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This
parameter inverts colors for printing; i.e., it changes dark colors
to light colors and vice versa.

Select one of the following options:

• Automatic — Select this option to automatically change dark
axes colors to a light axes color. If the axes color is a light color,
it is not inverted.
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• Invert — Select this option to change dark axes colors to light
axes colors and vice versa.

• Don't invert — Select this option if you do not want to change
the colors in the image displayed on the screen for printing.

• Use figure's InvertHardcopy setting — Select this option
to use the InvertHardcopy property set in the Handle Graphics
image.

• Make figure background transparent — Select this option
to make the image background transparent.

Annotation Figure Title
Choose a title option in this section:

• No title — Select this option if you do not want an image title.

• Use block name — Select this option to use the selected block
name as the plot title.

• Use variable/file name — Select this option to use the
selected variable or file name as the plot title.

• Custom — Select this option and enter your own title.

Caption
Enter a short text description for the snapshot figure.

Insert
Anything
into
Report?

Yes. Figure.

Filename rptgen_sl.csl_blk_toworkspace
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Truth Table

Category Stateflow

Description The Truth Table component reports on the truth tables in Simulink and
Stateflow models. The component displays both the condition table and
the action table. This component is context sensitive.

If the Truth Table component has the Simulink Model Loop as its
parent, it reports on all truth tables in the current model.

If it has the Simulink System Loop as its parent, it reports on all truth
tables in the current system.

If it has the Simulink Block Loop as its parent, it reports on all truth
tables in the current block.

If it has the Simulink Signal Loop as its parent, it reports on all truth
tables in the current signal.

If it has a Stateflow component, such as Stateflow Filter, Machine Loop,
or State Loop, as its parent, it reports on all truth tables in the current
object type specified by the Stateflow component.

Attributes The following figure shows the Truth Table Properties panel:
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Truth Table

Title Title
Choose the title for the truth table:

• No title

• Use Stateflow name

• Custom

Condition
Table

Specify the display of the condition table:

Show header
Select this option to display the column headers in the table.
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Truth Table

Show number
Select this option to display the condition number column in the
table.

Show condition
Select this option to display the condition column in the table.

Show description
Select this option to display the description column in the table.

Wrap if column count
Select this option to specify how many table columns to display
before creating a table continuation. Note that if the number
specified is higher than the number of columns that can be
displayed on the page, some columns are not displayed in the
report.

Action
Table

Show header
Select this option to display the column headers in the table.

Show number
Select this option to display the condition number column in the
table.

Show condition
Select this option to display the condition column in the table.

Show description
Select this option to display the description column in the table.

Note If Show description is not selected, no action table is
displayed in the report.

Insert
Anything
into
Report?

Yes. Table.
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Truth Table

Filename rptgen_sf.csf_truthtable
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Variable Table

Category MATLAB

Description The Variable Table component creates and inserts a table that includes
all variables in the MATLAB workspace. You can find all the variables
in the MATLAB workspace by typing whos at the command line.

Attributes The following figure shows the Variable Table Properties panel:

Source
Workspace

Read variables from
Select one of the following options:

• Base workspace — Select this option to read variables from
the MATLAB workspace.

• MAT-file — Select this option to read variables from a binary
file with a .mat extension. You can use the %<VariableName>
notation. See “%<VariableName> Notation” on page 8-253 in
the Text component reference.
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Variable Table

Table Title Table title
Select one of the following options for the table title:

• Automatic (Variables from MATLAB workspace) — Select
this option if you want the table title to be a variable name
from the MATLAB workspace.

• Custom — Select this option and enter the title in this field if
you want a custom title for the variable table.

If you have a title for a table, it is included in the list of tables if the
stylesheet you chose in the Report Options attribute page supports it.
See “Setting the Report Format” on page 2-3 to find stylesheets that
have a lst of tables.

Columns in table
Select information to be contained in table columns:

• Variable size (MxN) — Select this option to include the size
of the variable.

• Variable memory bytes — Select this option to include the
number of bytes of memory occupied by the variable.

• Variable class — Select this option to include the variable
class.

• Variable value — Select this option to include the value of
the variable. Note that large variable arrays are collapsed to
[MxN CLASS]. For example, if you have a 300-by-200 double
array, it appears in the report as [300x200 DOUBLE].

Example

This is an example of a variable table that includes size, memory bytes,
and value information in the table columns.
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Variable Table

Name Size Bytes Value

aCell 1x2 238 { [ 1 2 3 4 ] Speed (kph) }

aNumber 1x1 8 1

aString 1x11 22 Speed (kph)

aStructure 1x1 302 [struct w/ fields. Inputs, Outputs]

aVector 1x4 32 [ 1 2 3 4 ]

Insert
Anything
into
Report?

Yes. Table.

Filename rptgen.cml_whos
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While Loop

Category Logical and flow

Description The While Loop component iteratively executes its child components
while the string specified in the attributes page is true. You can limit
the number of repetitions to prevent infinite loops. The While Loop
component must have at least one child component; the purpose of this
component is to run its children several times. If it does not have any
children, this component does not add anything to the report.

Attributes The following figure shows the While Loop Properties panel:
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While Loop

Logic
Properties

Continue looping if this expression is true
Enter the string to be evaluated in this field. This string should
be a valid MATLAB expression that evaluates to 1 or 0 (true or
false) in the workspace. For example, if a = 1, b = 2, and c = 3
in the MATLAB workspace, and you enter the following at the
command line,

d=(a>b/c)

then MATLAB returns the following:

d = 1

Because 1 is greater than b/c (2/3), this expression is true, and
evaluates to 1.

Limit number of loops to
Use this option to prevent infinite loops. Use the left and right
arrows to increase or decrease the number of loops.

Initialize with this expression
Enter a valid MATLAB expression to initialize the loop.

Insert
Anything
into
Report?

Yes, as long as it has a child component.

Filename rptgen_lo.clo_while

8-272



A

Examples

Use this list to find examples in the documentation.



A Examples

Looping Components Example
“Working with Looping Components” on page 4-2

Property Table Components Example
“Working with Property Table Components” on page 4-13

Summary Table Components Example
“Working with Summary Table Components” on page 4-25

Using Components
“Creating and Using Component Properties” on page 5-24
“A Report Displaying Two Tickers” on page 5-29

Editing Font Size As a Derived Value in XML
“Editing Font Size as a Derived Value in XML” on page 6-23

Procedures for Some Specific Stylesheet Changes
“Making Some Specific Stylesheet Changes” on page 6-34
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Making Changes in Font Size, Page Orientation, and Paper Type

Making Changes in Font Size, Page Orientation, and
Paper Type

“Making Changes in Font Size, Page Orientation, and Paper Type” on page
6-34

Adding a Company Logo to a Report
“Adding a Company Logo to Headers in a PDF Report” on page 6-37
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